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Chapter 1. About cardPresso

cardPresso, Lda is always deweloping cutting edge ID Card solutions. Our team has R&D
technologies and extensive ID software development skills and experience. The result of our efforts is
the Next Generation of Plastic Card Software - cardPresso

Our programmers use the most recent innovations from different fields of information and ID security
technologies. Our goal is to create the perfect balance of functionality and usability, while ensuring
end users ease in using our software. We're constantly exceeding our goals through the team efforts
of our developers, analysts, resellers and our most important contributors our clients.

1.1 Overview

Welcome to cardPresso.
cardPresso is more than an application...

Why? Well, cardPresso is not only a very simple software, but also powerful and user friendly. We
have a dedicated and experienced team of professionals, support experts, software development
innovators and sales specialists, including our distributors that provide you with the best software
solution on the market.

cardPresso is committed to a continuous software improvement by responding to the clients
requests, keeping in touch with new technologies and anticipating the needs of an ever-changing
plastic card industry. Our worldwide staff is available to assist you as needed through training,
technical support, sales information or through a wide range of senices including full software
customization, stand alone projects or embedded projects, headed or followed by cardPresso.

cardPresso allows you to create a card from scratch to production, without any outsource program
to deal with any aspect of the card creation process, like image treatment or card encoding and even
the database connection issue, because cardPresso can connect to any database.

cardPresso's capability of working on Mac and Windows Operating Systems have been the market
revolution, satisfying both end-users. This has been not only a challenge but also a commitment that
allows cardPresso to work with a world wide range of clients.

Whether it's automating routine tasks or solving your toughest IT challenges, cardPresso delivers
rapid value and simplifies the plastic card creation process management, across physical, virtual and
cloud environments. And that means less chaos and stress for you, plus, big cost-savings for your
organization.

© 2014 cardPresso, Lda
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1.2 Features

= Software Box and Installation

cardPresso comes with a full setup on an USB key that allows you to work on Windows or Mac and
carry your work with you. It also brings a Digital Manual in PDF, card templates, clipart and shapes
and allows a group and user log-in management.

* Tools & Image

cardPresso has on it's tools a strong hold for its users, like 1D and 2D barcodes, variable objects,
templates, text setup, full image acquisition, face detection and a complete built-in image editor.
You also hawe access to a multi-layout design option.

» User Interface

cardPresso has five different views:

- the Welcome View where you define how yo start or resume a previous card creation process,

- the Users View where you can define groups and user log-in management,

- the Document View that gives you a complete oveniew of the document and at the same time
allows you to work directly on the card design,

- the Database View that is a full manipulation tool,

- and finally the encode view where you can setup your card encoding.

* Print
cardPresso offers a front and back print option, SDK driver printing, ethernet printer support, overlay
panel management and batch printing, print status and in some editions conditional printing over
database.

= Database

cardPresso allows you to connect to any kind of database, such as CSV, Excel, Access, among
others. cardPresso brings an internal database with photo connection and a powerful database tool
set where you can create and edit a database, link an image to a field, browse, filter and find
records, and concatenation options.

* Encoding

This feature allows magnetic encoding, contact smartcard plugin, contact smartcard encoding,
contactless RFID encoding and internal / external RFID encoding. cardPresso has also internal /
external RFID encoder support.

» Miscellaneous

cardPresso gives you free updates and automatic edition upgrades.

A user log that permits a step-by-step follow up of your work.

And a programming script (JavaScript, based on ECMA Script Language Specification).

© 2014 cardPresso, Lda
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1.3 Security

cardPresso, Lda team has opted for an USB pen solution that comes with a full setup.

Why? Because through this pen you can work in any PC or Mac with the advantage to carry your
work with you and also because it makes easier to recover your license online through cardPresso,
Lda.

This is a 4GB pen, which means that a lot of work can be carried on it, your card files, images,
databases and anything elase you might need to carry with you.

Currently there is a cardPresso XL Edition license on your
computer, click here to check for registered upgrades for
this license

SN:CP-0701-0B03-017E

ﬁ) || CARIPRESSO

iﬁheck for Upgmdes.

Close

—Advice: Always make a copy of your work. All data on your pen is recoverable except your work.
A pen is a piece of hardware as reliable as any other.

© 2014 cardPresso, Lda
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Chapter 2. Installation and Support

cardPresso is easy to install and customize.

2.1 Installing cardPresso

For Windows installation, please follow the steps covered on the the topics Windows Installation.

2.1.1 Windows Installation

Connect the provided USB key on one of your awailable USB ports. The AutoPlay will run
automatically and choose the 'Open Folder to view files' option.

Double-click on the cardPresso executable file and the Installation Wizard will run. The Installation
Wizard is displayed where you can verify the Serial Number of your product and also select the
language to install. To proceed with the installation click the 'Next' button.

Install
This wizard helps you to install cardPresso
Serial Number CP-0701-0B03-017E

Shortcuts
Finish

Please select language to install

English -

CARIPRESSO

more than an ion

Install or Evaluate
Select the installation folder. By default cardPresso software is installed on the Programs Folder but
you can select another destination folder by selecting the 'Select Destination folder' option.

Check the option 'Install for all users' if you want other Windows users to also run cardPresso
software. Click 'Next' to continue.

If you want to run the application without installing it please click 'Evaluate'.

© 2014 cardPresso, Lda
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Welcome

Please select the installation folder or click on 'Evaluate’ to run
cardPresso without installation

Shortcuts | Install in Programs folder

Finish W Select destination folder
Install for all user

CARIPRESSO

more than an aj on

Shortcuts

Check the shortcuts that you want to create for easy access to the application, and if you wish to
open card files immediately with cardPresso select the file associations checkbox. Click 'Next' to
continue.

This wizard can

Select the check boxes below t

shortcuts
Create programs shortcut
Create desktop shortcut
Create Start Menu shortcut

Create cardPresso file associations

CARIPRESSO

more than ana

Finish

Click 'Finish' to install cardPresso software.

© 2014 cardPresso, Lda
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cardPresso 1.1.23 XL Edition
Serial Number CP-0701-0B0O3-017E

M Delete the wizard file after installation

© 2014 cardPresso, Lda
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21.2Mac OS X

= Install

Installation

Plug the USB key and double click on USB drive icon, then double-click on the cardPresso.dmg file

and the end user license agreement appears, click 'Agree' in order to proceed.

cardpressol.1.14.05x10.6.dmg

IMPORTANT - Read this
License Agreement carefully
before clicking on the
“Agree" button. By clicking
on the "Agree” button, you
agree to be bound by the
terms of the License
Agreement.

END-USER LICENSE AGREEMENT FOR "cardPresso”,
COMPANY LICENSE"

IMPORTANT - READ CAREFULLY

Please read the following license agreement. You
must agree to its terms before using this software.

This end-user license agreement ("EULA") is a legal
agreement between you either as an individual or a
single entity ("LICENSEE") and cardPresso Lda. for
cardPresso, including computer software, electronic
documentation and printed materials ("SOFTWARE").
By downloading, installing, copying, or otherwise
using the SOFTWARE, you agree to be bound by the
terms of this agreement. If you do not agree to the
terms of this EULA. oromotly destrov all capies of the

| Print | | Save... | | Disagree | | Agree

Now drag and Drop the cardPresso icon into the Applications folder alias to install.

000

|= cardPresso 1.1

CARIPRESSO

For Mac OSX 10.6+

© 2014 cardPresso, Lda
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2.2 Changing Language
You can change the language of the user interface at any time.

To change the language of the cardPresso software, click "CP" -> Language. Choose the desired
language from the list and restart the application to apply the new language settings.

Ei|E Edit Vview Jool Wndow

About W Arabic

Zesky (Czech)
Clear Ccunﬁg Danish
USE Devices Deutsch (German)
Update Security Y RIGE

: Espanol {Spanish)
View Folders
Frangais (Francese)

Printer Drivers Indonesia {Indonesian)
Language » italiano (italian)

B%EE (Japanese)

§l =2 (Korean)

Mederlands (Dutch)

Norwegian

Polski (Polish)

Portugués (Portuguese)
Pyccrui [Pussian)

Slovencina (Slovak)

Swvenska (Swedish)

Tiéng Viét (Vietnamese]

YRR IR (Taditional Chinese)

© 2014 cardPresso, Lda
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2.3 Updating cardPresso
We advise to keep always your cardPresso software updated. In order to do so please go to http://

www.cardpresso.com website and download the setup required for your operating system.

CARDPRESSD omos woimen  ooemss MADSS SEFD CNCS | MLISTHES A @

VIDEO TUTORIALS

INSUPPORT / VIDEO TUTORIALSOR
YOUTUBE.COM/USER/CARDPRESSO
SEEHOW WITHOUR VIDEQ TUTORIALS.
NEW VIDEOS EVERY WEEK
ML ron B Windows

cardPresso

k ' eeeee o

&x vownroao 2] pownioao i & oownioan [l Yol cHANNEL

LM " for Windows 1593 " Zip File 1087 * for M3

2.4 cardPresso Support

cardPresso, Lda's team treasures the relationship with our costumers, keeping it as close and
personal as possible. We are committed to offer you the best support.

We can offer support by phone, email, Skype or remote sessions (Team Viewer):
iﬂ
(+351) 261 866 163

4
support@cardpresso.com

(S

cardpresso.support

© 2014 cardPresso, Lda
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Chapter 3. Getting Started

O mis chapter explains how to handle a document, model or template, how to create or open an
existing file and also how to recover a backup file.

Document - Contains all data related to your work, including the chosen model or template, all
objects, database connections, properties, encoding properties. In sum, all the properties involved in
your card document creation.

Model - Contains all the features and shape of your physical card. These features are size and card
type, ifit is a basic card, contactless, magnetic or smartcard. Please notice that the card settings
depends on your chosen or created model type. For instance, you can't access the chip encoding
settings if you've chosen or created a card without SmartCard capabilities.

Template - Is no more then a pre-made document layout used to create a new document with a
similar design, pattern, or style. This means that you can use an existing template as it is or you
can change it as you wish, creating a new document or template from the opened template.

Backup - cardPresso automatically generates a backup file of your document every time it's saved.
This backup is created on a pre-defined folder (\My Cards\Backups') with the document name and
date/time creation.

© This document can be recovered any time you need.
Example: documentname(yyyymmddThhmmss).cardBackup

© 2014 cardPresso, Lda
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3.1 - Welcome View

* Welcome View

The welcome view is your starting point when it comes to working with cardPresso.
Here you can create new card models, open existing card models or previously made templates, or

even create a basic card with a step by step guide.

Here you can also access the Users View (only on cardPresso XL Edition or higher) or simply quit
cardPresso.

To return to the Welcome View at any time:
0 Click Window menu » Welcome View

=|-' You can get help in different ways. Choosing "Help" from the Help menu or context-sensitive help
that is always available by pressing the F1 with the cursor located on the element on which you want

help. In addition, many dialog boxes contain a Help button.

© 2014 cardPresso, Lda
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3.1.1 -CP Menu

The top menu bar, gives you access to the "CP" menu.
Here you can find information related with cardPresso.

About W

Clear Config
USE Devices
Update Security
View Folders
Printer Drivers

Language r

E About cardPresso, Show your release, edition and serial number.

E Clear Config, Sets cardPresso all settings to default, including print settings, object settings
even work space.

E USB Devices, Show every information about your cardPresso license pen, the drive ID and the
serial number, if this information is not shown then your pen has not been recognized by the system,
please check it.

E Update Security, Show information about your cardPresso license pen and allows online
upgrade.

Currently there is a cardPresso XL Edition license on your
computer, click here to check for registered upgrades for
this license

SN:CP-0701-0B03-017E

==

’) il CARIPRESSO

| Check for Upgrades

Close

E View Folders, Show information about cardPresso working folders. If you don't find a file or
don't know where cardPresso keeps it's folders like cliparts, backups, shapes, etc, you can check
on this list it's location.

© 2014 cardPresso, Lda
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BACKGROU...
BACKUPS
CLIPART
COMPONENTS
DATABASE
DOCUMENTS
MODELS
MYMODELS
PICTURES
PRINT
PRINTSETTIN...
SHAPES
TEMPLATES
USERS
TRANSLATIO...

cardPresso Folders,

$PENS/cardPresso/ClipartFles/Backgrounds
C:fUsers/Daniel/Documents/My Cards/Backups
$PENS$/cardPresso/ClipartFles/Clipart
C:/Program Files/cardPresso/COMPONENTS
C:,fProgramDataf'cardPresso,fDATABASE
C:/Users/Daniel/Documents/My Cards
$PENS/cardPresso/CardFiles/Models
C:/Users/Daniel/Documents/My Cards/My Models
C:/Users/Public/Pictures/cardPresso
C:/ProgramData/cardPresso/PRINT
C:/ProgramData/cardPresso/PRINTSETTINGS
$PENS/cardPresso/ClipartFles/Shapes
$PEMS/cardPresso/CardFiles/Templates
C:,fProgramDatajcardPresso,fUSERS
C:/Users/Daniel/Documents/Translations

Close

E Printer Drivers, Show information about the printers and drivers installed on your computer and
if you click on View All Supported cardPresso Printers' you have access to a list of compatible
encoding printers.

E Language, Allows you to choose the language in which cardPresso is presented

© 2014 cardPresso, Lda



n cardPresso Manual

3.2 - Creating a New Card

The first step to printing cards is creating your own card.

6 To create new card, in the Welcome View 0 Click Create New Card button

or @ Click File menu » New ( CRTL+N )

CP BEIEN Window Help

3 New Ctri+N
B3 Open Template Ctr+Shift+0
B Open Ctrl+0

Exit

Then you can then choose the Card Type that you intend to use from our list of supported Card
Types:
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Card Types 23 Card Types | All Card Types |+]
I
))) MIFARE CR79
)) :o))) - GENERIC ke a
[ ]
® 9
GENERIC cRI00
i e D) [l 27rack

))) DESFIRE |
)) BUS LOCO

HICO LOCO 1))) MIFARE HICO 1))) MIFARE

El
O Portrait | [s]4 Close

After selecting the Card Type, the cardPresso Design View will automatically open, giving you
acces to al the tools you ned to add and edit content to your new card.

B8 EESEE EEE BrER DEEEEHEE

B
e

AEPFEBEEERES o0l B g
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3.3 - Open Your Own Card Documents

© In cardPresso there are two kinds of files, the ones you create, called card documents and the
ones created by cardPresso designated by backup files.

To better organize your documents, in the "Open Card" window, you find "cardPresso Favorites"
with two folders - "My Recent Cards™ and "My Cards". Or alternatively you may locate your file in

another folder in "My Computer".

You can sort the way how the cards are displayed. You may sort them by Name, Name
Descending, Modification Time, Modification Time Descending, File Size and File Size Descending.

Explorer|

4 [5] cardPresso Favorites
My Recent Cards
My Cards

> (M My Computer

Sort Cards By | MediicationTime

JPRESSO

Number of cards or name of your card

OK

Close

O in the lower right corner you can find the information about how many readable documents are
currently present in the selected folder, or the name for the current selected card document.
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3.3.1 - Open an Existing Card Document

© voucan open an existing card document to edit, change or even print again. The existing card
always keeps the last saved properties.

The first step will be to locate the document card that you wish to open. In order to do so, please
click the 'Open' button on the "Welcome View" or use the 'Open' option from the 'File' menu.

0 Click File » Open ( CRTL + O ) » Explorer and locate your card with extension .card

Explorer| .. _ Sort Cards By [name )

4 |z cardPresso Favorites
My Recent Cards
My Cards
> (W My Computer 3 Card(S)

JPRESSO B

oK | close

Q ciick ok.

Organize = Mew folder

Marme Date modified Type
File folder

Backups
My Models File folder
=] my_card.card 94 KB

- I card (*.card)

[ Open |v] | Cancel

d

File name: my_card.card

Ay
& Your file should have the extension .card

O sclect the file extension in the corresponding Combo Box, otherwise your file will not be listed
To proceed "Open™.
B Also remember that you can open the file directly from Windows by double clicking on on it

inside Windows Explorer.
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3.3.2 - Recover Your Card Documents From Backups

L1 I backup is a file that cardPresso automatically creates every time you save a document in a
internal or external drive. The file will be saved with a date and time reference to make easier to
detect the last backup made. Like this you have the assurance that you have a copy of your

document in a specific date/time, in the backups folder.

Before opening your backup, you should know where cardPresso created the backup folder during

installation. To check the path:

O Glick ¢P » View Folders

cardPresso Folders,

BACKGROU... $PENS%/cardPresso/ClipartFles/Backgrounds
BACKUPS C:/Users/Daniel/Documents/My Cards/Backups
CLIPART $PENS/cardPresso/ClipartFles/Clipart

COMPOMNENTS C:/Program Files/cardPresso/COMPONENTS

DATABASE C:,fProgramDatafcardPresso,fDATABASE
DOCUMENTS  C:fUsers/Daniel/Documents/My Cards

MODELS $PEN%/cardPresso/CardFles/Models

MYMODELS C:fUsers/Daniel/Documents/My Cards/My Models
PICTURES C:/Users/Public/Pictures/cardPresso

PRINT C:/ProgramData/cardPresso/PRINT

PRINTSETTIN... C:,fProgramDatafcardPresso;PPdNTSE'l‘l‘lNGS

SHAPES $PENS/cardPresso/ClipartFles/Shapes
TEMPLATES $PENS$/cardPresso/CardFiles/Templates
USERS C:,fProgramDatajcardPresso;USERS
TRANSLATIO... C:/Users/Daniel/Documents/Translations

Close

O Now that you know where your backups are stored

(.../users/.../Documents/My Cards/

Backups ), you can easily locate the backup document that you need to recover.

0 Click File » Open » Explorer » cardPresso Favorites » My Cards » === » Backups and

select your backup document in the folder "Backups"

© Remember that your backup has a 'filename(savedate Tsavetime).cardBakup' filename

convention.

Explorer|

Sort Cards By |name

4 |=) cardPresso Favorites
My Recent Cards
My Cards

> | My Computer

3 Card(s)

PRESSO 7

oK Close

O ciick ok.
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Organize » New folder SECHR S| I@}I
Name ° Date modified Type Size
|E| daniel(20130111T124839).cardBackup 08-01-2013 16:11 Backup 94 KB
(=] My_Model(20130110T215857).cardBackup ~ 10-01-2013 21:54 Backup 3 KB
|&] My_Model(20130110T220933).cardBackup ~ 10-01-2013 21:58 Backup 6 KB
|E] My_Model(20120110T221047).cardBackup ~ 10-01-2013 22:09 Backup TKB
|E] My_Model(20130110T221135).cardBackup ~ 10-01-2012 22:10 Backup g KB
|&] My_Model(20130110T221327).cardBackup ~ 10-01-2013 22:11 Backup 8 KB
|&] My_Model(20130110T221350).cardBackup ~ 10-01-2013 22:13 Backup 8 KB
[E] My_Model(20130110T221406).cardBackup ~ 10-01-2013 22:13 Backup 3 KB
(] MyModel(20130110T170818).cardBackup 10-01-201317:06 Backup 83 KB
=] MyModel(20130110T172244).cardBackup 10-01-201317:08 Backup 5 KB
File name:  My_Model(20130110T215857) .carc = ICEFdBﬂCkUP (*.cardBackup) -]
[ Open {v] | Cancel |

Ay
#" Your file should have the extension .cardBackup
0 Now all you have to do is to save your document with another name and with .card extension.

O sclect the correct file extension in the corresponding Combo Box, otherwise your file will no be
listed.
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3.4 - Using Templates

0 A template is a collection of styles that control the layout and appearance of a card document.
You can quickly create your card document using one of our many templates.

cardPresso provides these templates organized in categories, such as Test and diagnostic; Sports;
Shopping; Schools; Loyalty; Clubs & Resorts; Business; Activities and Access Control.

But if for some reason this categories don't fit your needs, you can always create new ones, just go
to My Templates directory and once there create a new folder and cardPresso will assume that
folder to be a template category.

The Templates cover a wide range of graphics and variable field types, all of them fully editable.
These professional templates are part of your cardPresso software. Your cardPresso USB dongle
also contains additional templates.

Template Types 29 Card Templates | All Card Templates | - |

Your Logo

<z SCHOOL

2

UourLoso

Dog Trainars:
Pt ek 3 T
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3.4.1 - Create from Existing Template

6 To create a document from a template, in Welcome View o Click Templates

Or o Click File menu » Open Template ( CRTL+SHIFT + O)

CP NN Window Help

R New Ctri+N
& Open Template  Ctrl+shift+0
& Open Ctrl+0

-

e
.a r.]

ip

_ In the dialog box, search thru the available templates.

i ] You can create a card based on a template and then modify the document without affecting the
original template

B cP Fle Edt View Tool Database MWindow Help e
EEEEE OcaAE AR - NEEEEE - BB -
..... AJ

Font Family

| Adial I

Point size

21,0 pt O Auto

Color

[Mrsz.0.0) =

Clipping | Position | fter

‘ = weskEs

| 1B L O
= g

IE

g5l | = e

=

@

H|. :

o

o By making changes to the background, images, text, and orientation card. You can create a new
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design to suit your needs. You can also modify any card object in your document.

O Al you have to do now is to save your new card document.

3.4.2 - Create Your Own Templates

O irthe preset templates do not meet your requirements, you can create a template based on your
own styles.

To create your own template, start by creating a new card and chose a model type that fits your
need. For instance, if you chose for example a contactless model, the result will be a template

based on your contactless, but with your own design.

: Common Card Types

Card Types 4 Card Types

Easg )))) GENERIC )))) MIFARE

oK | Close

0 Click "OK'. If you want to continue. Otherwise click 'Close' to revert to the previous window.

i 7N template may include any object type, variable field or text that can be edited and modified at
any time. Make all the changes you want on your template and then save it with '.cardTemplate' file
extension, in the appropriate folder in cardPresso (.../My Cards/My Templates/...).

o Click File » Save or Save as and create your file.

File name: your_card_template.cardTemplate

Save as type: [ TEMPLATES (*.cardTemplate)
DOCUMENTS (*.card)
: 1|

L |

™ Browse Folders  110nE 5 (* cardModel)

Ay
& Your file should have the extension .cardTemplate
i You can edit your template at any time.

0 Click File » Open » Explorer | ===
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Explorer| .. Sort Cards By [name

4 |=) cardPresso Favorites - A
My Recent Cards
My Cards

. (M My Computer 3 Card(s)

PRESSO B

oK Close

Organize » New folder =~ 0O @
-~

Mame Date modified Type Size

1= your_card_template.cardTemplate 3KB

File name: your card template.cardTemplate ~ lcardTempIate (*.cardTemplate) v‘

[ Open |v] | Cancel |

O sclect the file extension ".cardTemplate" in the corresponding Combo Box, otherwise the
template files will not be listed.

O Atter you have completed your template edition Q click Save and your old template will be
replaced with the new modifications.

3.5 - Using Models

© cardPresso allows you to create a document in two different ways, by using an existing model
or by creating your own card model.

The first one only requires you to choose one of the many different type of models that cardPresso
has at your disposal. Like mentioned before, you have four major kinds of card models: basic,
contactless, contact smart card and magnetic, and each type can hawe different settings like sizes,
different kinds of magnetic strips and so on, all listed on cardPresso model type.

But if you have a specific type of card model that is not listed, cardPresso allows you to create it
and that's the other way to create a document, using a new card model.

O Note that whatever model you choose, it will restrict access to further settings and properties,
like referred before. If you open a "Contact Smart Card", the result will be a model of your "Contact
Smart Card", where you can only edit Smart Card Settings, and it will not allow you to access, for
instance, RFID settings.
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3.5.1 - Create from Existing Model

O mis topic guides you on how to create a new document using an existing model. You can start
a creation procedure by clicking on the create button on the "Welcome View".

0 'Welcome View' » 'Click Create'

Or o 'Click File' menu » 'New' ( CRTL+N )

* m Window Help

Mew Ctr+N
&5 Open Template Ctrl+Shift+0
B Open Ctrl+0

Exit

© Then choose the type of model you want. The model types are organized in 8 groups:

E Basic card models, have no contacts, no microprocessors or internal memory. Simple piece of
plastic that you can print in front and back side.

™ Common card types, are the most common types of card models, used by the vast majority of
users.

™ Magnetic this model type allows you to encode the magnetic stripe through cardPresso. This
means that you can print and encode your card at the same time or use an external encoder. These
cards may contain secondary technology, like RFID technology.

E Contactless card is any pocket-sized card with embedded integrated circuits that can process
and store data, and communicate with a terminal via radio waves. This type of card model allows you
to encode through cardPresso. By using JavaScript language, you can program your card and
perform read and write operation on the card. This also means that you can print and encode your
card at the same time or use an external encoder.

E Mifare, this card model, when chosen, allows you to read or write the several sectors of your
card. By using JavaScript language you can connect the sectors to database fields and update them
automatically or simply enter data through keyboard input, therefore you can print and encode at the
same time. These cards may contain secondary technology, like Magnetic stripes.
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™ Contact, a smart card, chip card, or integrated circuit card (ICC) is any pocket-sized card with
embedded integrated circuits. In cardPresso you have four types of card models, 12C, JCOP (Java
Card), SLE4442 and generic. This type of card model allows you to encode through cardPresso. By
using JavaScript language, you can program your card and perform read and write operation on the
card. This also means that you can print and encode your card at the same time or use an external

encoder.

Ef Unusual, set of models used by a small number of users. Model types dewveloped for specific

projects are now included on this group.

™ user Models, if you have any models in folder "My Models", they will become available in this

group.

Card Types 23 Card Types | All Card Types

I
1})) |ﬂ| GENERIC

)))) MIFARE

W covnc

)))) DESFIRE
'BLIS‘ LOCO

LOCO !))) MIFARE HICO l))) MIFARE

.7
ks

D) 2 TRACK

oK Close

After you have choose the model type, Q 'Click OK' and you will be able to start working on your

new card. Or O 'Click Close' if you want to revert to the previous window.
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BEE]

[}
o
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[ Al classes [

8l Background

emi E&

|
)

EFBEEBREO

61 Backgrounds found, 0 folders remaining

o For your first card design, check also the Objects and Properties topic.
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3.5.2 -Create Your Own Model

© 710 create a document using a new model, you have to start by creating the model. This will be
your starting point to customize your own document.

Card Types 4 Card Types | common Card Types  ~

£

kjwii )})) GENERIC )))) MIFARE

OK Close

Your next step is to sawe that same model with the extension '.cardModel' and sawe it on
cardPresso folder called "My Documents/My Models" in order to be identified as a model.

Oiis important that you save your file in the folder "My Models", to be displayed in the category
"My Models" in "Select model type".

(% Click File » Save or Save as and create your file as the example below, in your folder "My

Documents" (To see this folder locations, please click on menu 0 cP » View Folders)

File name: your_card_model.cardModel -
Save as type: [MODELS (*.cardMadel) L -
DOCUMENTS (*.card
TEMPLATES (*.cardTemplate _, o
¥ Browse Felders 1 2ave j | Cencel

Ay
& Your file must be saved with the extension .cardModel

O At this point, you've created your new model "yourdoc.cardModel." The next step will be to
locate your file and open it.

0 Click File » Open » Explorer » cardPresso Favorites » My Cards » | ===

Explorer| .. Sort Cards By [name
4 |= cardPresso Favorites |
m: E«;crigt Cards : CARapRESSO -

> ([ My Computer

3 Card(s)

oK Close
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Organize « Mew folder =~ O @
Name Date modified Type Size
|E| your_card_model.cardModel cardPresso Model 3KB
File name: your_card_mcdel.cardModell - lcardModel (*.cardModel) vl
[ Open |v] I Cancel l

0 Select the file extension in the corresponding combo box, otherwise your file will not be listed.

0 After opening the model, you can customize the dimensions and corners radius. On your
right on the properties tabs you will find a tab named "Layout" where you can change the card

dimensions and corners radius,

2 Width [85.725 mm [
Fal ol
& Height [53.975 mm =
- kS |2 mim i '
§ RY [2 mm - '
(=]
A
(&)
L]
m

You can also change the orientation of your card by Q clicking on File menu » Configure Print

and In "Print Layout" o Click Orientation and select your card orientation. The card orientation
can be changed at any time, but this will be your card default orientation.

Orientation | | Landscape
' iLandscape
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€ You can add images, text or other elements to customize the thumbnail that you will see in the
preview area.

My Model _85X55mm

6 The last step is to save the model that you've just created. From now on the new model will be
displayed in the Create Document Dialog Box, under the category "My Models".

O Click File » Save (CRTL+S).

Card Types 1 Card Types | My Models -]

=
ofe
Your Logo

My Model_85X55mm

OK || Close |

0 Please note that cardModels can't be printed, they have to be saved as *.card before you can
print.
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Chapter 4. Design

© The definition of design is the creation of a plan or convention for the construction of an object
(as in architectural blueprints, engineering drawing, business process, circuit diagrams and sewing
patterns). Design has different connotations in different fields. In some cases the direct construction
of an object (as in pottery, engineering, management, cowboy coding and graphic design) is also
considered to be design.

Well, in cardPresso you can also design and when you design you build a layout. To accomplish

this, cardPresso provides the user with specific tools and objects, allowing you to build your layout
according to your imagination, capabilities and needs.

0 as you know, when you design you create a file, called document, this document keeps inside
all settings you will use on your creation.

4.1 - Workspace

© In cardPresso you can customize your working area as you wish. You can reposition the menu
bars or you can view or hide properties areas.

0 On the View menu you have a set of options that allows you to change your working scenario.

ToolBars
E Here you can select all the dockbars that should be available in the working space.

Pen Parameters:

{RoundCap

/SquareCap (FlatCap RoundCap
/Bevelloin  jRound|ein oK Cancel

Metrics
E Allows you to define the measurement unit that you wish to work with.

Pen Parameters:

{RoundCap

/SquareCap /FlatCap RoundCap
/Bevelloin  jRound|ein oK Cancel

Rulers
E Visible - Show or hide the rules in the card design area.

E Selected Items - Shows or hide the area occupied by selected items on top of the card design
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rulers Set

Pen Parameters:

{RoundCap

/SguareCap (FlatCap /RoundCap
/Bevelloin  /Round|oin (0]'4

Grid

E Visible - Set the card visible or hidden

Ef Snap to Grid - Allows you to move and/or position the objects on a grid unit step or free move

Pen Parameters:

{RoundCap

/SguareCap /FlatCap /RoundCap
[Bevelloin  jRound|oin OK

Workspace Color

™ Allow you to chose the workspace background color

Pen Parameters:

[RoundCap

/SquareCap /FlatCap /RoundCap
/Bevelloin  /Round|oin oK

O Switch between front or back card side.
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* Fle Edit View Tool Database Window Help

)

~
O -
€1 history records

e browe~ e

SOCCERscHooL

WU Y0 URSOCCERSCHOOL .Com

© Switch to Database View.
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* FAle View Database Window Help

=EEE

B =)

o
Hil

@

Browse Records

Database
C:fProgramData/ /DATABASE/internalDatabase.mdb, Tzble:Employee
Record 1 of 15
Employee Id Supervisor Id Last Name First Name !_i
i 5 Davolio Sonia Sal ':
M2 Fuller Andrew Vice
=3 5 Leverling Janet Sale:
fa 5 Peacock Margaret Sales
Fs 2 Buchanan Steven Sale#;
Es 5 Suyama Michael Salej
Ez7 5 King Robert Sales
e 5 Callahan Laura Inside
Mo 5 Dodsworth Anne Sales
10 2 Hellstern Albert Busin_|
11 in Smith Tim Mail Jlll
“ 3
|§e|e:t All ‘7Se|ect None| "hggle Selection
Database Record
Database C:/ProgramData/ .................. IDATABASE/internalDatabase. mdb.Table:Employee
Record 1 of 15
3]
Employee Id ‘ | Photo
-
- Iv]
Supervisor Id
5=
| I T
Last Name
____|pawnlin ,,,E|
&l ]

=1 | (TR (TR [
_‘GB OO R=0
Bl =
z
=
¥l e
o
2
[

‘ Front ‘ Back

© Switch to Encoding View.

© 2014 cardPresso, Lda



Chapter 4. Design “

* Hle View Database Window Help
A Fa Fgl g C = = 5 | B B B B AREL
111 BN q° Zs) o) | sl Ee) ) ) 2% o)
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@
-
= 9
] s
2 il
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=
o
-
&
fa}
@
o
=)
m | Front Back
i}
o
B
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a
2
DATA INSPECTOR i
2
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G
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w
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4.2 - Document Properties

© When you open the document view, the first thing you will see is the work space and on the right
side the basic properties of your card document.

E Backgrounds - Each layout can have an unique background. You can access cardPresso
backgrounds library using the Backgrounds Tab. To apply a background just select it from the list
and the background will be applied immediately to your card layout. You can also set the
background using an image object.

E Clipart - You can access it using the Clipart Tab. They can be used as an image object, part of
your card layout creation, or as a background. Please note that you can only change the
background color of the object.

™ Layouts - Like we said before on this manual, when you design a card, you are building a layout
and in cardPresso, a document can have as many layouts as you want. The Layouts Tab is our way
to offer you a quick way to manage all the possible layouts on your card document.

™ Script - The Script Tab allows you to write your own script commands, based on the
ECMEAScript language specifications. This is a way to extend the already large number of features
that cardPresso offers you. It also allows you to interact with external software, using the results to
apply on your document. You have three different kind of script boards, one for each object, one for
the card document and one for encoding, three different ways to expand cardPresso capabilities.
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4.2.1 - Background

O an image to be applied as the background of your card. cardPresso offers you many
background images that can be used from landscape cards to portrait cards.

| All classes

Background

lipart

-

0
=
i
o
o
[

i

-
61 Backgrounds found, 0 folders remaining

*0ea

Background

s

-
=1
Qo
el
o

i)

| All classes

11 Backgrounds found, O folders remaining

0 Background are divided in classes that are accessible through the background combobox.

[AII classes

All classes

Technology
Transportations
Unsorted
Geography
Foad
Shopping
Celebration
Animals
Architecture
Buildings
Cats

Dogs

Clean

Clown
Computers
Couple
Cyeling

lce

lce cream

O it possible to add a folder with images to use as background, in the Background Tab oAII
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classes select O#User Folder.

| All classes [*]

All classes A
#User Folder

- Background |

lipart

C

5

Layout

—
(25

el
L=

o

262 Backgrounds found, O folders remaining

oAnd select through the Explorer Browser the Folder with the images to use as Background.

Organize « Mew folder R (7]
MName Date modified Type Size

. Backups 21-06-2013 12:10 File folder

. Downloaded Templates 21-06-2013 12:10 File folder

; My Models 21-06-2013 12:10 File folder

| My Project Backgrounds 27-09-2013 12:36 File folder
; My Scripts 26-06-2013 13:05 File folder

; My Templates 21-06-201312:10 File folder

Folder: M)f P.roj-ect IS;ac-Egroun;:is

[ Select Folder J [ Cancel

alt's also possible to use your own image as the card background.

Add an image object to your layout, then right click on the object and chose 'Set as a
Background' option, like shown on the picture bellow.
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W F% Edit Yiew Tool Database \Window Help

mESEEs DoE®E ARA
a0 PR | nE F e Fo oW R, Crr T e S0

e Pt e

Delete

Duplicate

m Send To Front
B Send ™ Back

Export Image
[ set As Background )

CUFBEEBRESOND O

Fit to Card

=

If you want to change or edit the background, right click on the card and choose o 'Edit
background'.
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BEEE Eeem AAA @

Select all Ctri+aA

Duplicate
Paste

[ Edit Background

PKEL b W

1063 x 705 - 100.0

The Image Editor will open and from there you can edit the background image. To commit changes,

0 click on the 'Save Changes' button, otherwise press '‘Cancel’ to continue.
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4.2.2 - Clipart

0 Clipart are pre-made images that can be used to help on the layout creation. cardPresso offers
you several.

und

| All classes

Clipart I Backgro

wl
-
=]
o
=
)
=5

=N
nd IR

¥

«

=

1282 Images found, 0 folders remaining

0 They are divided in classes. All you have to do is select one class from the dropdown combobox.

[ All classes v |

All classes i
Symbols W
meats_and_eggs
thanksgiving
Nautical
Celebration
Clock

Countries

Flags

G10

Geography
Bread

Burguer

Food

Hot Dog
Peripherals
Storage
Vegetables

dairy

Dolphin

Dunk

Elephant

Grass Hopper

Gull .

Background

(i ] Select the image from the clipart list, and drag it to the card design area. The selected image will
be used as an image object that you can modify.
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4.2.3 - Layouts

6 The Layout Tab allows to define properties, settings and conditions for the use of the layouts.
This feature allows you to use on the same card document as many layouts as you need and
conditionally print the ones you want.
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[M Name - You can give a name to your layout.

Ef Add - You can add a new empty layout.

™ Copy - Creates a new layout based on the current selected layout..
K Delete - Delete the selected layout.

Ef Auto Select Based on Database Condition - When checked it allows access to a condition
box, where you can define fields and conditions for every layout. Remember that these conditions
are restricted to the selected layout.

O After you enable the checkbox, the first drop list shows all the available fields from the
connected database. You can apply conditions based on the available fields as you can see below.
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[ Employee ID

Employee ID
Supervisor ID
Last Name
First Name
Position
Birth Date
Hire Date
Add Copy Delete Home Phone
Extension
Photo

- Notes
Emplwe_e_ l_D. - @ 1 Repgrts To
is Equal . : Salary
A - SSN
LBS'# ° ) | |[Emergency Contact Frst Name

[ Auto select on card design Emergency Contact Last Name
Emergency Contact Relationship
Emergency Contact Phone
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Layout 2

7] Auto Select based on database condition

Layouts

Is Equal

Is Equal

Is Not Equal
Contains .
Mot Contains

Is Null
Is Not Null

E Is Equal - Link the chosen layout to all records with the selected field equal to the input value.

E Is Not Equal - Link the chosen layout to all records with the selected field different from the input
value.

M Contains - Link the chosen layout, based on the field value, to all the records that contains the
input value.

E Not Contains -Link the chosen layout, based on the field value, to all the records that do not
contains the input value.

E Is Null - Link the chosen layout to all records where the selected field is a null value.
E Is Not Null - Link the chosen layout to all records where the selected field is not a null value.

0 After you have chosen one condition, you can set it to match any string, like shown on previous

picture '.' however please notice that the condition is not case sensitive.
0 If the record doesn't comply to any condition it will assume the layout of the previous record.

0 What benefits may be obtained from using multiple layouts? To explain it, we will show you a
sample case using one of the predefined templates available with cardPresso.

Q Now let’s imagine that you hawe three different departments in your company, Sales, Marketing
and another one that for this example purpose we will call it General, but only one database and you
need distinguish them visually for faster identification. The process is simple:

0 After opening one of our predefined templates, a connection to an internal database will be made
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It’s time to start working on the card layouts. Now click on the Layout Tab.
As you can see you already have one layout, from cardPresso business card.

Now we will add two new layouts in order to have three different layouts for sales, marketing and
general departments.

To start, change one of the layout's name to Marketing and then click on the auto select checkbox
to set the conditions.

On the database field, choose the field that will define the layout selection, in this case will be the
Position field.

Then in the next drop list set the condition for the chosen field, on our example we set it to
'‘Contains’.

And on the text box below add a value for the condition. In this case it is the department's name,
remember that this is not case sensitive.

Finally, enable the 'Auto select' checkbox. This option allows you to see the card layout that
depends on the condition field type when scrolling through the database records.
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Now choose our distinguish color for the card that in our example is what will define visually the
different departments.
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Now add a new layout for Sales and General departments. Click on the copy button twice.

As you see it copies our previous card to the new layout. All we need to do now is the same

procedure we made for the Marketing layout.

Define database settings for each new layout.

* Fle Edt Yeew ol Dotabase Wrdow Help
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General
Add

Copy || Delote
¥ Auto Select based on detebase condibon

Foition - |

Cantaing |
Sabes marketing
B Auto select on card design

Now use the navigation buttons and start scrolling through the database records.

As you can see, now the setup of the card is finished, connected to an excel database and with

three different layouts to define the different departments.

{!] But this is an example, you can choose as many layouts as you want and set your own

conditions.
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Chapter 4. Design

0 There are two kinds of scripts in cardPresso, one for each object and one for the document. In
this chapter we focus on the card document script.

This is an advanced user area, where you can program actions and procedures in ECMEAScript
language in order to define settings or update your object.

=
§ When Document Loaded .
f:” When Document Loaded
E Before Print
m Eefore Print Record
After Print

After Print Record

Audit Successful Print
Database Connected
Database Disconnected

Print Dialog
Print Copies
FL @
G
W
—‘ Script | | Output '. ©
H

'.' This drop-menu allows you to define when the actions or procedures must take place.

. And in the space bellow you can write your lines of code.

'.' To see the log of your program output, change tab bellow.

© 2014 cardPresso, Lda



“ cardPresso Manual

4.3 - Document Objects

O These objects are the most important features in your card document creation process. There
are two major types of objects, static and dynamic.

The first class refers to objects that will never change along the creation or data input process, like
backgrounds and shapes, for instance.

The second ones can be static or variable. Static as a simple keyboard input text line can be but
when we connect the same text line to a database and make it change while browsing through
several records it makes it a variable object according to its data source.

The objects can be placed throughout the card space, in the front and back side. And can be
arranged as you wish in order to overcome your creation needs.

There are also a set of specific settings to each object that you can use according to your own
specifications, like color, size, source, among many others.

ram
— m@® % T 0° = oam
RN pTOT Y

New New New New New Print Print New 1D
Line Rectangle Circle Shape Text Counter Date Barcode
I:I?D : 1

_E"Y
T ﬂ e
New 2D Browse Acquire New Database Signature
Barcode Image Image Image Image

4.3.01 -Line

O mis object is a simple straight line, but still has some features that you can setup. You can
choose between five different kinds of lines and a custom one
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Solid
'F'-\\ - Line Width | 2 mm | .
[1h]
=
-1
L B
| Advanced...

¥

|Mare Colors...

E Solid Line: Is a plain line.

™ Dash Line: Dashes separated by a few pixels.

™ Dot Line: Dots separated by a few pixels.

[ DashDot Line: Alternate dots and dashes.

[ DashDotDot Line: One dash, two dots, one dash, two dots.

K The Custom Line is a line that you can define as you wish.
you can set additional parameters like offset and pattern.

. Line width: varies between 0.1 to 10 mm.

By clicking on the 'advance' button

. You can, also, change the color by clicking in one of the colored squares, acquire any color you

have on your screen using the dropper or use the advance colo
Colors' button.

Q By clicking on the 'advance’ button you have access to sett

r settings by clicking on the 'More

ings that allows you to change the

shape of your line. All you have to do is to write the command on the line like shown bellow.
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/RoundCap /SquareCap

Pen Parameters:

/SquareCap|

/squareCap /FlatCap /RoundCap | = N .Cancel.

E SquareCap: A square line end that cowers the end point and extends beyond it by half the line
width.

E FlatCap: A square line end that does not cover the end point of the line.
™ RoundCap: A rounded line end.

Q If you right click on the object a pop-up menu is shown allowing you to:

Copy Ctr+C
Delete Del
Duplicate  Ctrl+D

m Send To Front
W Send To Back

Fit to Card

E Copy - Click on the copy option or use the shortcut 'CTRL-C' to copy the object to the
clipboard.

E Delete - Deletes the selected object.
™ Duplicate - Creates an exact copy of the object on the work space.
™ Send to Front - Send the object to the front of all objects on the work space.

™ Send to Back - Send the object to the back of all objects on the work space.
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4.3.02 - Rectangle

6 This object can be either a rectangle or a square, depending only of the side measures.

olf you right click on the object a pop-up menu is shown allowing you to:

Copy Ctrl+C
Delete Del
Duplicate  Ctrl4+D

m Send To Front
W Send To Back

Fit to Card

™ Copy - Click on the copy option or use the shortcut 'CTRL-C' to copy the object to the clipboard.
™ Delete - Deletes the selected object.

E Duplicate - Creates an exact copy of the object on the work space.

[ Send to Front - Send the object to the front of all objects on the work space.

E Send to Back - Send the object to the back of all objects on the work space.

! ] You can also setup a number of properties and settings on the properties tab, on the right of
your screen. All properties and settings will be addressed further on this manual.
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4.3.03 - Circle

0 This object can be either a circle or an ellipse. By moving the delimitation lines you can change
the appearance of the object.

olf you right click on the object a pop-up menu is shown allowing you to:

----------- ’
H
Copy ctri+C
Delete Del

Duplicate  Ctr+D

m Send To Front
W Send To Back

Fit to Card

™ Copy - Click on the copy option or use the shortcut 'CTRL-C' to copy the object to the clipboard.
™ Delete - Deletes the selected object.

E Duplicate - Creates an exact copy of the object on the work space.

E Send to Front - Send the object to the front of all objects on the work space.

E Send to Back - Send the object to the back of all objects on the work space.

! ] You can also setup a number of properties and settings on the properties tab, on the right of
your screen. All properties and settings will be addressed further on this manual.
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4.3.04 - Shape

O mis object can assume many different shapes. On the Shape Tab you have a dropdown menu
with several categories of shapes. Inside each there are several shapes that you can add to your
card.
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O voucan change the color by clicking in one of the colored squares, acquire any color you have
on your screen using the dropper or use the advance color settings by click on the 'More Colors'
button.

olf you right click on the object a pop-up menu is shown allowing you to:

™ Copy - Click on the copy option or use the shortcut 'CTRL-C' to copy the object to the
clipboard.

E Delete - Deletes the selected object.

E Duplicate - Creates an exact copy of the object on the work space.

E Send to Front - Send the object to the front of all objects on the work space.
E Send to Back - Send the object to the back of all objects on the work space.

O You can also setup a number of properties and settings on the properties tab, on the right of
your screen. All properties and settings will be addressed further on this manual.
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4.3.05 - Text

O The text object allows you to add text to your card document. After positioning the text on the
card design area double-click on it to start typing your text. The default text format is a text box.

Enter Text... ‘ Enter Text... 6 ‘
[ - ‘+ - -
A
Please enter text
Your Text]
. Close .

0 There are three kinds of text objects: alphanumeric, numeric and Lists.

With the alphanumeric text objects, you can use a single line text or a text box, that allows you to
write more then one line of text.

The numeric type is divided in value, integer value and date/time.

There is also Lists and Database Lists, that are no more than a small list with two fields, one works
as an index and the other as the data that the object should display.

olf you right click on the object a pop-up menu is shown allowing you to:

.
¢
H

..-.-!.<-.-.
Q
c
-
_|
1))
o —————

Copy Ctri+C
Delete Del
Duplicate  Ctrl+D

L4
L]
:
L]
i

m Send To Front
W Send T Back

Fit to Card

E Copy - Click on the copy option or use the shortcut 'CTRL-C' to copy the object to the clipboard.
Ef Delete - Deletes the selected object.

E Duplicate - Creates an exact copy of the object on the work space.
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E Send to Front - Send the object to the front of all objects on the work space.

E Send to Back - Send the object to the back of all objects on the work space.

O You can also setup a number of properties and settings on the properties tab, on the right of
your screen. All properties and settings will be addressed further on this manual.
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4.3.06 - Print Counter

0 The Print Counter object allows you to set a counter and print it on the card.

You can set the update of the object to manual or automatic and interact with a database field.

O it also allows you to define the counter numeric format and values.

00000001 {©0000001| corv  cuc
E : : } Delete Del
s e e [ — -.'lh Brrmmme- - Duplicate Ctrl+D

m Send To Front
& Send T Back

At to Card

olf you right click on the object a pop-up menu is shown allowing you to:

E Copy - Click on the copy option or use the shortcut 'CTRL-C' to copy the object to the
clipboard.

E Delete - Deletes the selected object.

™ Duplicate - Creates an exact copy of the object on the work space.

™ Send to Front - Send the object to the front of all objects on the work space.
™ Send to Back - Send the object to the back of all objects on the work space.

O You can also setup a number of properties and settings on the properties tab, on the right of
your screen. All properties and settings will be addressed further on this manual.
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4.3.07 - Print Date

0 The Print Date object allows you to print on the card the current printing date and/or time.

You can set the update of the object to manual or automatic and interact with a database field.

O it also allows you to define the date and time format.

v Des Copy Ctr+C

............. D e I TECEUREERRT R P Delete Del
A ﬁ Duplicate  Ctr+D

m Send To Front
™ Send To Back

Fit to Card

olf you right click on the object a pop-up menu is shown allowing you to:

™ Copy - Click on the copy option or use the shortcut 'CTRL-C' to copy the object to the
clipboard.

™ Delete - Deletes the selected object.

E Duplicate - Creates an exact copy of the object on the work space.

E Send to Front - Send the object to the front of all objects on the work space.
E Send to Back - Send the object to the back of all objects on the work space.

O vou can also setup a number of properties and settings on the properties tab, on the right of
your screen. All properties and settings will be addressed further on this manual.
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4.3.08 - 1D Barcode

O Tis object allows you to create a barcode. A barcode is an optical machine-readable

representation of data relating to the object to which it is attached.

There are many different barcodes types, Code 128, EAN-8, UPC among many others. Each one

with different features and settings.

You can setup to see only the bars or complement it with readable data.

0 You can also connect the object to a database field to become a dynamic readable source.

......... O R S T

+
0 0

ST SRETTRY |

L4

olf you right click on the object a pop-up menu is shown allowing you to:

Copy Ctrl+C
Delete Del
Duplicate  Ctr+D

m Send T Front
W Send T Back

Fit to Card

E Copy - Click on the copy option or use the shortcut 'CTRL+C' to copy the object to the

clipboard.

™ Delete - Deletes the selected object.

™ Duplicate - Creates an exact copy of the object on the work space.

™ Send to Front - Send the object to the front of all objects on the work space.

™ Send to Back - Send the object to the back of all objects on the work space.

© vou can also setup a number of properties and settings on the properties tab, on the right of
your screen. All properties and settings will be addressed further on this manual.
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4.3.09 - 2D Barcode

O Tis object allows you to create a 2D barcode. A 2D barcode is also an optical machine-
readable representation of data relating to the object to which it is attached, ewlved from the 1D
barcode into rectangles, dots, hexagons and other geometric patterns in two dimensions (2D).
Although 2D systems use a variety of symbols, they are generally referred to as barcodes as well.

There are many different 2D barcodes types, PDF417, Datamatrix, QR-Code between others. Each
one with different characteristics.

© You can also connect the object to a database field to become a dynamic readable source.

Copy Ctri+C
Delete Del
Duplicate  Ctrl+D

m Send T Front
W Send To Back

Fit to Card

O Picase be aware that this object is only supported on XM and XL cardPresso editions.
0 If you right click on the object a pop-up menu is shown allowing you to:

E Copy - Click on the copy option or use the shortcut 'CTRL+C' to copy the object to the
clipboard.

E Delete - Deletes the selected object.

E Duplicate - Creates an exact copy of the object on the work space.

E Send to Front - Send the object to the front of all objects on the work space.
™ Send to Back - Send the object to the back of all objects on the work space.

O You can also setup a number of properties and settings on the properties tab, on the right of
your screen. All properties and settings will be addressed further on this manual.
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4.3.10 - Image

is object is a very important one, not only because it allows you to add and work an image on
© This object i i rtant t only b it all to add and k i
your card, but also allows you to transform that image into your card background.

An image can be add to your card from any source available like a scan device, camera, disc or
cloud and allows any kind of image, jpg, png and others.

With cardPresso you can transform that image as you want, changing color, light, size and many
other settings.

0 Making it your card background is easy, right click on the image and chose 'Set as
Background' and your picture is adapted to your card size.

. D
= el lED
L
llt {f"
Bommmmm e | CEEPEr

Copy ctrl+c
Delete Del
Duplicate Ctrl+D

m Send To Front
™ Send To Back

Export Image

Set As Background

| B e e RO EE T PR EEL

Fit to Card

olf you right click on the object a pop-up menu is shown allowing you to:

™ Copy - Click on the copy option or use the shortcut 'CTRL+C' to copy the object to the
clipboard.

™ Delete - Deletes the selected object.

™ Duplicate - Creates an exact copy of the object on the work space.

[ Send to Front - Send the object to the front of all objects on the work space.
E Send to Back - Send the object to the back of all objects on the work space.

E Export Image - Allows you to export the image as a file to anywhere on your computer.

™ Set As Background - Set the image as the background of your layout.

O You can also setup a number of properties and settings on the properties tab, on the right of
your screen. All properties and settings will be addressed further on this manual.
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4.3.11 - Signature

O 1his object allows you to add a Signature on the card.

A Signature can be added from Signature Pad devices recognized by cardPresso, which are the
WinTab, Wacom Bamboo & Topaz:

- SigLite LCD 1x5 - T-L460-HSB-R and T-LBK460-HSB-R

- SigLite LCD 4x3 - T-LBK750-BHSB-R

- SignatureGem LCD 1x5 - T-L462-HSB-R and T-LBK462-HSB-R

- SignatureGem LCD 4x3 - T-LBK755-BHSB-R and T-LBK755SE-BHSB-R
- SignatureGem LCD 4x5 — T-LBK766-BHSB-R

The Signature can also be saved to a Database as an image.

Copy Ctri+C
Delete Del
Duplicate Ctrl+D

m Send T Front
W Send To Back

Export Image
Set As Background

Fit to Card

@ R

B

olf you right click on the object a pop-up menu is shown allowing you to:

™ Copy - Click on the copy option or use the shortcut 'CTRL+C' to copy the object to the
clipboard.

E Delete - Deletes the selected object.

E Duplicate - Creates an exact copy of the object on the work space.

E Send to Front - Send the object to the front of all objects on the work space.
E Send to Back - Send the object to the back of all objects on the work space.

E Export Image - Allows you to export the image as a file to anywhere on your computer.

M set As Background - Set the image as the background of your layout.

© vou can also setup a number of properties and settings on the properties tab, on the right of
g 9
your screen. All properties and settings will be addressed further on this manual.
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4.4 - Objects Properties

6 cardPresso has a properties space, shown on the right side of your screen and you can display
it as a set of tabs or as a tree or accordion set, as pictured below. To change, just right click on an
empty space on the tab and check one of the options.

D [Item |

[ITEM_34DFo1B4 | o
=) Group [ITEM_34DF91B4 |
wl
i | |

Group

=) Options [ |
E [ Design not allowed
= Options
L) o

O Do Not Print ] Design not allowed
I aci o Not Prinf

op [] De Not Print
o .
E P Opacity

i)
c
=
=)
O

Clippin
Tree , —

These tabs change depending on the object we are dealing on the working area and as you will see
further on this manual.

(i ] Script, Layouts, Clipart and Background are the four basic tabs already refered on the 'Card
Document Settings' chapter. These tabs are shown after you chose your card model and are
previously referred to in this manual.
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441 -Item

© The Item tab allows you to define the ID, Group and visibility of an object.

[item

D
ITEM_34DF91B4

Group

Options
[] Design not allowed
[1 Do Mot Print

Opacity

Clipping

U

™ Object ID - Defining the object ID not only helps you organizing data on your document, but also
gives you an easier object identification and helps you on encoding operations.

When manipulating a database you can use an ID to identify objects that will help you while
programming a script.

The options settings allows you to:

K Design Not Allowed - Check the 'Design not allowed' box protecting the object from being
changed, but only the graphical appearance and drag&drop position, not the content. This option is
applied to all objects but background.

™ Print - Lets you set if an item should be printed (Yes), if an item should not be printed (No), if it
should only be printed when it contains data (Only when has data), or if it should only be printed
when the data currently displayed in the item is valid for the type of item (Only when has valid
data).

™ Opacity - You can also define the opacity level of the object by scrolling the opacity button, from
100%, the default position to 0%.

E Encoding - For items that hold data to be encoded, like magnetic tracks, this option allows you
to manually set if the date should be encded (Yes), should n't be encoded (No) or to only encode if
the item currently has data when being encoding (Only when has data).
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4.4.2 - Position

0 In this tab you can set the position manually or check the real-time position when moving and/or
resizing the object directly in the card design area.

The same properties apply to the objects dimensions, allowing you to manually change the width
and height of the object with a higher precision level.

Position |

X [9.019 mm

Width  [31.015 mm
Height [29.112 mm

!
Y [9.283 mm =
|
|

Clipping
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6 This option allows you to change the visual shape properties of an object, setting it up the \isible
area of that object with three different formats, circle, rectangle or round rectangle.

Item

Position

Shape

|

1 | |l g

X Radius:

[4 mim

¥ Radius:

[4 mm

Alignment
Rotation
Outline

Fill

Image

Source

Script

It's like hiding the image behind a layer with a hole in the middle, and the shape of that hole define
the visible part of our image, as shown below. For instance if you chose a circle shape the area of
the photo that is sitting directly above the circle content area now remains completely \isible.

e WI_HF-M'I_WJMI.MJ!B#

o 7 _. o - -
Original Clipping Effect Format

After Clipping Effe

oTo define the clipping area and format all you have to do is drag the image boundaries.

© 2014 cardPresso, Lda



cardPresso Manual

4.4.4 - Rotation

6 In this tab you can rotate or define a rotation angle to your object... Or you can select more than
one object and apply a rotation to all the selected objects at the same time.

clipping

Qutline

Rotation |

Script

'.' cardPresso has quick rotation buttons for the most common rotations, 0, 90, 180 and 270
degrees rotation. You may also rotate the object in increments and /or decrements of 45 degrees
(also available using the shortcut 'Backspace’).

. If you wish to apply a more specific rotation use the edit box available for those situations

. Or turn the round button to the desired angle, updating at the same time the angle box value.

O Al these changes are seen in real-time on the object.

4.4.5 - Outline

6 Outline allows you to chose between five different types of predefined lines and a custom one.
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IFour Text...ll

ESolid Line: Is a plain line.
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Clipping

-
l Dash Dot e m - —————————— | - .
Line Width |3_25 mm | v .

.

| Advanced...

Fill

[ Dash Line: Dashes separated by a few pixels.

Ef Dot Line: Dots separated

by a few pixels.

E DashDot Line: Alternate dots and dashes.

E DashDotDot Line: One dash, two dots, one dash, two dots.

E The Custom Line is a line that you can define as you wish and if click on the advance button
besides the normal advanced parameters you are allowed to set offset and pattern parameters.

. Line width is one of the settings that you can change from 0.1mm to 10mm

. You can also change the color by clicking in one of the colored squares, acquire any color you
have on your screen using the dropper or use the advance color settings by click on the 'More

Colors' button.

0 Clicking on the 'advance' button you have access to a serial of settings that allows you to
change the shape of your line. All you have to do is to write the command on the line like shown

bellow.
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/RoundCap /SquareCap

Pen Parameters:

l/5quarecap| |
/squareCap /FlatCap /RoundCap [

oK |[ Cancel |

E SquareCap: A square line end that covers the end point and extends beyond it by half the line
width.

™ FlatCap: A square line end that does not cover the end point of the line.
™ RoundCap: A rounded line end.

4.4.6 - Fill

6 Define the fill color you want to see applied on your object, in case of lines, rectangles or circles
it will change the color of the object, on all other cases it will change the background color.

Outline

Al |

' solid il B

| v
More Colors...|

™ No fill: No color is applied to the object. This option is extremely handy when placing Text over
other objects.

™ Solid Fill: Fill the area with only one color and you can define the color using the standard
pallet, the dropper or using the advanced pallet within the "More Colors" button.
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™ Gradient Fill: Allows you to pick a second color and make a gradient effect with both colors
and define both colors using standard pallet, the dropper or clicking in "More Colors" button using
the advanced pallet.

Ef Dropper: In case of using the dropper you can select any color, even outside the program
window, like shown on the first picture below. After that the color is applied to the object and added

to the color pallet as you can see on the second picture.

W

| solid Fil

- ]

ET More Colors: Gives you access to an advanced color pallet.

Ef Basic Pallet Color Theme: To chose a theme for your basic pallet color use the drop menu like
shown on the picture bellow and the theme is automatically applied to the basic pallet color.
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90% Black f\

Apples
Eananas
Black Body
Camouflage
Candy
Christmas
Coral reef
Desert
Earthtones
Easter

Eyes
Feminine
Fire

Fleshtones
Metallic

Midnight
Mountain
Mud

r \Roncil

i Rainbow

T |ROSes
| — SEII'Id
Shades of Autumn

Hue (101 2| Red[so =
sat [237 |2 Green [254 2]
Val |254 }—:-1 Blue |18 5%1

. ok || cancel |

6 In this example choosing Rainbow option will apply to the basic color pallet only colors related
with Rainbow theme.

Ef Unusual Color: In case you want to add an unusual color, you have two ways to do it, you can
drag the crosshair through the panel or input directly the color values on the boxes.

After that, the new color is added to the basic color pallet.

44.7 - Font

6 When you select the 'Font' tab, a number of tools allows you to define the font of your object.
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E

.
]
i

[Fant

' "
‘Your Text... *
Font Family [ EEECEEREEEEEEEEs Beooeeneeeaae N
|. Arial ._ | ¥ J Arial __J 7]
Point Size T Arial 3
1s0p 2 0ace @) 7 Arial Black
Color T Anal Narrow
(W r153608102 .j T Arial Rounded MT Bold
Typeface T Arial Unicode MS
== s . T Arno Pro
& “L“ “H“ T Arno Pro Caption
[ verdean T Arno Pro Display
[J Render as HTML . T Arno Pro Light Display
Fr Arno Pro Smbd
T Arno Pro Smbd Caption
T Arno Pro Smbd Display
T AUdimat
T AvantGarde Bk BT AaBbz/
T Avan arde-Book 1h AcBb

'.' First you hawve the 'Font Family' where you can chose the font type, all fonts that you have in
Windows or on your OSx are displayed here.

. Point Size - Allows you to define the font size, if you check on the checkbox the size is

determined by the space available between boundaries, to change just drag and drop the selection
handles.

. Color - Chose the font color.

. Typeface allows you to define more font settings that affect the whole Textbox, like:

BIU

. You can also wrap the sentence on your object by checking the 'Word Wrap' checkbox.

';Your Tex;h *Y our

( [ word wrap ) ( [ word wrap )
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. With 'Render as HTML' checked, you can use some HTML codes in your text to change the
Typeface' in parts of it, instead of the whole Textbox.

----------------------- -.""""""""""""..
| Textbox
«Render as HTML'
Test
CIREERENENERNE “EESEEEEERENN =

Please enter text
<u=This is a</u> <i>Textbox</i=
l{b}'ﬂender as HTML'=/b> <p>Test
Close

E Text between <u> </u> will be Underlined.
E Text between <i> </i> will be in /talic.

[ Text between <b> </b> will be in Bold.
E The <p> starts a new paragraph.
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0 The bar code properties allows you to define some properties depending on the type of barcode
you want to use. There are two major types of barcodes the 1D and 2D, illustrated bellow.

Brm-Tn A ———— ]
1 1
1 1
[ [
1 1
1 [
1 1
1 1
L] [
[ [
1 1
1 [
1 1
1 1
[ [
1 1
1 1
[ EETT | CTTE ]

=
(=]

0

on cardPresso:

E Type: Chose the type of barcode you wish to use, keeping in mind that in some cases your

Barcode |

| Code 128

Barcode color

[DR51:3255|351 v]

Module width

| Auto v|

Bearer bar

|. No bearer bar

Bearer width
0.75 mm

Quiet Zone

|0 mm

Human readable

| Below

Font

| Normal

CheckDigit

|N0ne

Source

Let's start by making a general introduction, to the most common properties of barcodes, referenced

choice may change other properties range of values.

E Color: Define your barcode color.

E Human Readable: Defines if the readable data, alphanumeric characters, is imprinted or not

(only 1D barcode).

™ Font: Defines the font of the readable data (only 1D barcode).

0 Other properties and definitions are specific to each different type of barcode, therefore will be
addressed further on this manual.
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4.4.9 - Image

© voucan acquire images from any source available, from disk, from database, from a camera or
even from a scanner.

Al classes

O After you select an image and apply it to your working area, you have access to a new tab, the
image tab. On this tab you can change a set of properties as:

E Keep Ratio: Allows you to adapt the image to your object boundaries or keep the image ratio.
E Reinforce Black: This option forces the usage of Resin K on the black in the image.

E Flip Horizontal: This option reverses the active object horizontally, that is, from left to right. It
leaves the dimensions of the object and the pixel information unchanged. It looks as if the image has
been reflected along the central vertical axis of the object.

™ Flip Vertical: This option reverses the active object vertically, that is, from top to bottom. It
leaves the dimensions of the object and the pixel information unchanged. It looks as if the image has
been reflected along the central horizontal axis of the object.

E Grayscale: Applies grayscale on the image in which the value of each pixel is a single sample,
that is, it carries only intensity information. Images of this sort, are composed exclusively of shades
of gray, varying from black at the weakest intensity to white at the strongest.

E Chromakey Effect: Turn the chromakey effect on and off in which a color range in the top layer
is made transparent, revealing another image behind.

E Color: Allows you to choose the color range on which the effect will act. Use the dropper to
chose any color on the image.

E Tolerance Level - Allows you to change the tolerance level of the effect. The bigger the
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tolerance, the larger the range of colors affected by the effect.

[ Effect area - Select the area of the image affected by the effect, if all image or only on the
frame.

0 If you double click on the image the Image Editor opens with more edition tools.
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4410 - Source

0 The Source Tab allows you to define the origin of the object and parameterize that same object.
In cardPresso you have two major object classes, the images and all the text objects.

Image

[Source |

| From Disk ﬂ\
Title P /
f e i )
|please browse image | From Disk ¥
Eaiis From Disk
- From Camera or Scanner
| o From Signature Pad
From Photo Editor
Updated From Database
X Item Link
| When Item Double-Clicked i e
Save with document
|- Yes | w J
Format
|- Image Free format | »

Face Detection

| No -]

Open image editor

| Only when error

! ] On text objects and barcodes the source can be a print counter, a print date, a keyboard input,
database or item link.

On image objects and signatures the source can be the disk, a camera or scanner, the image editor,
a database field or an item link.

On the next chapters we will show you how to use them and how to define them, in sum:
how easy it is to manipulate any of the sources or its properties.
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4.410.1 - Text & Barcode

(i ] When you hawe a text or barcode object selected you can use the Source Tab to set the input
options for the object.

0 On this tab you will define what kind of object it is, how it is updated, under what condition it will
be updated, when it will be updated and the final result.

Source |

[ Keyboard Input jll I}eyboard Input Rd|
Print Counter
Print Date — Title

E?;g%;gimpur |please enter barcode data |
Iltem Link Updated
I | When item Double-Clicked |* i
Save with document
| No ¥ }
Data Type
i ............................ .. | Text Line | "] E]
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4.410.1.1 4.4.10.1.1 - Print Counter

0 This feature allows you to add a print counter to your card. It can be updated automatically and
saved with your card file, thus keeping the counter status. You can also define values, justify and set
the number of digits of the counter as explained further on this manual.

When a text object is selected you can go to the Source Tab and, on the drop down menu on top,
choose the Print Counter option or click on the 'Print Counter' button on the design toolbar.

0 You can update your counter in five different situations:

| Print Counter

Updated
[ Before Print - 4 | Before Print Card
When Item Double-Clicked .
When Load Document Vo = ave with document
Before Print | Yos

Before Pnnt Card
After Print Card

Minimum Value
(1

Clipping

Maximum Value

Alignment

Restart Value

i

Increment Value
1 =

Current Value
1

|ustified with zeros

Ratation

(ik]
£
o
=K
O

|‘|Es

Number of digits
|8
Font auto adjust

| Never

Source

E When Item Clicked - When you double-click the object it will update the counter according to
all the settings.

E When Load Document - Every time the card document is opened.

E Before Print - Count the number of times you send a print order and update the counter before
the printing procedure.

™ Before Print Card - Count the number of cards you're going to print and update the counter
before each card is printed.
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™ After Print Card - Count the number of cards you printed and update the counter after printing
each card.

0 And set the following properties:

E Save with Document - Save the settings and counters with the document so you don't loose
any data.

™ Minimum Value - Defines the counter minimum value in case of negative incrementation.
E Maximum Value - Defines the counter maximum value in case of positive incrementation.

™ Restart Value - Is the value assumed by the counter when it reaches the maximum or minimum
values. (Min Value < Restart Value < Max Value)

™ Increment Value - Defines the incrementation value, it can be positive or negative.

[ Current Value - Shows the current value.

E Justified with Zeros - Justify with zeros until the desired number of digits.

E Number of Digits - Defines the number of digits used in the counter, you can justify with zeros.
E Font Auto Adjust - Automatically adjust the font size, but only if font point size is set to auto.

™ Concatenation - Allows you to add a prefix or suffix to your counter value. If you don't want
these to be printed check the Ignore on print check box.
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4.410.1.2 4.4.10.1.2 - Print Date

(i ] This feature allows you to add a date object to your card. It can be updated automatically and
saved with your card file, thus keeping the date status. You can also format the date and time as

explained further on this manual.

When a text object is selected you can go to the Source Tab and, on the drop down menu on top,
choose the Print Date option or click on the 'Print Date' button on the design toolbar.

| Print Date
Updated
Before Print - = _// Before Print Card - |
When Item Double-Clicked .
When Load Document /- = ave with document
Before Print . | = =
Before Prnnt Card % 2 J
=8  Format
(¥]

| dd-MM-yyyy (hh:mm) | « | [...]

g
I8  Font auto adjust
=
= -
=] | Never
= L
Concatenation
=
o
=8 Increment Value
k=] !
& |1 |

Current Value
[1 ¥l

|ustified with zeros

Dutline

|_ Yes

Number of digits
Font auto adjust

| Never

Concatenation

@
o
il
3
(=]
w

0 You can update your date/time in four different situations.
E When Item Clicked - When you double-click the object it will update the date and time.

E When Load Document - Every time you open the document it will automatically update the
date object.

™ Before Print - Update the counter before the printing procedure starts and all the cards are
printed with the same date and time.

E Before Print Card - Update date and time before printing each card.
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O And set the following properties:

[ Save with Document - Save the settings and date/time of the last printing procedure with the
document so you don't lose any data.

E Format - You can format the date using one of the preset formats available thru the drop down
menu or by creating your own format by clicking on the pointed button and then write it according
with the legend bellow.

I ﬂ [:] | Date and Time format
] dd-MM-yyyy (hh:mm)

yyyy-MM-dd N . ;

yyyy-MMM-dd ' | oK cancel
Yyyy-MMMM-dd U = :
yyyy/MM/dd

| dd-MM-yyyy (hh:mm)

d the day as number without a leading zero (1 to 31
Yyyy/MMM/dd dd  the day as number with a leading zero (01 to 31)
yyyyMMMM fdd ddd  the abbreviated localized day name (e.q. ‘Mon* to
dd-MM-yyyy dddd the long localized day name (e.q. ‘Monday’ to 'Sun
dd-MMM- M the month as number without a leading zero (1-12
YYYY MM the month as numberwith a leading zero (01-12)
dd-MMMM-yyyy MMM the abbreviated localized month name (e.qg. Jan' t

dd/MM iy MMMM the long localized month name le.q. January to 'D
dd/MMMyyyy the vear as two digit nurmber (00-99)

hh:mm
hh:mm:ss

Y
wyyy the year as four digit number
Time
h the hour without a leading zero (0 to 23 or 1 to 12 if AM,
hh:mm:ss:zzzz hh the hour with a leading zero (00 to 23 or 01 to 12 if AMA
dd-MM-yyyy (hh:mm) m  the minute withaut a leading zero (0 to 59)
dd-MM-W {hh:mm:ss) mm  the minute with a leading zero {00 to 59)
s
55
z
ZZZ
AR
ap

ddmmy b miri) the second without a leading zero (0 to 59)

the second with a leading zero (00 to 59)
dd/mMmMpyyyy (hh:mm:ss) the miliseconds without leading zeroes (0 to 959)
the milliseconds with leading zeroes (000 to §99)
use AM/PM display AP will be replaced by either "AM= or

use am/pm display. ap will be replaced by either "am” or

E Font Auto Adjust - Automatically adjust the font size, but only if font point size is auto.

E Concatenation - Allows you to add a prefix or a suffix to your date and it can be printable, to do
that just check on the check-box.

4.410.1.3 4.4.10.1.3 - Keyboard Input

O mis setting allows you add an object to your card that is updated by keyboard input. It can be
updated automatically, saved with your card file. You can also choose the data type like explained
further on this manual.

When a text object is selected, you can go to the Source Tab and on the dropdown menu, on top,
chose Keyboard Input option.

E Title - You can give a name to your object, it will make it easier for further identification.

0 You can update the object in six different situations.
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Fill

Source |

[ Keyboard Input

TextBox Properties

Title Columns (30 —

: Please enter text
[ Eefore Print Card |

When Item Double-Clic ;
On Custom View l Before Print Card

On Edit View '\'—(
When Load Document ave with document

| e L m Rows |6 =
’ﬁ Updated \

Cancel

Before Print B,

Before Print Card ﬁ'—"‘-‘| No

After Print Card Data Type
IR 4 [ Text Box
Text Line B t fomibink
ok ont auto adjus
Y; | B - 3 . | Textline Properties

alue

Integer Value | pleer, ) Data Length [0
sl e
Time Vabdation Rules
Date and Time
Database list &

|

™ When Item Clicked - When you double-click on top of the object it will open an input window to
update.

™ On EditView - This setting, when chosen, allows you add a new field to a small internal
database, as you'll see further on this manual.

E When Load Document - When the card document is loaded this object is updated.

K Before Print - After the print order and before start printing, it will open an input data window in
order to allow you to update the object, after that it will not be update again until next print order, on
the example below was date field.

E Before Print Card - Before print each card, it will open an input data window in order to allow
you to update the object, on the example below was date field.

E After Print Card - After print each card, it will open an input window in order to allow you to
update the object for the next card, on the example below was date field.
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| Cancel |C0ntinue

E Save with Document Save on your card document the last object update.

E Data Type On this setting you can define what kind of data your object can hold.

E Text Line - Allows you to input text information in one line.

TextLine Properties

Data Length [go
Input Mask
Validation Rules

oK Cancel

E Data Length - Defines the length of your text line (maximum of 128 characters).

™ Input Mask - The mask consists of a string of mask characters and separators. You can define
your object input guide by choosing the mask or the Validation Rules, when both the mask prevails.

Character

— = AVOWSTIHQUOOX X Z0 >

Meaning

ASCII alphabetic character required. A-Z, a-z.

ASCII alphabetic character permitted but not required.
ASCII alphanumeric character required. A-Z, a-z, 0-9.
ASCII alphanumeric character permitted but not required.
Any character required.

Any character permitted but not required.

ASCI digit required. 0-9.

ASCII digit permitted but not required.

ASCII digit required. 1-9.

ASCII digit permitted but not required (1-9).

ASCII digit or plus/minus sign permitted but not required.
Hexadecimal character required. A-F, a-f, 0-9.
Hexadecimal character permitted but not required.
Binary character required. 0-1.

Binary character permitted but not required.

All following alphabetic characters are uppercased.

All following alphabetic characters are lowercased.
Switch off case conwersion.

Use \ to escape the special characters listed above to use them as separators.
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€ Examples:

Mask Notes

000.000.000.000;_ IP address; blanks are _.

HH:HH:HH:HH:HH:HH;_ MAC address

0000-00-00 ISO Date; blanks are space

>AAAAA-AAAAA-AAAAA- License number; blanks are - and all (alphabetic) characters are
AAAA-AAAAA;# converted to uppercase.

E Validation Rules - Validation Rules are built up from expressions, quantifiers, and assertions.
The simplest expression is a character, e.g. x or 5. An expression can also be a set of characters
enclosed in square brackets. [ABCD] will match an A ora B or a C or a D. We can write this same
expression as [A-D], and an expression to match any capital letter in the English alphabet is written
as [A-Z].

A quantifier specifies the number of occurrences of an expression that must be matched. x{1,1}
means match one and only one x. x{1,5} means match a sequence of x characters that contains at
least one x but no more than five.

Note that in general Validation Rules cannot be used to check for balanced brackets or tags. For
example, a Validation Rule can be written to match an opening HTML <b> and its closing </b>, if
the <b> tags are not nested, but if the <b> tags are nested, that same Validation Rule will match an
opening <b> tag with the wrong closing </b>. For the fragment <b>bold <b>bolder</b></b>, the first
<b> would be matched with the first </b>, which is not correct. However, it is possible to write a
Validation Rule that will match nested brackets or tags correctly, but only if the number of nesting
levels is fixed and known. If the number of nesting levels is not fixed and known, it is impossible to
write a Validation Rule that will not fail.

Suppose we want a Validation Rule to match integers in the range 0 to 99. At least one digit is
required, so we start with the expression [0-9]{1,1}, which matches a single digit exactly once. This
Validation Rule matches integers in the range 0 to 9. To match integers up to 99, increase the
maximum number of occurrences to 2, so the Validation Rule becomes [0-9]{1,2}. This Validation
Rule satisfies the original requirement to match integers from 0 to 99, but it will also match integers
that occur in the middle of strings. If we want the matched integer to be the whole string, we must
use the anchor assertions, * (caret) and $ (dollar). When * is the first character in a Validation Rule,
it means the Validation Rule must match from the beginning of the string. When $ is the last
character of the Validation Rule, it means the Validation Rule must match to the end of the string.
The Validation Rule becomes /0-9]{1,2}$. Note that assertions, e.g. » and $, do not match
characters but locations in the string.

If you have seen Validation Rules described elsewhere, they may have looked different from the ones
shown here. This is because some sets of characters and some quantifiers are so common that
they have been given special symbols to represent them. [0-9] can be replaced with the symbol \d.
The quantifier to match exactly one occurrence, {1,1}, can be replaced with the expression itself, i.e.
x{1,1} is the same as x. So our 0 to 99 matcher could be written as M\d{1,2}$. It can also be written
Md\d{0,1}$, i.e. From the start of the string, match a digit, followed immediately by 0 or 1 digits. In
practice, it would be written as A\d\d?$. The ? is shorthand for the quantifier {0,1}, i.e. 0 or 1
occurrences. ? makes an expression optional. The Validation Rule Md\d?$ means From the
beginning of the string, match one digit, followed immediately by 0 or 1 more digit, followed
immediately by end of string.

To write a Validation Rule that matches one of the words 'mail' or 'letter' or 'correspondence’ but does
not match words that contain these words, e.g., 'email’, 'mailman’, 'mailer’, and 'letterbox’, start with
a Validation Rule that matches 'mail’. Expressed fully, the Validation Rule is m{1,1}a{1,1}i{1,1}{1,1},
but because a character expression is automatically quantified by {1,1}, we can simplify the
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Validation Rule to mail, i.e., an 'm' followed by an 'a’ followed by an 'i' followed by an 'I' Now we can
use the vertical bar |, which means or, to include the other two words, so our Validation Rule for
matching any of the three words becomes mail|letter|correspondence. Match 'mail' or 'letter' or
‘correspondence’. While this Validation Rule will match one of the three words we want to match, it
will also match words we don't want to match, e.g., 'email. To prevent the Validation Rule from
matching unwanted words, we must tell it to begin and end the match at word boundaries. First we
enclose our Validation Rule in parentheses, (mail|letter|correspondence). Parentheses group
expressions together, and they identify a part of the Validation Rule that we wish to capture.
Enclosing the expression in parentheses allows us to use it as a component in more complex
Validation Rules. It also allows us to examine which of the three words was actually matched. To
force the match to begin and end on word boundaries, we enclose the Validation Rule in \b word
boundary assertions: \b(mail|letter|correspondence)\b. Now the Validation Rule means: Match a word
boundary, followed by the Validation Rule in parentheses, followed by a word boundary. The \b
assertion matches a position in the Validation Rule, not a character. A word boundary is any non-
word character, e.g., a space, newline, or the beginning or ending of a string.

Characters and Abbreviations for Sets of Characters

Element Meaning

c A character represents itself unless it has a special regexp meaning. e.g. ¢
matches the character c.

\c A character that follows a backslash matches the character itself, except as
specified below. e.g., To match a literal caret at the beginning of a string,
write \A.

\a Matches the ASCII bell (BEL, 0x07).

\f Matches the ASCII form feed (FF, 0x0C).

\n Matches the ASCII line feed (LF, 0x0A, Unix newline).

\r Matches the ASCII carriage return (CR, 0x0D).

\t Matches the ASCII horizontal tab (HT, 0x09).

\v Matches the ASCII vertical tab (VT, 0x0B).

\xhhhh Matches the Unicode character corresponding to the hexadecimal number hhhh

(between 0x0000 and OxFFFF).

\Oooo (i.e., \zero matches the ASCIl/Latin1 character for the octal number ooo (between 0 and

000) 0377).

. (dot) Matches any character (including newline).

\d Matches a digit (QChar::isDigit()).

\D Matches a non-digit.

\s Matches a whitespace character (QChar::isSpace()).

\S Matches a non-whitespace character.

\w Matches a word character (QChar::isLetterOrNumber(), QChar::isMark(), or ' _").
\W Matches a non-word character.

\n The n-th backreference, e.g. \1, \2, etc.

E Text Box - The multiline text box is used only if more than one line of input is required and
allows you to input text information. To input a new line the user must press CTRL+Enter. By
pressing only the Enter key will close the text box.

TextBox Properties

Columns |80

Rows |G

oK

Cancel

E Columns - Define the number of columns of you text box (max: 128)
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[M Rows - Define the number of rows of you text box (max: 128)

E Value - Defines the object as a numeric value.

E Minimum Value - Defines the minimum value reachable, normally used to countdown.
™ Maximum Value - Defines the maximum value.

E Step Value - Define step value when updated, use negative value for countdown.

[ Decimals - Defines the number of decimal places.

E Alignment - Set horizontal alignment

E Prefix - Defines character set that precedes the number.

[ Suffix - Defines character set shown after the number.

E Special Value - Is the value the object will assume after reaching the maximum or minimum
values.

E Integer Value - Allows you to write any integer value in one line box.

Integer Value Properties

Minimum Value o
Maximum Value 999599
Step Value 1

Alignment | Right
Prefix
Sufix

Special Value

oK Cancel

E Maximum Value - Defines the maximum value.

E Step Value - Define step value when updated, use negative value for countdown.
E Alignment - Set horizontal alignment

[ Prefix - Defines character set that precedes the number.

E Suffix - Defines character set shown after the number.

K Special Value - Is the value the object will assume after reaching the maximum or minimum
values.

E Date - Allows you to write any date value in single line box.
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Date Properties

Minimum Date |1800}01/01

Maximum Date |2100/12/31

Alignment | Left
Calendar popup | es

Date format | yyyy/MM/dd

oK Cancel

E Minimum Date - Set the minimum value to date to awids backdating.
E Maximum Date - Set the maximum value to date to awids introducing later dates.
Ef Alignment - Allows you to align text date inside object.

E Calendar Pop-up - Every time you change settings on date field it pops up a calendar to easy
date manipulation.

(€] Fevereiro_| 2011 (5]
dom seg ter gqua qui sex sab
w a[1]z 3 & s
6 7 8 9 10 11 12
13 14 15 16 17 1a8 19
20 21 22 23 24 25 26
27 28 1 2 3 4 5
4] 7 8 9 10 11 12

E Date Format - Helps you set a date value format, you have some predefined.

E Time - Allows you to write any time value in one line box.

Time Properties

Minimum Time |[p0:00:00

Maximum Time |23:5%:59

Alignment | Left

Time format | hh:mm:ss

oK Cancel

E Minimum Time - Set the minimum value to time to awids backtiming
E Maximum Time - Set the maximum value to date to awoids introducing later time.
E Alignment - Allows you to align time text inside object.

E Time Format - Helps you set a time value format, you have some predefined.
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E Date and Time - Allows you to write any date and time value in one line box.

Date and Time Properties

Minimum Date (1900/01/01
Maximum Date (2100/12/31
Minimum Time |00:00:00

Maximum Time |23:59:59

Alignment | Left
Calendar popup | No

Date & Time format | yyyy/MM/dd (hh:mm:ss)

0K Cancel

E Minimum Date - Set the minimum value to date to awids backdating.

E Maximum Date - Set the maximum value to date to awids introducing later dates.
E Minimum Time - Set the minimum value to time to awids backtiming

E Maximum Time - Set the maximum value to date to awoids introducing later time.
™ Alignment - Allows you to align text date inside object.

™ Calendar Pop-up - Every time you change settings on date field it pops up a calendar to easy
date manipulation.

Q Fevereira_| 2011 ()
dom seg ter gqua qui sex sab
30 31{1:2 3 4 5
9 10 11 12
13 14 15 16 17 18 19
20 21 22 23 24 25 26
27 28 1 2 3 4 5
6 7 ] 9 10 11 12

™ Date and Time Format - Helps you set a date and time value format, you havwe some
predefined.

™ List - Allows you to create a list, composed by two columns, the first is an index column and the
second is the data column.
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[ List

Text Ling

Text Box
Value

Integer Value
Date

Time

Date and Time

Text Data

Database list

Please enter text

@

2 | v

| Close

B WK =

Ef Database List - Allows you to create a combobox to select the update data to your object. This
only works if connected to a SQL database.

List From database Properties
SQL Select

User column |El |

Data Column |1 |

Limit Fows

[ oK H-::ancel]

O e SQL Select statement is part of the SQL code and bellow we describe some examples in
how to use that code, specially how to use the select statement.

SELECT column_name(s)
FROM table_name

{!] Lets consider the example bellow, from our internal database, where we select the position,
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extension and salary fields, from the employee database. This is the first step, the second is to set
a condition, only consider the records with the field salary with a value lower than 35000.

Now the selection is made and the condition is set.

List From database Properties
SOL Select

SELECT position, extension, salary
FROM employee
WHERE| salary<35000

User column |p

Data Column (1

Limit Rows 40

oK Cancel

E User Column - Here you define what column will be listed on the combo box, as a reference to

the Data Column.

™ Data Column - Define to wish column belong the data that will be shown on the database list

object.

Ef Limit Rows - Setup the maximum rows to be listed on the combo box, to a maximum of 99.

© After we define the User Column as 0 and the Data Column as 1, we define the column to be
listed as the first (the count starts from zero) and the Data Column as the second and the result will

be as shown bellow.
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Text Line

Text Box
Value

Integer Value
Date

Time

Date and Time
List
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Database list

Please enter text

[ Sales Representative

List From datahage Properties
SQL Select

SELECT position, extension, salary

FROM employee
WHERE]| salary<35000

User column |l}

Data Column |1

Limit Rows |40 =

Sales Pepresentative

Sales Representative

Mail Clerk
‘ Receptionist

On your combo box is only listed the position field records (User Column 0) that matches the
condition (salary<35000). And when the position Mail Clerk is selected the object assume the
extension field record of the selected position 6261.

Ef Font Auto Adjust - Automatically adjust the font size, but only if font point size is auto.

™ Concatenation - Allows you to add a prefix or a suffix to your date and it can be printable, to do

that just check on the check-box.
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4 4.4.10.1.4 - Database

(i ] There are two ways to add an object linked to a database to the card document. Open a
database and drag and drop the fields like explained further on this manual or create the object and

then connect it to a database. We will address the last option now.

After creating an object go to the Source Tab and select the Database option.

0 After you have chosen this option your tab changes.

Paosition

Clipping

=
C
@
e
fe
=

=
<L

Rotation

Qutline

J’ Source

[ Keyboard Input
Print Counter
Print Date
Keyboard Input
Database

Itermn Link

| When Item Double-Clicke:

Save with document

|N0

Data Type

|. Text Box

Font auto adjust

[ Never

r

| Database

[ Connect to Database ...

)

Font auto adjust

| Never

Concatenation

© And the next step is too click on the button 'Connect to a Database'. The Database

Connection Wizard will start allowing you to connect to any database you want.

After the database is opened, by default the object will be connected to the first table and first
column of your database, like shown on picture bellow. All you have to do now is define the table and

column that you want your object to be linked to.

E Font Auto Adjust - When you have defined a size for your object it allows you to choose if you

want cardPresso to automatically adjust the font size.
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l Database | = |
g [ Connect to Database ... |
el Font auto adjust
£

l Never |+ | || Never -

= - Mewver
H i
= Expand to fit
& Shrink to fit

Q
=]
s
ju
o
w

™ Concatenation - Allows you to add a prefix or a suffix to your data and print it. While in
datatabase mode you can concatenate up to four columns on the same object and define a prefix
separator if needed.

Data Prefix
| | O ignore on print
Data Suffix

| O ignore on print
- oncatenate database columns

Column Prefix

Column

ﬂ Employee ID |+ ])

Column Prehx

Column

{Not Used) | v

Column Prefix

Column

([ (Not Used) |+ ])

[ OK |[Cance||
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W mle Ldt View ol Datsbase Window Help
.ﬁﬂ..ﬂ:ﬁi &.ﬁ e EEEE -
B EEEE = En E
-| C:FrogramDatal e DATABASEfintomalCatak
-
- =
&
e | as
R :
& -
S hﬁm:ﬂ (0o:00:00) 2
H: z Hire Date .
\ | 199103729 (00:00:00) 2
:ﬁ Home Phone
% I A2061555-0857
nl Extersson E
5 | 23 1
Zoom Ou -l

As you can see the first element on our object is 'Employee ID' the one connected by default and
the two others we choose to merge in our object, the first and last names.
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4.410.1.5 4.4.10.1.5 - ltem Link

0 This option allows you to connect an object to another, assuming the same values with
automatic update.

Fill

ont

R

Item Link o | » ltermn Link

Print Counter '
Print Date Item / "’
Keyboard Input | "[_—‘ =
Database J
item Link Font auto adjust EMPLYEEID
1D BARCODE
| Never |*] 2D BARCODE

Script

|

When you chose this option your tab changes, allowing you to chose an object to link, showing on
the list all objects that are on the card space and which is possible to connect, in this particular
case we have a card with three other objects.

0 When connected the object will assume the linked object value and ewery time it is updated so is
our object.
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4.4.10.2 -Image & Signature

0 When you select an image object a new tab is added to properties tabs, the Image Tab, where
you will be able to define your image settings. But the source tab also changes, allowing you to

define the source settings of your image file.

4.410.2.1 4.4.10.2.1 - From Disk

| From Disk

From Disk

Title

From Disk

|please editimage

Source

|c‘..f

From Camera or Scanner
From Signature Pad

From Photo Editor

From Database

Itern Link

Updated

| When Item Double-Clicked

Save with document

|"|'bs

Format

| Image Free format

Face Detection

|N0

Open image editor

| Only when error

i ] This option sets the image source as the disk. When the object is updated the browser opens

allowing you to pick an image from disk.

To open an object from disk the procedure is simple, just click on the 'Browse Image’ button, add a
picture object to your card and a window will open allowing you to browse for your file.

Like shown on the picture bellow:
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Ef Title - Here you can give a nameftitle to your image, it will be easier for you to identify your
object later in further operations.

E Source - Opens a dropdown list with all cameras or scanners that are installed on your pc or
mac.

Ef Updated - Your object is updated in five different situations:

Fill

S e oA -

When Iltem Double-Clicked

Source On Custom View

On Edit View

[ From Disk When Load Document
Before Print

Title Before Print Card

After Print Card

[Please browse image

Source
[Image Free format |+
Image 3x2
Updated Image 2x3
[When ltem Double-Clicked Image 4x3
Image 640x480
Save with document Image 480x640

Image 800x600
[‘ES Image 600x800
Image 1024 x768
Format

Image 768x1024
Image 1920x1080
Image 1080x1920

Imaﬁ Free format

[ Image Free format

Face Detection

[NO

[Oriywhen emmor |~

Yes
Mo

Oﬁwhen error

Open image editor

[ Only when error
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™ When Item Double-Clicked - When you double-click on top of the object it will open the
interface related to the source you have chosen.
E When Load Document - Every time you open the card document.

E Before Print - Before the printing procedure it will open the interface related to the source you
have chosen.

E Before Print Card - Before each time a card is printed it will open the interface related to the
source you have chosen.

™ After Print Card - After printing each card it will open the interface related to the source you
have chosen.

E Save with Document - Save the image with the document so you don't loose any data, but in
the other hand if you don't want to keep the image for a smaller card document just chose 'No".

E Format - The image can have a pre-established format, like shown on the image abowe, adapting
the image to it or a free format, allowing you to keep the image source format.

E Face Detection - When you chose yes, after the image as been acquired the image editor
opens, allowing you to chose the face detection option.

E Open Image Editor - You can open the editor every time the image is updated (yes), never
open the editor (no) or open the editor only when an error is detected (Only when error).
4.4.10.2.2 4.4.10.2.2 - From Camera or Scanner

O Atter you add an image to your card, the first thing that opens is the image editor, but you can
change your image source any time you want and a camera or scanner is one of your options.
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Fill

Image [‘M‘len ltem Double-Clicked | +
| When Item Double-Clicked

_Source J On Custom View
On Edit View
| From Camera or Scanner When LOEI_d Document
Before Print

Before Print Card

Title i
After Print Card

|Please browse image

Source
[ Image Free format v

| TwBrother DCP-J315W LAN

Image 1x1
Image 3x2
Updated Image 2x3
| When Item Double-Clicked Image 4x3
Image 640x480
Save with document Image 480x640

Image 800x600
Image 600x800
Image 1024 x768
Image 768x1024
Image 1920x1080
Image 1080x1920
Image Free format

|‘|'Es

Format

| Image Free format

Face Detection

|N0

Open image editor [Onlywhen gror_ 1 ¥

| Only when error

Only when error

After chose this option your source pad changes allowing setup the camera or scanner options.

™ Title - Here you can give a namef/title to your image, it will be easier for you to identify your
object later in further operations.

E Source - Opens a dropdown list with all cameras or scanners that are installed on your pc or
mac.

E Updated - Your object is updated in five different situations:

™ When Item Double-Clicked - When you double-click on the object it will open the interface
related to the source you have chosen.

Ef When Load Document - Every time you open the card document.

E Before Print - Before the printing procedure it will open the interface related to the source you
have chosen.

Ef Before Print Card - Before each time a card is printed it will open the interface related to the
source you have chosen.

E After Print Card - After printing each card it will open the interface related to the source you
have chosen.

™ Save with Document - Save the image with the document so you don't loose any data, but in
the other hand if you don't want to keep the image for a smaller card document just chose 'No'.
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™ Format - The image can have a pre-established format, like shown on the image abowe, adapting
the image to it or a free format, allowing you to keep the image source format.

E Face Detection - When you chose yes, after the image as been acquired the image editor
opens, allowing you to chose the face detection option.

™ Open Image Editor - You can open the editor every time the image is updated (yes), never
open the editor (no) or open the editor only when an error is detected (Only when error).
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4.410.2.3 4.4.10.2.3 - From Signature Pad

0 Signature pad is a signature acquisition device, cardPresso work essencial with two kinds, the
Topaz or any device that work with the WinTab drivers.

The acquisition procedure is simple, after click on the 'Signature’ button and add the signature
object to the card a list will pop-up to allow you to chose the device in case of the Topaz, like shown

bellow.

After choosing the device the interface window will show and wait for you to add the signature to the
device like in the pictures bellow:

L Pean e
ilmhu evmplate 1
|

TOPAZ WINTAB

The Topaz device also allows you to have templates for the signature frame. The Wintab drive have a
track pressure setting that according with the pressure made by the pen makes the line thinner or

thicker

Like any other image object, cardPresso allows you to use an existing object, all you have to do is
to click on the object and change the source to 'From Signature Pad' and starts the procedure of

signature acquisition.

Ef Source - Opens a dropdown list with all signature devices that are installed on your computer.
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E Updated - Your object is updated in five different situations:

‘ Please select your Signature Dewce from the list below

| mpaz siguite LCD 15 Backde

(Bgaz SigernColers.?

WAz Siglite LCD 1x5

|Rpaz SigLite LCD 1x5 Backit
™ Bpaz Siglite LCO 4x3

Topaz SignatureGem LLD 1x5

Tpaz SignatureGem LCD LS Backit I

Topaz SignatureGam LED 4x3
Bpaz SignatuneGem LCD 4x3 (TLBKT5SSE-BHSE-R)

TBpaz SignatureGem LCD 435 '
Source |

| From Signature Pad

[ wWhen Item Double-Clicked v Title

When Item Double-Clicked
| On Custom View

|please sign here |

Oon Edlt View Source
When Load Document
Before Print | Topaz Signature Pad

Before Print Card

After Print Card 4 Updated

Image Free format S | When Item Double-Clicked | =
Image 1x1 Save with document

Image 3x2 5
Image 2x3 | Yos lize
Image 4x3 \ J
Image 640x480

Image 430x640 pamk

Image 800x600 -
Image 600x800 | Image Free format J
Image 1024 x768 "

Image 768x1024
Image 1080x1920

Image Free format

E When Item Double-Clicked - When you double-click on the object it will open the interface
related to the source you have chosen.

Ef When Load Document - Every time you open the card document.

E Before Print - Before the printing procedure it will open the interface related to the source you
have chosen.

™ Before Print Card - Before each time a card is printed it will open the interface related to the
source you have chosen.

[M After Print Card - After printing each card it will open the interface related to the source you
have chosen.

™ Save with Document - Save the signature image with document so you don't loose any data,
but in the other hand if you don't want to keep the image for a smaller card document just chose 'No'.

™ Format - The image can have a pre-established format, like shown on the image above, adapting
the image to it or a free format, allowing you to keep the image source format.
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4.410.2.4 4.4.10.2.4 - From Image Editor

(i ] The Image Editor brings you new tools for image edition, there are many ways to open the image
editor, but to acquisition only one, open an image object and then change the source to 'From

On the tool bar you can set this settings on your image:

E Rotate clockwise - Is the circular motion is one that proceeds in the same direction as a
clock's hands: from the top to the right, then down and then to the left, and back up to the top.

Ef Rotate anti-clockwise - Is the circular motion is one that proceeds in the opposite direction as
a clock's hands: from the top to the left, then down and then to the right, and back up to the top.

E Flip Horizontal - This option reverses the active object horizontally, that is, from left to right. It
leaves the dimensions of the object and the pixel information unchanged. It looks as if the image has
been reflected along the central vertical axis of the object.

™ Flip Vertical - This option reverses the active object ertically, that is, from top to bottom. It
leaves the dimensions of the object and the pixel information unchanged. It looks as if the image has
been reflected along the central horizontal axis of the object.

™ Brightness and Contrast - The Brightness/Contrast adjustment lets you make simple
adjustments to the tonal range of an image. Moving the brightness slider to the right increases tonal
values and expands image highlights, to the left decreases values and expands shadows. The
contrast slider expands or shrinks the owerall range of tonal values in the image. To change values
you can drag the slider to the left or to the right or setup manually typing the values on the boxes.
The values can go from -128 to 128.

E Color Balance - Is the global adjustment of the intensities of the colors (typically red, green,
and blue primary colors or RGB system). Changing the owerall mixture of colors in an image and is
used for color correction and when you drag any of the sliders, you can see those corrections taking
place, adjustments are made to the color values RGB (on screen) or CMY (on printers). The values
can go from -128 to 128.
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™ Color to Grey - Apply gray scale on the image in which the value of each pixel is a single
sample, that is, it carries only intensity information. Images of this sort, are composed exclusively of
shades of gray, varying from black at the weakest intensity to white at the strongest.

E Color to Monochrome - Not a combine black and white in a continuum producing a range of
shades of gray but really starkly contrasted black and white.

E Zoom In - This tool allows you to obtain a larger image, or a closer view.
Ef Zoom Out - This tool allows you to obtain a smaller image, or a farther view.
E Zoom Auto - Reset image to its initial size.

™ Export Image - You can sawe the image as... in many different formats like png, jpg, bmp, tiff
and others.

E Select Image Acquisition Source - Allows you to select the image acquisition source from
any device that is connected or installed on your pc. It may appear some devices that are not
connected but are installed.

E Image Acquisition - This tools opens the interface related with the image acquisition source
you had chosen.

™ Open Image File - Opens an image file from your system, including disk, pen, memory card or
any other source.

E Select Image File Path - Allows you to chose your default image file path from all that you had
already used before on your document.

M Face Detection

™ Face Detection Setup

E Undo - It erases the last change done to the document reverting it to an older state.
E Clear Image - Erases the image from Image Editor.

™ Cut / Crop - On cardPresso crop tool you don't use the traditional handlers, the visual area is
automatically resized to the image object boundaries, to cut/crop the image all you have to do is to
drag or zoom in on the image and every thing that is on the blur area (gray and black squares) when
you click the cut/crop button, goes away. And the image is automatically adjusted to the object
area.

M save Changes - Click on this button to accept the changes.

™ Cancel - Click on this button to quit on the changes.
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4.410.2.5 4.4.10.2.5 - From Database

6 cardPresso allows you to connect an image object to a database image, this way you can
setup the object as you want and then connect to the database image adapting it to your object.

The procedure is simple, first add a image object to your card change the source to 'From
Database’.

0 If not connected to a database yet o click on the 'Connect to Database' button.

e
et the clatabass direer that identiien your databane cotnecton.

......... o il Catabases msALCaa)
Derect C5W 6 TXT Rl Do

Chrict Entel il Bt

SR wirsan 3

orwct Mccmss Fle Driver

G Databade Conm traty {DOBE
Dpan Dakabane Cornectviy (DOBE ane]
MO Dt

. The connection wizard will start

i ] After the connection is made, if there is no image field, the link is not made and the list stays
like the image bellow, empty.

If there is only one image field, the cardPresso recognize it and the link is automatic.

0 If more then one then a list will show you the options for you to chose, like shown
bellow.

| K
cardin
F20M5435
32848035
BIEDTFIS
F20M9435
32448035

DATABASE
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Source ‘

| From Database

Table
| Employee
Column
| Photo - [@Phata v
Save with document @Photo
@image
| MNo

Face Detection

|Na

Open image editor

| Only when error

0 If you add a field image, please don't forget to refresh the database.

4.410.2.6 4.4.10.2.6 - Item Link

(i ] This option allows you to connect (link) one object to another object, assuming the same data
values with automatic update.

When you choose this option your tab changes allowing you to chose an object to link, showing on
the list all objects that are on the card document that you can connect to,

Q For the next sample we will use an image object.
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o
=
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o

6 When connected, the object will assume the linked object value and every time it is updated also
the first object will also reflect the data from the linked object.

This option allows you to have two image objects, one at the front of the card and another at the
back of the card, sharing the same data.

4.4.11 - Alignment

6 The alignment tab allows you to define the object alignment inside the boundaries.

[Alignm ent ]I

; . S R . Select your item alignment
Your Ter1 - b g 5 o -

Rotation

Your Text
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As you can see you can define vertically from top, middle or bottom and horizontally from left, middle
or right.

When the point size is in auto, on the font tab, it means that the font size justify the text to the
boundaries what makes the horizontal adjustment very small

O The default position is left and middle.
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4412 - Script

© There are two different locations where you can write in cardPresso's design area. One for each
object and one for the document. In this chapter we focus on the object script.

This is an advanced user area, where you can program actions and procedures in javascript
language in order to define settings or update your object.

[Scr‘ipt |

[ When Item Double-Clicked ._
veevre©ey

When [tem Double-Clicked
On Custom View

On Edit View

when Load Document
Before Print

Before Print Card

After Print Card

Record changed

Script | Output @

. This drop-menu allows you to define when the actions or procedures must take place.
. And in the space bellow you can write your lines of code.

'.' To see the log of your program output, change tab bellow.

© 2014 cardPresso, Lda



m cardPresso Manual

4.4.13 - Multi Align

6 The multi align tab is only displayed when three or more objects are selected and is divided in
two classes, the alignment between objects and the distribution.

[Multi—AIign j

( Alignment Between Objects |}

F

P

Multiple selection

-

_
wx

ks

™ Alignment Between Objects - Aligns vertically and horizontally the objects to top, middle or
bottom and to left, middle or right using as boundaries the card limits.

™ Distribution - Allows you to distribute the objects on the card area equitably, but instead of
using the card limits as a reference uses the object boundaries referring to the last object selected
that is marked with blue selection handles.

All other objects will be allocated according to the selection and having as a reference the last one
selected, notice that the reference object is also the anchor and will not move, all the others will be
placed according with the distribution settings.

In short, the space occupied by the three or more objects will always be the same, the space
between them is the one that will be arranged.
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4.5 - Edit View

0 This chapter will explain you what the Edit View is about, its basic concept, features, availability
and objective.

Imagine that you have a small business, with eight or ten employees and you want to keep a record
for each and even print a card for time attendance or access allowance
And then you think... but | don’t now how to work with a database.

{!] Edit View is a very simple, small but powerful alternative to a database, where you can
keep up to ten records, and manipulate them as you wish.

0 The Edit View is available from our basic edition, the XXS, allowing you to have a first contact
with cardPresso capability of database manipulation and if you don't need more than ten records or
don’t know how to work with a database, then the Edit View may become your ideal solution.

All the records are saved into you card document file, so there are no attached files or any other files
to look after and you can use an existing card template or create a new one.

Edit View also allows editing any kind of field type that you can find on any other database, text,
date, numbers and also allows you to add and edit images of any kind.

Ok after the presentation we took a cardTemplate like the one on the picture below:

£ s ot i
Lo A - / S .
;\F/ LR R R / S
BRr, e [N o dl
/\‘I W yDuTE R pany.com -

o | j./_ B -

B
v

architects

-ﬂ:?éré,mly Hardens: L“!

P . |
" Engineer Supervisor \er‘

~

As you can see we have three workable objects, the name, the position and the photo.

0 Click on the name, for example and then on the source tab on the Update option chose 'On Edit
View'
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W Fe Edt Wiew Pol Database Window Help

=g

architects

Yourlogo.

Updated

[ on Edit view

When Rem Double- Chcked
On Custam View

Sav

2 4 : ; When Load Document
- o ; e Dat Bedare Print

* e Befare Print Card
|After Brant Card

EPBEEEER-=on[ B

0 Then a new tab is available, the Edit View tab.

‘m V\ A EEE gs
- 'XXXXK

1 of 1 history records

Photo

architects

Yourl ogo

-~ Jéremy Hardens™ %
" Enginesr Supendsor Ny

Name

[Jeremy Hardens |

Position

|Eng.ineer Supervisor |

Very similar to the database tab, with the command buttons on the top and already with our name
field.
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'.' Go to the first record

. Go to the last record

'.' Go to the next record

'.' Go to the previous record
. Delete displayed record
. Add a new record

(i ] To start lets give names to our objects, like Name, Position and Photo, it will be easier in the
future to identify them.

To add the other objects to the Edit View the process is the same, select the object, go to the
source tab and on the Update option chose 'On Edit View".

Now we have all three objects on the Edit View, to order them as you like just drag and drop on the
tab.

| Edit View |

Photo

Name

|Jleremy Hardens

Name

Jeremy Hardens

Position

|Engineer Supervisor |

O you have to do now is add more records, filling the fields on the 'Edit View' tab, up to a
maximum of 64 records (on XXS Edition only 10).
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Chapter 5. Database

O A database is an organized collection of data. A database is typically organized to model
relevant aspects of reality in a way that supports processes requiring this information

This chapter explains you how to connect to a database through cardPresso and how to use it to
your advantage

5.1 - Connection

0n cardPresso there are two ways to connect to a Database.

One of them is by clicking on the Connect Database icon in the Dockbar.

The other is by selecting Connect in the Database Menu.

* Fle Edit View Thol gatahase Window Help

£3) Connect
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5.1.1 - Configuration

0 here are several Database Drivers at your disposal:

XXS only has the cards internal database accessible from the Edit View as explained in chapter
4.5

XS has the, Direct CSV & TXT File Driver, that can only read the fields in these databases.
Edition of their records isn't possible through cardPresso.

And the Direct Excel File Driver through which cardPresso can edit the fields and records of the
Database.

With these drivers it is also possible to add Links to images and their Folders.

XM can connect to SQLite version 3 and the Direct MS Access File Driver. From here on it is
possible to Alter Tables and in the records add images as Binary file.

The cardPresso Internal Database (msAccess) becomes available in this Edition.

XL adds the ODBC Drivers and with them it is possible to connect to any Database with ODBC
Support, like: SQL Server; Oracle; MySQL,; as others.

Database Driver
Please select the database driver that identifies your database connection.

) .

Internal Database {(msAccess)

Direct CSV & TXT File Driver

Direct Excel Ale Driver

SQLite version 3

Direct Access FAle Driver

Open Database Connectivity (ODBC)
Open Database Connectivity (ODBC ansi)
MyS QL Driver

= Back Mext = : Cancel j

After selecting the Driver you will be prompted to Select or Browse to the Database.
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Database
Please select the database that you wish to connect to.

QODBC:Open Database Connectivity (ODBC)

Database [| | v |

Cennection Options | |

|DD BC Administratﬂr]

Or

|
|Emwse For *.csv|

Prompt for credentials

| < Back || Next = ]| cancel |

© The instructions on how to configure each Driver connection, will be addressed further on this
manual.
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5.1.1.1 - Direct CSV & TXT Driver

On the Direct CSV & TXT Driver there are seweral configuration options, usually cardPresso
Guess function does the required configuration when the CSV or TXT file are opened.

Auto \ ;-
File Fields ’—mu .—3

Sample.tx | Number BE%& ‘
NAME |

Ale Encoding Auto ° ;J Date (150 88359-1 |

— Photo | Feld delimited

. '._J [Feld delimited . |
® |

Type _.Fiaeld delimited

o — Fxed Record Size
Delimiter | | Banking Structured Fle

[ Has columns header] '._'-i-_i = ) f . =
¥
<TAB>

<AUTO= .
- 0D | =a

1 String

Istang I
Integer Number

Guess QK Cancel Fractional Number

| Date

| Time

| Date and time

'.' File Encoding - The File encoding is by default as 'Auto’, if the encoding used by the database
is on the dropdown list chose it.

. Type - Is for the Size of the Fields in the Database.
'.' Delimiter - It is possible to chose the Delimiter used in the Database or Input it.

'.' Field Type - Select the Field Type accordingly.

0 Explanation on the next connection steps will be addressed further on this manual.
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5.1.1.2 - Direct Excel Driver

On the Direct Excel Driver it is possible to confirm the structure of the database and if needed
add more Fields to it. The cardPresso Guess recognizes the structure and configures the
connection, if the configuration isn't correct, change it accordingly.

File

Sample sds

Worksheet
Header

Data

Guess

o

@ Mame
Sample '] |Date

Fhota |
Al (D) b I

A2 e :
Y

= ~

Type String “ - Stnng

|Stnng |
Integer Mumber

| Fractional Number

Date

Timna

Date and tirme

Length 10

(o4 Cancel

. Worksheet - Chose the Worksheet to which the card is to be connected.

. Header - Select the Header of the Database.

'.' Data - Select from where the Rows start.

'.' Type - Select the Field Type accordingly.

0 Explanation on the next connection steps will be addressed further on this manual.
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5.1.1.3 - Direct MS Access Driver

0 Since the data stored in the MS Access and the SQLite Databases has a fixed format, no
special configuration is needed. Just browse to the Database and open it.

The cardPresso Internal Database is a MS Access Database provided with the cardPresso
installer and serves as a Sample and for test purposes.

Database
Please select the database that you wish to connect to.

QMDE:Direct Access Fle Driver

Database |ASEfinternalDatabase.mdb |']

Browse Fur*.mdh]

[J Prompt for credentials

| -::Back” Next = H Cancel

0 Explanation on the next connection steps will be addressed further on this manual.
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5.1.1.4 -Internal Database

eEach cardPresso document contains an internal database as a smaller yet more convenient way
to keep records. This means you can have your own database records saved within the cardPresso
document itself, without need of external database files.

To connect to the internal database you can use the Connect to Database button.

On the following window select document Internal Database.

Database Driver
Please select the database driver that identifies your database connection.

PR e e e e
cardPresso Internal Database (msAccess)
Direct C5V & TXT Fle Driver

Direct Excel File Driver

SQLite version 3

Direct Access File Driver

Open Database Connectivity (ODBC)
Open Database Connectivity (ODBC ansi)
MySQL Driver

= Back Mext = | Cancel

You can then use Database Operations to create your own tables and columns and save them on
your cardPresso document.

5.1.1.5-0DBC

i ] The Open Database Connectivity (ODBC) provides the means to connect to several
Databases, such as, SQL Sener, Oracle, IBM, Fox Pro, dBase and others.

In case of Databases containing special characters, the usage of the Open Database Connectivity
(ODBC) ansi is advised.
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Database
Please select the database that you wish to connect to.

QODEC:0Open Database Connectivity (ODBC)

Database [ | - |

Connection Options | |

I 'ODEBC Administrato r]

User DSN | System DSN | File DSN | Drivers | Tracing | Connection Pooling | About |

|Jser Data Sources:

Jm—
| £ Mame Diriver | Add...
Exicel Files Microsoft Excel Driver ("xds, ~xdsx, ~xdsm, ~“x |
Remove

M5 Access Database Microsoft Access Drver " mdb, ~accdb)

4| m | b

An ODBC User data source stores information about how to connect to
the indicated data provider. A User data source is only visible to you,
and can only be used on the cument machine.

(==’

Select a driver for which you want to set up a data source.

Mame Wi+

Drriver da Microsoft para arquivos texto (Thd; ~.cav)

&
Driver do Microsoft Access ("mdb) &
Drriver do Microsoft dBase (~.dbf) [
Driver do Microsoft Excel{™xs) &
&
1
6
;

Driver do Microsoft Paradox (".db )
Driver para o Microsoft Visual FoxPrao
Microsoft Access Driver (" mdb)

B [ . T— "o

4 L)
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By selecting the ODBC Administrator these options are available:

User DSN - Shows the existing connections and provides the possibility to Add more connections
and Remove or Configure existing connections.

System DSN - Shows the existing connections and provides the possibility to Add more
connections and Remove or Configure existing connections.

File DSN - Provides the means to connect to a data provider.
Drivers - Shows the connection Drivers installed on the system.

Tracing - Provides the means to log the calls to the ODBC drivers for use by the support personel or
to aid in debugging your applications.

Connection Pooling - Provides the means to reuse open connection handles.

About - Shows the ODBC core components available.

o Please contact your SysAdmin for the configurations required to connect with your Database.

0 Explanation on the next connection steps will be addressed further on this manual.
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5.1.1.6 - MySQL Driver

0 The MySQL Driver allows to connect to a MySQL Database.

Database
Please select the database that you wish to connect to.

QMYSQL:MySQL Driver

Database [test "]

Hostname |1l].l].2.2 ]

Port |Default =

Connection Options | |

Username |mﬂt |

Password [ ]

Keep credentials
e Prompt for credentials

[ OK H Cancel ] FTH Mext = H Cancel ]

0 Please contact your SysAdmin for the configurations required to connect with your Database.

0 Explanation on the next connection steps will be addressed further on this manual.
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5.1.2 - Database Operations

6 The Database Operation is an important function for XM and higher Editions. In the Database
Operation it is possible to Select, Create, Alter or Drop Database Tables, making it possible to
personalize a Database with cardPresso.

Since the CSV, TXT and Excel Databases do not have multiple Tables only the Select Table is
possible in their case.

Database Operation
Please select the operation you wish to perform on your database.

‘ OMDEB:C:/ProgrambDataf e JDATABASE/internall

Operation [Se&ect Table |~

Select Table
Employ Create Table
Alter Table

Drop Table
Select View
Select ...m Table
Select ALL

TABLE,19 Columns

| < Back | Next > || Cancel

This example is based on the cardPresso Internal Database.
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5.1.3 -Table Columns

6 In this part of the Database Connection Wizard it is possible to select which columns of the

selected Table you need.

Table Columns
choose Table columns

CProgramDatal cec e JODATABASE/nternalDatabase. mdb -

Columns

Employee ID
Supervisor ID
Last Name
First Name
Position
Birth Date
Hire Date

[[] Home Phone

Extension
[l nbhatns

E]

H select all columns

< Back H MNext = || Cancel |

[ Select all columns [ Select all columns At least one column must be selected]

6 If no column is selected the Wizard won't continue.
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5.1.4 - Guide Columns

6 The Guide Columns will work as an Index of the Database.

Guide columns
choose Guide columns

C:ProgramDatal ceceem 'DATABASESNnternalDatabase. mdb -
Guide columns

Employee ID [=]
Supervisor ID

] Last Name

Frst Name

Position

Birth Date

Hire Date

Home Phone

Extension E

C——

[ = Back ][ MNext = H Cancel ]
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5.1.5 - Database Filter

6 In the Database Filter you can add conditions to filter what is shown from the database. These
conditions have to be written in SQL Script without the "Select * where".

Filter
Filter

C:/ProgramData/ wocecece. JDATABASEfinternalDataba

Database Filter

[ < Back H Next = ” Cancel ]

Flter
Filter

C:/ProgrambDataf «coeueei. JDATABASEfinternalDataba

Database Filter

"Supervisor ID” = 5 OR “Supenvisor ID” = 2

czBack” Mext = H Cancel J
————
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5.1.6 - Order Columns

6 With the Order Columns it is possible to change how the database is shown in cardPresso.

The organization rules used by cardPresso for the selected columns are:
Empty fields first, then the Numeric fields from the smallest value (0) to the biggest value (+9),
followed by the fields in Alphabetic order.

Order Columns
choose Order columns

C:/ProgramData) oo IDATABASE/internalDataba
Order columns

Employee ID [1] (=]
[[] Supervisor ID [
[ Last Name

Frst Mame

[ Position

[ Birth Date

[ Hire Date

[l Home Phone

@ Extension F

< Back H Finish ]| Cancel ]
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5.1.7 - Properties

0 It is possible to review the configuration of the Database connection through the Database Menu
and selecting Properties.

Tool EsE\eEEEEN Wndow Help

T8 Disconnect

o) Refresh
£ Properties

Ja| First record
4 Previous record
24 Mext record

e Last record

4 Insert record

- Delete record

! ] The Database Properties are mainly used to check the configurations of the connection. Do not
change them unless necessary.
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Connection Properties

Property Value
4 Connection
Timeout |0secs & i
Driver QMDE
Host
Port -1
Database C:/ProgramDatal ..o
Usemame
Keep credentials =
Table Employee
-
Saved images format AUTO |+
Include Images in recurdset
Database thumbnails Yes | v

—
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5.2 - Dockbar

6 The buttons in the Dockbar ease browsing between records and managing the Database.

— | [+

) |

Database Disconnect Database First Record Previous Ne xt Last Revert

Connect Database Refresh Record Record Record Record
Changes

N - N = N -

Insert Delete Save

Record Record Record

5.3 - Database

i ] As it is with cardPresso Document Objects the Database Fields can also be added to the card
Layout through Drag&Drop. These Objects will be connected to the Database Field and update when
the field in the database is changed or when moving between records.
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5.4 - Find or Filter

9 The Database Find Tab eases the search for specific records in the Database.

It is possible to search in the available variables if the data in a column of the Database is or has a
value, as input by the user to the Textbox.

W Be Edt yiew Bel Database Wndww el

EEOSEE QAR . TEEEEE -8

o siamenilannst " ' . Database

EBRE

[l

1
|

ﬁr

Bt

(i ] The Database Filter works as an SQL Query and in it there are available the same options as
in the Database Find with the possibility to search with multiple rules and with a personalized Script.

The Database Filter Tab can also be used to generate the Script for the Database Filter in the
Connection Wizard.
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Database
C:/ProgramData/ ... /DATABASE/interna

Table Employee Is Equal (=) -
Record 1 of 19 Is Equal (=)
| w

L2
=
J
o
o

o
[
L]

o

Is Mot Eq?al}{c:}

- Is Bigger (=

Conditions, Is Bigger or Egual (>=)
Is Smaller (<)

Is Smaller or Ec&ual (<=)

i i ]
T —— = Is Null (1S NULL
(iSupanisor BB (g —

g - Contains (LIKE)
| 1s Equal (=) v | || Not Contains (NOT LIKE)
|
J

Layouts

5

[.ﬁdd Column ...

Add Column ...
g q Employee ID

| Supervisor ID v | E| E:;pterz\;srgg [s}
r First Name

| Is Equal (=) v

[. Oor v

Database

Paosition
Birth Date
3 ] Hire Date
E;tme Phone
] ension
[ Add Condition ... * | }|photo
NH;‘:EE 3
orts
SQL: Salary
" : . X : - SSN
Supervisor I = 5 OR "Supervisor D™ = 3 Emergency Contact First Name
Emergency Contact Last Name
Emergency Contact Relationship
%mergency Contact Phone
st

Database Filter

Database Find

Add Condition ...
Reseat | APFA-Y J i:.iﬂ ':Uﬁditiﬂﬂ

Or

When using the Contains filter, if you are searching with a partial word, you must use the % symbol
on the search term.

Eg: Searching for a word that starts with "card": card%
Searching for a word that ends with "Presso": %Presso
Searching for a word that contains the text "ardPres": %ardpres%
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5.5 - Database View

Browsing and editing a database is made simple with the Database View.
Here you can see a list of all the database records and edit them with in a convenient interface,
made to simplify browsing and editing records.

To access the Database View, click the Database View button or open the cardPresso menu
View > Database View.

0 Note: The Database View will only show data when connected to a database.

CP File View Database Wndow Help
A o - = ¥ 1 1 ¥ (51
ESEEE L oB= o) s o) Es) s ) Ex) &) =)

Browse Records Edit Records

Database C db
Record 1 of 15 )
| Employee 14 Supervisor 1d Last Name First Name Position Birth Date Hire Date Home Phone Extension Ne
| Education includes 3 BA in Psych
1 s Davolio Sonia Sales Representative 10721208 12:0000AM  1991-03-2012:00:00AM  (206)555-9857 5467 in1954. She also completed "Th

member of Toastmasters Internal

fluent in French and Italian and re

2 Fuller Andrew Vice President, Sales 1969-02191200:00 AM  1991.07-1212:0000 AM  (206)555-0482 3457 company as a sales representat]

1994 and to vice presil

a 85 dégrée’n Chemis
plete

3 s Leverling Janet Sales Representative 1971-08-30 12:00:00 AM  1991-02-27 12:00:00 AM  (206)555-3412 3355

Man: Jane <
RISmSied o se SRR
and an MA from the Ar In{
was assigned to the Lor
November 2000... ... cvev. vy
representative in 1997, he spent]
5 2 Buchanan Steven Sales Manager 1975-03-04 12:00:00 AM 1992-09-13 12:00:00 AM (715)554-8485 3453 at the Seattle office and then ret.
London. He was promoted to sa,

a s peacock Margaret Sales Representative 1973-09-1912:00:00 AM  1992-03-30 12:00:00 AM  (206)555-8122 5176

the University of Califonia at Los
5 5 Suyama Michael Sales Representative 1963-07-0212:00:00AM  1992-09-1312:00:00 AM  (715)557-7737 428 has also taken courses in Multi-C
Management for the Sales Profe!
leting his degree in ¢

before coml
in 19 ear he joined the c¢

7 s King Fobert Sales Representative 1972:05-2012:00:00 AM  1992-11-20 12:00:00 AM  (715)555-5085 465

ing in Europe”, he wa
Laura received a A in psycholog

8 5 Callahan Laura Inside Sales Coordinator 1974-01-0912:00:00AM  1993-01-30 12:00:00 AM  (206)555-1189 2304 She has also completed a coursé
writes French.

ree in English,

o s Dodsworth Anne Sales Representative 1076-01-271200:00AM  199310-12120000AM  (71s)ssa-4442 452 fnosbass Bdeaa e

Hellstern was hired as Assistant |
10 2 Hellstem Albert Business Manager 1968-03-1312:00:00 AM  1993-03-01 12:00:00 AM  (206)5554869 7550 promoted to Business Manager ¢
Hellstern is a native speaker of

evening classes at a local Comm

u 10 smith Tim Mail Clerk 1973-06-06 12:00:00 AM  1993-01-1512:00:00 AM  (206)555-3857 6261 his AA degree in programming in
educatio; of wa
AAd

12 10 patterson Caroline Receptionist 1979-09-1112:00:00 AM  1993-05-1512:00:00 AM  (206)555-3480 1411 she
chai

select All| [select None| [Toggle selection

E Browse Records - Opens the Browse Records tab which lists all the records in a reader friendly
way .

™ Edit Records - Opens the Edit Records tab provides you with a more convenient interface to edit
each database record.

5.5.1 - Browse Records

The Browse Records view is a tool that alows you to see all the records in your database in a
simple and reader friendly environment.

Here you can also individually select records for when you want to print several specific records in
the database (see more on Printing Selected Records in a Database).

You can access the Browse Records window trough the Database View button, then Browse
Records button, or trough the cardPresso menu View > Database View, then Browse Records
Button.
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CP Hle View Database Window Help

ESEE = B

Record 1 0f 15,

Employee Id - Supervisor Id Last Name First Name Position Birth Date Hire Date Home Phone
Education includes a BA in Psych
Davolio Sonia Sales Representative 1972-12-08 12:00:00 AM 1991-03-20 12:00:00 AM  (206)555-9857 in1994. She also completed "Th
‘member of Toastmasters Interna
fluent in French and ftalian and
Fuller Andrew Vice President, Sales 1969-02-19 12:00:00 AM 1991-07-1212:00:00 AM  (206)555-9482 company as a sales representat]
in January 1994 and to vice presis
janet has'a 85 ‘dégrée’in Chemis,
has also completed a certificate
Management. Janet was hired a:
PRSiechig G2 SRR ER TRt
™ the Amencan i
was assigned to the London offic
Nevember 20

Leverling Janet Sales Representative 10710830 120000 AM  1991-02-27 120000 AM  (206)555-3412

Peacock Margaret Sales Representative 1073-0919 120000 AM  1992-03-30 120000 AM  (206)555-8122

representative in 1997, he spent
Buchanan Steven Sales Manager 1975-03-04 1200:00 AM  1992-09-1312:0000 AM  (715)554-8485 at the Seattle office and then ret

London. He was promoted to sa|

the University of California at Los
Suyama Michael Sales Representative 1963-07-0212:00:00 AM  1992-09-1312:0000 AM  (715)557-7737 has also taken courses in

Management for the Sales

befo eting his degree in
King Robert Sales Representative 1972-05-29 12:00:00 AM 1992-11-20 12:00:00AM  (715)555-5085 in 19 e year he joined the ¢

entitled *Selling in Europe”, he w:

Laura received a BA in psycholo:
callahan Laura Inside Sales Coordinator 1974-01-09 12:00:00 AM 1993-01-30 12:00:00 AM (206)555-1189 She has also completed a cours
writes French.

Anne has a BA degree in English
fluent in French and German.

Dodsworth Sales Representative 1976-01-2712:00:00 AM  1993-10-1212:00:00 AM  (715)554-4442

Hellstorn was hired as Assistant |

Helstern Business Manager 1968-03-1312:00:00 AM  1993-03-0112:0000 AM  (206)555-4869 promoted to Business Manager ¢
Hellstern is a native speaker of €

evening classes at a local Comm

Smith Tim Mail Clerk 1973.06-06 1200:00 AM  1993-01-1512:0000 A (206)555-3857 his AA degree in programming in
of va

12 Patterson Caroline Receptionist 1979-09-1112:0000 AM  1993-05-1512:00:00 AM (2065553480
il |

Select All| [Select None| |Toggle Selection

™ Hide/Show Photo Columns - Toggles between hiding or showing database columns which contain
images. Ideal for larger databases with a large amount of pictures, which can be very memory
intensive.

When disabled this option allows for higher performance in computers with slower resources.

E Select All - Selects all the records in the database.
Ef Select None - Deselects all the records in the database.

E Toggle Selection - Individually toggles the selection on all database items that are listed (Does
not apply to items that are not visible trough Database Filter).

5.5.2 - Edit Records

The Browse Records view is another powerf tool in cardPresso which allows you to quickly edit
database records, making database management fast and simple.

On the left side of the Browse Records window you can find the columns which contain text.
ON the right side, you can find all the the Image items contained in the database.
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Browse Records Edit Records

Database C:/ProgramData/cardPresso/DATABASEfinternalDatabase.mdb. Table:Employee
Record 8 of 13

+ Employee Id +] Photo
9

] Supervisor Id

5

~+| Last Name
Dodsworth
| First Name
Anne
| Position
Sales Representative
| Birth Date
1976/01/27 (00:00:00)
| Hire Date
1993/10/12 (00:00:00)
4| Home Phone
(715)554-4442
| Extension
452
| Notes

Anne has a BA degree in English from St. Lawrence College. She is fluent in French and
German.

Simply browse the records with the top Database Toolbar until you find the database record you
want to edit, then edit the database record and click the Save Record button.

5.6 - Managing Records

Adding, deleting and editing records are core tasks when managing a database and when working
with large databases, it can become a time costly task.

With all the tools provided by cardPresso, managing databases becomes simple and intuitive.

5.6.1 - Adding Records

Adding records in cardPresso is quick and simple:
1 - Make sure you are connected to a database (see more on chapter 5.1 - Connection)

2 - Open the Database sidebar when working on the Card Design view (see more on chapter 5.3
Database).

Alternatively open the Browse Records window on the Database View (see more on chapter 5.5.2
Edit Records).

3 - Click the Insert Record button on either the Database Toolbar or trough the cardPresso menu
Database > Add Record.

=

i |
4 - The Database Items will now be empty and ready to be written.
Finally, fill the items with the required data and click the Save Record button to save the changes.
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"

-
I
F

&

Prior to saving you can cancel any changes with the Revert Record Changes buton:

J

-
e »

(s

5.6.2 - Editing Records
Editing existing records is also a quick and simple task:
1 - Make sure you are connected to a database (see more on chapter 5.1 - Connection)

2 - Open the Database sidebar when working on the Card Design view (see more on chapter 5.3
Database).

Alternatively open the Browse Records window on the Database View (see more on chapter 5.5.2
Edit Records).

4 - Use the database toolbar to find the record you wish to edit.

- T )
=

-5 3
4 - Finally, fill the items with the required data and click the Save Record button to save the

)
changes.

L

_
7

(v

3
)

Prior to saving you can cancel any changes with the Revert Record Changes buton:

—l "
5.6.3 - Deleting Records
Deleting existing records is also a quick and simple task:
1 - Make sure you are connected to a database (see more on chapter 5.1 - Connection)

2 - Open the Database sidebar when working on the Card Design view (see more on chapter 5.3
Database).

Alternatively open the Browse Records window on the Database View (see more on chapter 5.5.2
Edit Records).

4 - Use the database toolbar to find the record you wish to delete.
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5 - Click the Delete Record button and when prompted if you want to delete the record, click the
Yes button.

Note: Deleting a record is a permanent action that cannot be reverted, canceled or undone.
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Chapter 6. Printing

o Printing your cards is the core function of cardPresso. Within this chapter we describe the
several printing configurations cardPresso provides for printing and how those settings work with
your printer to achieve the best printing results.

To ensure that the finished card appears as intended you should understand basic printing principles
such as the resolution of your printer or the calibration and resolution of your monitor. These
specifications are provided by the printer manufacturer and in the display settings of your Operating
System.

Make sure you have the latest printer driver and firmware versions for the printer you have installed.

6.1 - Printing with cardPresso

O The computer you wish to print a card from must be connected either to a local, shared, or
network printer and be configured to use that printer.

1. Make sure that you've installed the correct printer driver for your printer.

2. o Click the Print Button, or choose File > Print.

3. If connected to a database (see more on Chapter 5. Database) you can use the Database
Selection options to select the records you want to print (see more on Chapter 6.1.1 Printing
With a Database):

4. Update record after print writes a user determined value in the selected database field of each
database record that is printed, after being printed.

5. Copies sets the number of copies to print for each print job / record.

6. Driver Options opens the Printer Driver properties of your currently selected printer. Set
additional printer driver options in your operating system. See your printer driver documentation for
details.

7. Print Operations allows you to select the operations you wish to run on each print job.

Click OK to start the print job with your currently selected options.
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Printer | g Microsoft XPS Document Witer [ i

Manufacturer Microsoft
Driver Microsoft XPS Document Witer

| Driver Options LZJ

Database Print Operations
Selection:

Print Front

Fanas [F] Print Back

From | Start Record | = i Number of records |1 =

[ Selected Records in browse view

[J Conditional print

Update
[0 uUpdate Record After Print

Copies

Number of copies

0K | Close | Cancel
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6.1.1 - Printing With a Database

O Print jobs with large databases can be very lengthy and complicated. That's why cardPresso
provides you with sewveral options you can use to your advantage to, making printing with large
databases a much simpler job.

6.1.1.1 - Printing a Database Range

O Print Range allows you to choose a range of records within a database to be printed
automatically. This range can vary from one card to several cards.

1 - In the From field, select the starting point you want for your print job.
2 - In the Number of records, type the number subsequent records you want to print.

When selecting a range, you have 3 options to select which is the record you want to start to print
from:

Start Record starts printing from the first database record.
Current Record starts printing from the database record that's currently open.
Last Record starts printing from the last database record.

After selecting which record to start from, Number of records let's you choose how many
subsequent records you want to print besides the starting record

Database
Selection:

Range

From [ Start Record | = [ Number of records 1 w’*

| Start Fecord H
O selectel rrent record iw

[ Conditi Last Fecord

Eg: If selected From: Start Record, Number of records: 700 cardPresso would print all database
records ranging from 1 to 100.
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6.1.1.2 - Printing Selected Records in a Database

(i ] Selected Records in browse view lets you select which records to print, one by one, by
selecting them previously in the Browse Records window in Database View.

1- o Click the Database View button, or choose View > Database View

2 - Select the records you want to print on the Browse Records window, using the checkboxes.

3- o Click the Print button, or choose File > Print.

4 - Select the Selected Records in browse view option and click OK to print.

1 = = ) Mo 3 3 T4 FX L Y [P L > |1
Database C:/Prog j /D |Database.mdb. Babl |
Record 1 of 13 print L2
Employee Id - Exter®|
Printer g Microsoft XPS Document Witer | -
[ 5 5467
B2 Manufacturer Microsoft 3457
@3 5 Driver Microseft XPS Document Witer 3355
14 5 o = 5176
river Options| | X
@s 2 il sl 3453
Els 5 428
oz 2 Database Print Operations 165
i 5 Selection: 2345
[=E) 5 Print Front 452 i
H1o 2 0 Range [] Print Back 7559
11 10 . 6261
A1z 10 Selected Records in browse view 1411 5l
ki [J Conditional print i

|Select All| | select None|

[ . |

Database C:/Pi Data/e [] Update Record After Print
Record 1 of 15

Employee Id

L1 Copies

Supervisor id Number of copies [T [

Last Name

[Davolie

First Name

[sonia |

Position

[ ok ][ close |[ cancel |
|sales =) kit ey

e ——————————————————————

6 In the image abowe the records to be printed are 3; 5 and 8.
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6.1.1.3 - Printing with Conditional Printing from a Database

© conditional Print lets you configure a print rule using a value from the database records. When
printing, cardPresso will search trough all records within the database and will only print the records
that comply to the rule you have configured.

1 - Select the database Column which contains the data to be validated.
2 - Select the condition that fits the print rule you want.

3 - Click OK to print only the database records that follow your print rule.

Database
Selection:

[ Range
[] selected Records in browse view

Conditional print

Column | Employee ID | Is Not Null

Is Equal

Is Mot Equal

Is Smaller

Update Is Smaller or Equal
Is Bigger

[ Update Record After Print Is Bigger or Equal
Contains

Mot Contains

Is Mull

s Mot Mull

O mis option is only available in cardPresso's XL Edition or higher.
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6.1.1.4 - Update after Print

o Update Record after Print allows you to change a record to save relevant print information,
after being print.

By using your own text or one of the options available in cardPresso it is easier to mark in the
database the records that have been printed, the amount of cards printed for that specific record and/

or the print date of the last card.
1 - Select the Column wich you wish to update.

2 - Type the data you want to store, or choose one of the available options cardPresso provides.

Update
Update Record After Print
Column | Employee ID || Apply your text here or
name of your database column SPRINTSTATUS

SPRINTCOUMNTER
SPRINTDATE
SPRINTSTATUS&COUNTER
SPRINTSTATUS & COUNTERSDATE

6.1.2 - Copies
O Number of copies lets you set the number of times each card will be printed.

Copies

Number of copies |1
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6.1.3 - Print Operations

O In the Print Operations you can find the print and encode tasks that occur in each print,
depending on the Card Type in use.

As an example, a CR-80 Card Type layout would only show the Print Front and Print Back
operations.

Print Operations

[¥] Print Front

[C] Print Back
[¥] Magnetic Encoding
[C] Contact Encoding

[[] Contactless Operations

O The operations selected in this area are the only ones sent for printing.
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6.2 - Print Settings

© Printer Settings allows you to configure the basic layout settings of your card, configure Print
Options which adapt to your to your printing needs, and gives you access to your printer's Driver
Options.

o To configure your Printer Settings, click File » Configure print or Ctrl+Shift+P.
1 Paper Size, selects the paper size supported by the chosen printer.

. Orientation, selects the orientation of your document. Landscape or Portrait.

'.' Print Options, shows you the current Driver Properties, select the Rendering, Advanced
options and the Overlay.

. Driver Options, opens the configurations of the currently selected Printer.

Printer | = Microsoft XPS Document Witer O

Manufacturer Microsoft

Driver Microsoft XPS Document Witer . =
Paper Size | Letter @§ . . |Driver Options| | X

Dimensions 279.4 mm x 215.9 mm

Or‘ientation| || Landscape .
Print Layout Print Options 0

card Model | = CR100 = 63 £a » Driver
: 4 Rendering
Dimensions 85.725 mm x 53.975 mm [ £ ra > Black
- “ © » Antialiasing
Orientation | | Landscape :
I- B =3 =3 = > Composite black replacement
Columns | 3 =] 4 Advanced
; = o o & > Invert Driver Orientation
bowsi| 4o » Rotate 180
Top Margin [0 mm La] * Flip Horizontal
o — P > Flip Vertical
Left Margin |0.556 mm ¥ » Use Colored Card
Vertical Spacing [0 mm =] > Print Jobs .
: 2 I 4 Overlay/Varnish
Horizontal Spacing |10 mm > Mode

oK
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6.2.1 - Printer

0 In this area you can choose which Printer you want to use, its Paper Size whether it is Letter
as used by A4 printers, CR-79, 80, 90 or any size recognized by the card printer and the card
Orientation.

Printer

= Microsoft XPS Document Whiter v O

Manufacturer Microsoft
Driver Microsoft XPS Document Whter

Paper Size | Letter

Grientatiun‘ [ | Landscape

0 To view the Printers installed on your computer and their Driver version

Drivers.

Dimensions 279.4 mm x 215.9 mm

click cP » Printer

fle Window Help

About

Clear Config
USE Devices
License

View Folders

Printer Drivers

EDIsecure DCP350
Evolis Badgyl
Evolis Elypso
Evolis Primacy

Evolis Primacy (Copy 1)

Language »
f Printer Drivers M

Printer Name Diriver

CIAAT CTC-940 CIAAT CTC-940,1.4.0.5(2012/09/05)

CX-330 C%330,5.0.0.2(2010/05/20)

CX7000 UL CX7000 U1,7.1.0

CxD8ao CX%D20,7.0.0.2(2010/06/10)

DIS DCP360i DIS DCP3601,5.0.0.2(2010/05/10)

EDIsecure DCP350,2.12.10.17(2012/10/17)
Evolis Badgyl1.2.12.1.246(2013/04/08)
Evolis Elypso.2.12.1.254(2012/03/08)
Evolis Primacy.2.12.1.254(2012/03/09)

Evolis Primacy,2.12.1.254(2012/03/09)

kil

| i

|View all cardPresso supported printers

|FE5t0reDefauIts| Save | Close

Printer Drivers
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© The Print Layout settings change depending on the Card Model you choose. In its drop-down
list you can choose the Card Types available in your cardPresso Edition.

Printer ‘ = Brother DCP-J315W Printer

B

Manufacturer Brother
Driver Brother DCP-J315W Printer

o

Paper Size | Ad

Dimensions 297 mm x 210 mm

Orientation‘ [ ] Landscape

Print Layout

Card Model

Orientation
Columns

Fows

Top Margin

Left Margin
Vertical Spacing

Horizontal Spacing

"= GenericCombo

Basic
= CR100
w CR79
= CR80
= CRSO
Common Card Types
= CRS80
*~ Generic Contact Card
Generic Contactless Card
= HI-CO
Mifare Classic
Contact
= GenericCombo
= GenericCombo_2MagTrack
*~ Generic Contact Card
== |2C Card
» JavaCard
= SLE4442
Contactless
[ Genericcombo

= GenericCombo_2MagTrack

Generic Contactless Card
= HI-CO Mifare Classic
15015693 Card
= LO-CO Mifare Classic
Mifare Classic
Mifare Desfire
Mifare Desfire NFC
Mifare Ultralight
Magnetic
— HI-CO 2Tracks
= HI-CO

‘b))) - GENERIC

Driver Options I E.J

Print Options

I Driver

4 Rendering

I Black

I Antialiasing

I» Composite black replacement
Magnetic Encode

> Macros

I Character encoding

4 Advanced

I Invert Driver Orientation
[ Rotate 180

I Flip Horizontal

I Flip Vertical

I» Use Colored Card

I» Print Jobs
Overlay/Varnish

> Mode

[ S

[

Ok

© Different Card Models have different Print Layout settings.

In the case of paper printers the you can print multiple cards in one page. cardPresso provides you
with a simple grid system that you can modify to fit your printing needs.

Print Layout lets you choose the number of rows, number of columns, top margin, left margin,
vertical and horizontal spacing. As you can see in the image below.

1 Card Model, selects your card type.

. Orientation, selects the orientation of your card in document.

. Columns, number of columns.

'.' Rows, number of rows.
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. Top Margin, left margin of your document.
. Left Margin, top margin of your document.
7 Vertical Spacing, vertical spacing between cards.

8 Horizontal Spacing, horizontal spacing between cards.

Print Layout
@ cardmodel | = crso L &3 3 "
Dimensions 85.725 mm x 53.975 mm [ ] [ | [
‘ el e al ool
. Grientatiun| [ Landscape — i =
4 e La (|
. Columns |_3___I e e e
@ rows [ 4 7]
. Top Margin |0 mm Le]
. Left Margin (0.556 mm =
T ' Vertical Spacing |0 mm =
Horizontal Spacing |10 mm i 8
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6.2.3 - Options

© The Print Options section contains information and configuration settings on how the print job is
sent to the printer Driver.

Print Options

» Driver

: Rendering

- Advanced

» Overlay/Varnish

oThe Driver section shows the basic driver info of the printer currently selected.

Print Options

4 Driver =
4 Manufacturer
Windows (R) Win 7 DDK provider
4 Mame
Matica Printer Driver
4 \Version
6.1.7600
a Class
Matica Espresso
a Model
Matica Espresso
4 Print Class
WIN32API

4 F‘ri_ﬂt Test
Print Test

[ T

O e Rendering settings allows you to configure advanced Black rendering options,
Antialiasing, and Composite Black Replacemet.
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Print Options

» Driver
4 Rendering
4 Black

| Separate Render

AAﬁtialiasing
|- fes

a Cﬁmpusite black replacement
|- Disabled

- Advanced
: Overlay/Vamish

Black, configures how the black color is sent to the printer. You can Send as RGB; Send as
Monochrome; Send as RGB and Monochrome; Send Composite; Send Composite and
Monochrome or send as a Separate Render (default option).

Antialiasing, lets you enable or disable Antialiasing for either the whole card, for Text only and for
Images only.By default, the option is active.

Composite black replacement, You can use composite black replacement with one of the
following options: Using the options available: Grayscale (Low, Medium or High), Color Decrement
(Low, Medium or High) Red Increment (Low, Medium or High).

Black, To obtain the desired results, you can submit the black in RGB; monochrome; RGB and
monochrome; composite; composite and monochrome and separate render;

Composite black replacement, You can activate composite black replacement, using the options
available: Grayscale (Low, Medium or High), Color Decrement (Low, Medium or High) Red Increment
(Low, Medium or High).

oThe Advanced section provides you with the following options.

Print Options
Advanced -
4 Pptate 120
|. Mo
a FIi.p Horizontal
|. Mo
a FIi.p Wertical
|. Mo
4 Use Colored Card
|. Mo
a F'r:iﬂtjt}bs

| All Print operation
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Rotate 180, Rotates the layout by 180° when sending the print job.
Flip Horizontal, Flips the layout horizontally when sending the print job.
Flip Vertical, Flips the layout vertically when sending the print job.

Use Colored Card, Sends the print job optimized for when your card is than white.
You can select from Black, Green and Yellow.

Print Jobs, By default the print job is sent as "All Print operations", in this case cardPresso
sends all print jobs whether each print job was successful or not.

With Card by Card cardPresso only sends the next card to be printed, after receiving a success
signal from the printer.

With Card by Card and Wait cardPresso sends the print job one by one, and waits for a user
input. cardPresso will wait for a user confirmation that each selected print job is successful before
sending the next print job.

Oove rlay/Varnish:

Mode: By default the Overlay is Disabled. Depending on the Printer in use it is possible to send the
Overlay Layout during the print job to the driver by saving it to an External file or directly to the
printer as Separate Page.

Print Options

> Diriver

» Rendering

» Advanced

4 Overlay/vamish
4 Mode

. Disabled
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Chapter 7. Encoding

© cardPresso's other core function is encoding. The process of encoding consists in converting
information from one format to another, and in the context of cardPresso, storing that information in
a card.

To that end cardPresso provides you with a dedicated workspace stocked with tools focused solely
on Encoding and managing the way information is sent to your card.

This workspace is called Encode View.

7.1 - Encode View

i ] The Encode View is where you view manage the encoded information in your card and the
encoding operations to be performed when encoding to your cards.

You can access it by clicking the Encode View button, or trough the menu View > Encode View.
This section gives you access to the various sections that manage the encoding process.

The Encode Model window shows a visual representation of the way data is stored in each card.
The Data Inspector window shows the data currently being browsed in the Encode Data window.
The Encode Script window shows the encode commands that run when the card is encoded.

The Properties window, to the right, has its own set of options in the Properties section which
provide you with convenient information and tools to make Encoding fast and easy.

W fle View Database Window Help

EESEEE LS

atabase
= 4 Mifare Classic 1K ble Employee
ars s ontactless encoders | OMNIKEY CardMan s:21-cLo |- [@)(@) ot
= » Sector1 card timeout=30:// maximum waiting time for the card to be p - B
» Sector2 o Pk DU ateat Auni ARG Soch card ook be ifferent rom the previous [ | = employeed B
© Sector3 18
@ I Sector4 rd. ("1 ): g
- cardwaitForPresent("MIFARE CLASSICY] ; [—
» gecoio loglMEDIA TYPE:"card mediaType): s
v Sector 10QUMEDIA SN 4 cardUID 5. =
log("MEDIA S/N reversed: +(ard UiD_LsB ): £ Last Name
T
] TPSAVE MIFARE SERIAL NUMBER ON DATABASE RECORD e
= 111) choose the database Dockbar.
ks it 172) drag the field where you want to save the serial number and drop over the line below [8 Frstname
o=> currenlk:ord '=card.UID;currentRecord.save();
Soria |

EE

/7T UPDATE AR FELD

2] choose the preview Dockbar,

112) drag th feldvnere you v t update the serial number and drop aver the e below
=> item.2=cai

Position

[ales Representative |

aller is Birth Date

[1972712/08 (00:00:00) [£]
JIn this encode area there are samples for the usage of the Mifare cards. such as.
1/ how to wite and read a Mifare card in E Hire Date.
Contactless | Output | [1991/03/29 (00:00:00) [+

Home Phone

{(206)555-9857

Mifare Classic:Tailer 15 Extension

Block. Hexadecimal
< s1s803

(5467

photo

| edt | | read | | wite | Continuous Read

Notes

|'a member of Toastmasters International.

« ®

7.2 - Encode Model

i ] The Encode Data window is a \isual representation of the way information is stored in your
card. It allows you to easily browse the card for a quick access to the information stored.
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You can find it by clicking the Encode View button.
Different Card Types have different types of Encode Data organization.

Here is an example of the Encode Data window of a Mifare card:

4 Mifare Classic 1K
= Sector O
Sectorl
Sector 2
Sector 3
Sector 4
Sector 5
Sector e
Sector 7
Sector 8
Sector 9
Sector 10
Sector 11
Sector 12
Block 0
Block 1
Block 2
< Trailer 12
Sector 13
Sector 14
Sector 15

*
El
[
[
[+
*
El
El
[
[+
#
]

7.3 - Data Inspector

0 The Data Inspector window shows you the data currently stored on the item you select on the
Encode Data window and allows you to manipulate the stored data. This gives you a quick
reference of the data stored in your card and eases the workflow while working on your Encode
Operations.

You can find the Data Inspector window by 0 clicking the Encode View button, or clicking View
> Encode View.

The information shown on Data Inspector also changes depending on the Card Type.
The Data Inspector window organizes the information stored in your card in 3 columns:
Block shows the card block currently selected in the Encode Data window.

Hexadecimal shows the hexadecimal value of the data currently stored on the selected card block.
If the user has changed the value using the Edit button, it will show the new value entered by the
user)
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ASCII shows the value of the Hexadecimal field in regular text format.

Here is an example of the Data Inspector window of a Mifare card where we wrote the hexadecimal
value for the word "cardPresso":

Mifare Classic:Block 2

Elock Hexadecimal ASCII
S00B02 I53RFRER9A 1204461 766FECEAEFO00000 | Sonia Davolio...

Continuous Read

0 The Data Inspector window comes with a set of tools that allow you to quickly view and modify
the data stored in your card:

The Edit button allows you to directly modify the information stored in the item currently selected in
the Encode Data window. The Edit button works with Hexadecimal values.

The information will only be written in the card when you press the Write button.

Hexadecimal

|535F5E69512l}4451?55FECEQEFHHHHHH

ASCI

|Sonia Davolio... |

[ OK j[{:ancelj

The Read button allows you to read the information stored in the item currently selected in the
Encode Data window.

The Write button writes in the card the value currently visible in the Hexadecimal separator of the
item currently selected in the Encode Data window.

The Continuous Read button makes cardPresso repeatedly read the data in the currently selected
item every two seconds.

This allows you to perform seweral write functions in the Encode Operations window and
immediately see the results on the Data Inspector window.

© 2014 cardPresso, Lda



Chapter 7. Encoding 171

7.4 - Encode Script

0 The Encode Script window is where all the code that manipulates how the information
pertaining your cards is written into the cards. You can program and test all the encoding actions
you want before printing trough this window.

You can find the Encode Script window by O clicking the Encode View button, or clicking View
> Encode View.

The actions written here will then occur each time the card is encoded.

Here is an example of the Encode Operations window of a Mifare card type:

Contactless encoders | OMNIKEY CardMan 5x21-CL O

=]

J{ The Mifare UID is read in Hexadecimal and ordered by the MSE "Most significant Bit"
{reading the bits from left to the right)

Jf cardPresso reads the UID using » card.UID

Jf to read the UID in LSE "Least Significant Bit" use » card.UID_LSE

J{ to read the UID in Decimal {0-9) use » parselnt{card.UID, 16)

/i Mifare cards have 2 keys: A and B, normally the keys are all 'F

J{ If there is a » Error: mifare:Error readMifare:PSSC ERROR:6982:Security status not satisfied
Line: XX « this means that the key is wrong.

/{ The comand below sends an all 'F key 'A'

mifare.key("A" "FFFFFFFFFFFE");

/i Read and Whte to a Block of the card

Ji write to HEX in sector X block ¥
Hmifarewrite(X,Y,"54657374207772697465000000000000", "HEX");

Ji from the connected Database
Jimifarewrite(X,Y,currentRecord["Hire Date"].toString());

/i Simple text write
mifarewrite(s,2,"cardPresso");

Contactless | Output @

52869735

0 By default the Encode Operations window comes with some commented basic sample code to
get you started on the most common Encode Operations of the selected card type.

If a line is commented the code it contains will not run under any circumstance. To run you must
remove the comment tag (// ) in the beginning of the line).

In the previous example the line containing the code "mifare.write(5,2"cardPresso");" is the only
one that will run because it's the only code line that is not commented.

The various Encode Operations also change with each Card Type.
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7.5 - Properties

© The Encode View also has it's own set of Properties tabs located as usual to the right. It
provides you with several separators which contain conwenient information about your card, your
printer, your users, your database and scripts. All with more tools to make your Encoding

Operations even smoother and easier to implement.

You can find the Encode View Properties tab by Qo clicking the Encode View button, or
clicking View > Encode View.
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HEEE E EBE E

Database

&

Preview

Printer Toaols

Table Employee
Record 1 of 15

|

Employee Id
118

1“r_-

Supervisor Id

1
Fy

Last Name
4]
m *
- |Davolio |
[0}
o
]
O First Name
@ |Sonia |
= e
=
' Position

|Sales Representative |

Databas

Birth Date
11972/12/08 (00:00:00) =

Hire Date
11991/03/29 (00:00:00) =

Database Find

Home Phone
(206)555-9857 | L

Extension

|5467 |

Photo

Motes

i a member of Toastmasters International. |

il uflidl

© 2014 cardPresso, Lda



174 cardPresso Manual

7.5.1 - Preview

© The Preview tab provides you with a quick overlook on the card design. You can swap between
the front and the back of the card design preview by clicking the Front button and Back button
respectively.

You can find the Preview tab by 0 clicking the Encode View button, or clicking View > Encode
View and clicking the Prevew tab on the right .

-

Preview

SHOPPING

P

TR KEING CECATTTHIC

e
o
|_
e
[
o’
=
i
o

User Data

Front Back

Database

7.5.2 - Printer Tools

© Printer Tools are a powerful set of tools that allow you to manually navigate your card inside
your printer (in printers that support these functions) so you have more control over how your printer
uses your card while writing your Encode Operations.

The available printer tools vary with the printer modules installed on your printer.

You can find the Printer Tools tab by o clicking the Encode View button, or o clicking View >
Encode View and clicking the Printer Tools tab on the right .

Insert card from card input feeder inserts a card positioned in the printer input feeder into the
printer circuit.

Insert card manually allows you to manually insert the card directly in the position you desire.

Position card at contact encoding unit moves the card from its current position to the contact
encoding unit.

Position card at contactless encoding unit mowes the card from its current position to the
contactless encoding unit.

Move card out of contactless encoding unit mowes the card out of the contactless encoding unit.

Eject card to dispenser unit moves the card from it's current position to the card dispenser unit.
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Eject card to reject unit moves the card from it's current position to the card dispenser unit.
Magnetic Encoder allows you to read the content the 3 tracks of a magnetic card.

Direct Commands allows you to send commands directly to the printers who support this feature
(please refer to the printer manufacturer for a list of supported commands).

=
=
o
| Exreal S TpTEe
= [[! Evolis Primacy
@ )
o
E E
o
L=
0 ™ !
T
o
4_.
|
-
0

ARS8
oY

]
o
D E—
i Magnetic Encoder:
:! -

| ISO Encoding
EE J
m
] Track 1
o , :
(] [

Track 2

Track 3
I

L
K]
=
iC
Q
0]
m
Ee]
m
)
m
O

| Read
Direct Commands:

| | (send]

. Database Find

0 These options work only with printers that support commands.

7.5.3 - Database

i ] The Database separator works Encode View exactly the same way as in the other views. You
can browse your records, edit them and drag them into the Encode Operations window. Making
your work with Encode Operations in cardPresso even easier and faster!

You can find the Database tab by o clicking the Encode View button, or o clicking View >
Encode View and clicking the Database tab on the right.
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L]
L}
o
0
L]
4
o
O

se Filter

Databas

e Find

P=

Databas

Supervisor Id
5 5]

Last Name

|Davolio |

First Name
|50ma |

Position

|sales Representative |

Birth Date
11972/12/08 (00:00:00) |

Hire Date
11991/03/29 (00:00:00) =

Home Phone

(206)555-9857 |

Extension

5467 |

Photo

Motes

i a member of Toastmasters International. |

i ]

il
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7.5.4 - Database Filter

@ Database Filter is yet another strong tool that makes the work-flow on Encoding Operations
much smoother and faster in cardPresso.

You can apply Database Filters on cardPresso so you only see the records with the information
that matters the most to you. Making browsing database records a much easier and cleaner task.

You can find the Database Filter tab by clicking the Encode View button, or clicking View >
Encode View and clicking the Database Filter tab on the right .

To do so, simply select the column which contains the data you want to filter.

Select the condition to filter which matches your needs.

Insert the value you want to filter

Select Add Condition and click Apply (You can add more filters by selecting And or Or).

Now when you browse your database records on the Database tab, only those that follow the
condition will show.
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Database

Preyview

Table Employee
Record 1 of 15

Conditions,

w
O
izl
.
a
=
C
o
o

|Pumﬂun

| Is Equal (=)

'Sales

User Data

| And

| Extension

Database

| Is Equal (=)

15467

| Add Condition ...

Database Filter

SQL:

“Position” = 'Sales' AND " Extension” =
5467

Database Find

Reset | Apply

7.5.5 - Database Find

i ] Database Find is a quick reference tool that lets you find specific values throughout your
database.

You can find the Database Find tab by clicking the Encode View button, or clicking View >
Encode View and clicking the Database Find tab on the right .

Select the Column in which you want to find a value.
Select the condition that fits your situation.
Insert the value you want to search for.

Use the buttons to navigate trough the records which comply with the condition.
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Record 5 of 15
Table Employee

Find,
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l Employee ID

M

-
=}
a

-
|-
al

H
L

=

o

l Is Equal

M

|5

Found in record:5

7.5.6 - Script

311# Ta) > >

(i ] The Script separator is the Document script and if you previously added code, it will be located

here. See more on Chapter 4.4.12 - Script.
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Chapter 8. Users
© when working with multiple collaborators, managing and providing select permissions to each
individual becomes crucial.

Users is yet another powerful management tool provided with cardPresso to help you specifically
with user management, allowing you to limit who can access cardPresso and what they can do.

Users provides you with tools that allow you to create and manage user logins for cardPresso. This
gives you full control over who has access to cardPresso and what they can do. With the added
ability to create groups, managing large numbers of users becomes as simple as a single click.

8.1 - Users View

© The Users View gives you access to all the tools that allow you browse, add, remove and edit
Users and Groups. It also gives you access to an oveniew of all their operations and an additional
option to print customized audits.

You can access the Users View by clicking Window > Users View:
The Users View is separated in 5 smaller sections:

The Users View Toolbar provides you with the basic tools to add and remove users, add and
remove groups and print audit reports:

% Audit Report Prints an Audit Report for different files formats.

-.O Add User Creates a new user.

-.0 Remove User Removwes the user currently selected in the Users section.
‘(-.0 Add Group Creates a new group.

,(-.0 Remove Group Removes the user currently selected in the Users section.

. | . .
‘\C) Refresh Views Reloads the users database on the Users View.

© The Users section located in the top left of the Users Vew shows a list with all the users you
currently have configured in cardPresso.
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Users
Login Name
ADMIN Administrator
JOADCLUCAS Jodo Lucas
MUMOMARTING  MNunc Martins
PEDROSOUSA Pedro Sousa
RUIFARILA Rui Faria
SARAVAY Sara Vaz

O e Groups section shows you a list with all the groups you currently have configured in
cardPresso and it's respective users.

Auditing

PRINTONLY Print Only
VIEWOMNLY  Wiew Only

PEDROSOUSA,SARAVAL
JOAOLUCAS NUNOMARTINGS

Groups
Group Name Users
ADMIN Administrators  ADMIN, RUIFARIA

The Auditing section is located in the bottom half of the Users View and it shows a list of all the
actions performed by each user.

© vou must first enable auditing for the intended users in the User Properties tab by editing the
user (see more on: Chapter 8.2.5 Edit a User).

Date
2013-12-16 13:17:01
2013-12-16 13:16:59
2013-12-16 13:16:57
2013-12-16 13:16:52
2013-12-16 13:15:55
2013-12-16 13:15:51
2013-12-16 13:15:42
2013-12-16 13:15:41
2013-12-16 13:15:30
2013-12-16 13:15:23
2013-12-16 13:15:17
2013-12-16 13:15:15
2013-12-16 13:15:12

Computer
CPPEDROSOUSAPC
CPPEDROSOUSAPC
CPPEDROSOUSAPC
CPPEDROSOUSAPC
CPPEDROSOUSAPC
CPPEDROSOUSAPC
CPPEDROSOUSAPC
CPPEDROSOUSAPC
CPPEDROSOUSAPC
CPPEDROSOUSAPC
CPPEDROSOUSAPC
CPPEDROSOQOUSAPC
CPPEDROSOQOUSAPC

Location

HQ
HQ
HQ
HQ
HQ
HQ
HQ

Operation
Users View
New Document
WVelcome view
Refresh Views
Users View
Welcome view
Exit
Save Document
New Text
New Text
Mew Text
MNew Document
wvelcome view

User
ADMIN
ADMIM
ADMIM
ADMIM
ADMIM
ADMIM
PEDROSOUSA
PEDROSOUSA
PEDROSOUSA
PEDROSOUSA
PEDROSOUSA
PEDROSOQUSA
PEDROSOQUSA

Document

Documentl

Cardl

Documentl
Documentl
Documentl
Documentl

Description | Ewvent Result

The Properties tab is located as always to the right of the Users View. It's contents also change
depending on what you are currently doing, whether it's adding new users and groups or editing their
respective settings, all the information is shown and edited here.
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o EDIT USER
5
Login ADMII
g -
% Name Administrator
Q
5 Password 290000900 000000

Confirm Password 99 0000000000000
[ Disable user (cannot login)
Enable auditing

i
o
(1]

OAbove is the properties tab while a user is selected.

8.2 - Users

O A user system is a combination of a user name and a password and, if enabled, are required to
access cardPresso. The user name and password identify each person that accesses cardPresso
and determines what they can or can not do within cardPresso by attributing each user with its own

set of permissions.

8.2.1 - Enabling User Logins

O The first step to work with users is enabling user logins. You can do this by accessing the Users
View by clicking the cardPresso menu Window > Users View and in the bottom of the window

clicking the Enable user logins checkbox.

The first time you enable user logins, you will be prompted with the default user name and
password.

The default user name is ADMIN and the default password is admin:

This information will only appear once.
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On the next time yourun .
software you will be asked to enter your
username and password.

P The default user name is ADMIN and the

default password is admin.

Close

Enable user logins

8.2.2 - Login

O After enabling users logins, when you open cardPresso you will be required to enter the login
credentials on the welcome screen.

Simply type the credentials and 0 click the OK button.

User Name [ADMIN |

@

oy
- Password |@oeee® |

Change Password OK Cancel

Every user that is created can login in this fashion.

8.2.3 - Add User

O with user logins enabled the next step to managing your users is adding them. You do this by
clicking the Add User button found in the Users View Toolbar.

Doing so will open the new user options in the properties tab where you will be prompted to fill
various fields required to create a new user:
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ADD USER
Login PEDROSOUSA

Mame Pedro Sousa

Password L 1117]
Confirm Password | @@ eee®

|§ User Properties |

[ Disable user {cannot login)
[ Enable auditing

Save

Login: Write the username the user must insert when logging in cardPresso.
Name: Write the name of the owner of this username.

Password: Write the password the user must insert when logging in cardPresso.
Confirm Password: repeat the password to validate it.

Diable user (cannot login): The user won't be able to log in cardPresso until this option is
disabled (unchecked).

Enable auditing: Every user action within cardPresso will be recorded and \visible in the Auditing
section.

0 Click Save to sawe the new user. It will then be available for editing in the Users section.

O A new user will have no permissions until assigned to a Group (see more on Chapter 8.3.2 Add
Group).

8.2.4 - Remove User

O keep a clean and up to date user base you can remove Users that are no longer needed by
selecting the user you want to remove and clicking the Remove User button found in the Users
View Toolbar.

If a user is removed its user name and password will no longer work when logging in losing all
access to cardPresso.

© 2014 cardPresso, Lda



m cardPresso Manual

Users

Login Name
ADMIM Administrator it vmar
JOADLUCAS Jodo Lucas
NUNOMAETING  MNuno Martins
PEDROSOUSA  Pedro Sousa Do you want to delete
RUIEARIA Rui Faria user PEDROSOUSA ?
SARAVAZ Sara Vaz ves || cancel

0 Removing a user is a permanent action that cannot be undone.

8.2.5 - Edit a User

6 cardPresso
To edit an existing User select the user you want to edit in the Users section on the Edit Vew:
Users
Login Name
ADMIN Administrator

JOADLUCAS Joao Lucas
NMUNOMARTING  MNuno Martins

RUIFARILA Fui Faria
SARAVAL Sara Vaz
TEST test

Once selected, the user's data will be editable in the properties window to the right:

@ EDIT USER
E

S Login PEDROSOUSA

= Name \Pedro Rocha |
o

5 Password 900000000000000 |

Confirm Password @@ 0000000000000 |
[ Disable user (cannot login)
Enable auditing

Save |

When done editing, to save the changes 0 click the Save button.

6 Once created, the user Login field cannot be edited.

© 2014 cardPresso, Lda



Chapter 8. Users 187

8.3 - Groups

© cardPresso adds Groups to its User management system to ease editing large numbers of

users.

Here you can add Groups and select each group's specific permissions and assign them to multiple
users.

When a User is assigned to a Group, it inherits all the permissions the Group currently has. Every
change to the group's permissions affects the permissions of all the users assigned to it.

0 A user with no group assigned will have no permissions.

8.3.1 - Add Group

© 0adda Group 0 click the Add Group button found in the Users View Toolbar.

Doing so will open the new group options in the properties tab where you will be prompted to fill
various fields required to create a new group:
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g ADD GROUP
=
Qi

Grou
3 p | |
o Mame | |
0
] .
o Location | |
0
— Users

[ ADMIN Administrator

[ JOAOLUCAS  Jodo Lucas
[ NUMOMAFRTING Muno Martins
[] PEDROSOUSA Pedro Sousa
] RUIFARIA Rui Faria

[[] sARaVAZ Sara Vaz

Permissions

4 Design
=[] File
=[] Edit
» View
> [] Tool
> Help
4 Database
» Database
4 User Logins
> [ Users
4 DockBars
» Document
» Users

Group*: Write the unique name cardPresso will use to identify the group.
Name: Write the name of the Group for easier identification.
Location: Write the name of the location/department/category of the users assigned to this group.

Users: Select the Users that belong to this group.

eOne user can belong to more than one group.

Permissions: Select the permissions that the users assigned this group will have.

0 Click the Save button to save the group with the selected settings.

*required field
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8.3.2 - Remove Group

0 If a group is no longer needed you can removwe it by selecting the Group you want to remove and
clicking the Remove Group button found in the Users View Toolbar.

If a group is remowved all users assigned to it will lose all permissions the Group had.

Groups
Group Name Users
ADMIN Administrators ADMIN,S
ESORSIEH o PEDR| = "
PRINTOMLY Print Only SARAVA
VIEWONLY  View Only JoADLU

Do you want to delete
the group EDITORS ?

Yes || cancel |

(i ] Removing a group is a permanent action that cannot be undone.

8.3.3 - Edit a Group

i ] To edit an existing Group select the group you want to edit in the Group section on the Edit

Vew:
Groups
Group Name Users
ADMIMN Administrators ADMIN, RUIFARIA
PRINTOMLY Print Only SARAVAY

VIEWONLY  View Only JOAOLUCAS NUNOMARTING

Once selected, the groups data and permissions will be editable in the properties window to the
right:
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a EDIT GROUP
£
i} e ~

Grou E OR5
EL 4] ED R
o pName Editors
5
o Location HQ
0]
 Users

] ADMIN Administrator

[[] JoAOLUCAS  Jodo Lucas
[ NUNOMARTING MNuno Martins
PEDROSOUSA Pedro Sousa

[] RUIFARLA Fui Faria
[] sARAVAZ Sara Vaz
[] TEST test

Permissions

4 Design

» File

> Edit

> Wiew

> Tool

» Help
4 Database

» Database
4 lser Logins

> [] Users
a DockBars

» Document

» Users

When done editing, to save the changes click the Save button.

© once created, the user Group field cannot be edited.

8.4 - Auditing

O e Auditing section in Users View is where you can see every action performed by any user
in cardPresso.

To audit a user you must first Enable Auditing for the intended user in the User Properties tab by
editing the user (see more on: Chapter 8.2.5 Edit a User).

After enabling auditing for a user every future action that user performs in cardPresso is registered
and listed in the Auditing section
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Auditing

Date Computer Location Operation User Document = Description
2013-12-16 20:12:35 CPPEDROSOUSAPC Users View ADMIN
2013-12-16 20:12:32 CPPEDROSOUSAPC Welcome view ADMIN
2013-12-16 20:12:22 CPPEDROSOQUSAPC HQ Exit PEDROSOUSA
2013-12-16 20:12:15 CPPEDROSOUSAPC HQ Save Document As PEDROSOUSA Sales Card
2013-12-16 20:11:59 CPPEDROSOUSAPC HQ Save Document PEDROSOUSA MyCardl
2013-12-16 20:11:53 CPPEDROSOUSAPC HQ Mew Rectangle PEDROSOUSA MyCardl
2013-12-16 20:11:49 CPPEDROSOUSAPC HQ New Circle PEDROSOUSA MyCardl
2013-12-16 20:11:37 CPPEDROSOUSAPC HQ New Image PEDROSOUSA MyCardl
2013-12-16 20:11:34 CPPEDROSOQUSAPC HQ Browse Image PEDROSOUSA MyCardl
2013-12-16 20:11:31 CPPEDRQSQUSAPC HQ Delete PEDROSOUSA MyCardl
2013-12-16 20:11:28 CPPEDROSOUSAPC HQ Open Document PEDROSOUSA MyCardl
2013-12-16 20:11:22 CPPEDROSOUSAPC HQ Welcome view PEDROSOUSA
2013-12-16 20:11:09 CPPEDROSOUSAPC Exit RUIFARIA
2013-12-16 20:11:05 CPPEDROSOUSAPC Save Document RUIFARIA MyCardl
2013-12-16 20:10:53 CPPEDROSOQUSAPC Connect to database RUIFARIA Documentl
2013-12-16 20:10:47 CPPEDROSOQUSAPC Delete RUIFARIA Documentl

8.4.1 - Audit Report

O For an easier view purposes cardPresso allows you to print or export customizable Auditing
Reports.
You can do this by clicking the Audit Report button on the Users View Toolbar.

Doing so will open the Audit Report editor window, where you can customize your reports before
printing or exporting them to files.
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Audit Report

From date 01-01-2000 -l
To date 31-12-2100 =~
From time (00:00:00 =
To time 23:59:59 -~
Computer |AII Computers | ¥
Location |AII Locations | ¥
Operation [ All Operations | ¥ I
User [AII Users | >
Group [ All Groups |
Document IAII Documents | "|
Description |* |
Event Result | |
Order [ eventDate |z ]
Report model [ auditModel |
Output to | PDF File | ]
oK | [ Cancel |
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Appendix A - XXL Net License

i ] The cardPresso XXL Edition includes the Net License Service. This senice allows you to use
the same license in 16 different computers connected to the same Local Area Network (LAN).

To use this senice, one computer must have the cardPresso XXL Edition USB dongle and be
connected to the same LAN as the other computers. When the Net License service is activated on
this computer, it acts as Server and provides the license to a total of 15 computers connected to the
same LAN.

eThe cardPresso Net License Service only works on a LAN. It does not work trough the
internet.

use (EEEIND
- lB
- [

-l

Switch —
10.10.10.X

10.10.10.X

0 For best results, the computer with the Net License Service should have a Static IP Address.
The computer acting as the Net License "Server" does not need to have a Serer type Operating
System.

To ensure the Net License Service is always available to the other computers, the USB dongle
should be connected to a computer that computer that is either always turned on, or at least when
the other computers require the Net License Service.

Appendix A.1 - Installing the XXL Net License Service

0 To install cardPresso's Net License senice please do the following:

1 - Install cardPresso on the computers but without the senrvice.
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Please select installation folder or choose Evaluate to
run program without installation

H Install in programs folder

f

=
. 'l Install security service |

M Select destination folder

Install for all users

2 - In the computer that will run the senice and act as the server, open the cardPresso menu

cP>cardPresso License

F||e Window Help

About

Clear Config
USE Devices
Lincese
View Folders
Printer Drivers

Language

3 -In the cardPresso License window, click the Net tab click on the Run as Application button:
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[ usB | Net

License server

security service not installed

Fun as Application § Install as Service

Close

O on systems using Windows Firewall, a warning will pop-up, please allow the cardPresso
connection trough the Local Area Network.

O some Firewall applications will not show any warnings and automatically block the License
Seniice, the required permissions are at the end of these instructions.

This will open a command line window which will show you if the ports are open and if a cardPresso
application is running in the network.

cardPresso — License Service 1.08.38
{c) cardP . ;

Security

secuprite

"e»uplf

=F: cupity

ddFile<F:

ddUalumebllﬁ i in,terminate _
UREnut1f1Pat1unﬂThPPad- EMUM. S thread: :ENUM._sto
»
connection accepted:192.168.2.1369
_enumeratelevices:
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In this example

192.168.2.138 is the Host computer acting as a Net License server, providing the license.
192.168.2.136 is the Client computer receiving the license.

4 - Close the cardPressoLS.exe window and click Install as Senice

USE MNet

License server

security service not installed

Run as Application |In5tal| as Service|

Close |

5 - Run the senice and confirm it's running.

UsB Met

License server

security service is not running

Uninstall

d

Close
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USEBE Met

License server

[ security service is running ]

Close

6 - In the License Senice Client Computer use the default configurations or change it based on your
networks characteristics.

use MNet

License server browser

[Uﬁ&'ﬁ&ﬂdﬂws WINS and _____ _ NE |v

Use Windows WNS

Use Windows WINSand ___ _ _ _ MNENS

Use known static address

Disable -
r — | Apply |

Close

Now you can have up to 16 computers in your Local Area Network, including the one acting as a
senver, running cardPresso XXL edition.

i cardPresso doesn't automatically detect the license in a Client computer, open a command
prompt window (Start Menu > Run> cmd.exe) type "ping CARDPRESSO _LS" and hit return.

If the host isn't found as shown abowve, please confirm that it is in the same Local Area Network, and
if so, open a port in the firewall for:
CPSECURITY_SERVICENAME "CARDPRESSO_ LS"
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CPSECURITY_SERVICEPORT 1947
(TCP to communicate and UDP for the name)

If the ping requests an answer from an IP address that doesn't belong to the Local Area Network and
has no answer, retest the ping after rebooting the Router and/or use a different router.

i Warning : If the License Senice is added (Step 3) to multiple computers, a License Senice
"cluster" is created and it will drown the real License Senrwer.

Also, the Net License uses WINS or NetBios to assign the License to the client computers.
Therefore the License won't be assigned to a cardPresso application outside the WINS or NetBios
range.
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Appendix B - Advanced Print Operations

@ cardPresso contains seweral advanced features to provide you with the flexibility required to
adapt to any circumstance.

In this chapter we will show you an oveniew on which features are available, how they work, and how
to best use them to make your printing jobs simple, fast and most importantly, exactly the way you
want them.

Appendix B.1 - Overlay

i By default cardPresso uses the printer's default overlay pattern. However cardPresso also gives
you other options regarding how you work with the Overlay ("O" Ribbon).

You can access the Owerlay options trough the cardPresso menu File>Print Settings,
cardPresso gives you three options:
1 - Separate Page lets you design your own Overlay with cardPresso's Design Vew.

2 - External File lets you design an Owerlay within cardPresso so later when printing it can be used
trough your printer's driver settings.

3 - Use the printer's default default overlay pattern by disabling cardPresso's overlay customization.

Important notes regarding how printers work with
Overlay:

© Printers which support overlay printing have their own overlay settings. These settings owerride
cardPresso's.settings. This means the printer's settings determine if the owerlay is printed or not,
regardless of cardPresso's configuration.

You can your printer settings find them on your Printer Options trough the cardPresso menu
File>Print Settings, Driver Options button.

© cardPresso can only print owverlay if the printer being used supports overlay ribbons, has an
overlay ribbon installed and has the owerlay option enabled in it's own Driver Options.

O if the owverlay option is Disabled in cardPresso but the printer Driver Options have owerlay
enabled, the printer will still print overlay.

O ifan owverlay option is enabled in cardPresso but the printer Driver Options have owerlay
disabled, the printer will not print overlay.

O prevent unintentional Overlay printing, we recommend disabling the Owverlay printing option on
your printer driver settings while designing your Overlay. Enabling it only it when you are ready to
print.

Appendix B.1.1 - Separate Page Overlay

O One of the ways cardPresso allows you to customize your own Overlay is by providing you with
a separate page within cardPresso where you can design your Owerlay the same way you design
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your cards.

This option is found trough the cardPresso menu File>Print Settings, Print Options>Overlay/

Varnish>Mode>Separate Page.

When this option is selected, below it, you will have access to another setting:

Side: Lets you choose the side of the card where the Overlay is to be printed. You can choose

either Front or Back.

Print Options

: DIriver
- Rendering
4 Advanced
» Inwert Driver Orientation
» Rotate 180
» Flip Horizontal
» Flip Vertical
» Use Colored Card
: Print Jobs
4 Overlay/Varnish
4 Mode

Separate Page

4 5ide

Front

Once Separate Page is enabled, cardPresso will display an Overlay/Varnish tab in the bottom

left corner of the Design View as shown highlighted in the image below:
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* Fle Edit View Tool Database Wndow Help

Background

T
= - E

62 Backgrounds found, 0 folders remaining

When you click this tab you will have all the design tools cardPresso provides to design your own
Overlay.

6 The Overlay/Varnish page can only be printed with the Overlay Ribbon.

Appendix B.1.2 - External File Overlay

© External file lets you design an Overlay within cardPresso and then export it as an image file so
you can open it trough your printer's driver configuration. This way your printer will print all images
with the selected image as the Owerlay design.

This option is found trough the cardPresso menu File>Print Settings, Print Options>Overlay/
Varnish>Mode>External File.

When this option is selected, below it, you will have access to more settings:

File: Lets you save your Overlay/Varnish design to a .bmp file, to later be used by your printer
driver when printing.

Side: Lets you choose the side of the card where the Overlay is to be printed. You can choose
either Front or Back.
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Print Options

I Driver
I Rendering
a pdvanced
I Inwert Driver Onientation
[ Rotate 180
i Flip Horizontal
i Flip Vertical
i Use Colored Card
i Print Jobs
4 Overlay/Varish

lhﬁesﬂ'ﬂy Pictures/Overay.bmp [;]P
4 5ide

Front v il

Once External File is enabled, cardPresso will display an Overlay/Varnish tab in the bottom left

corner of the Design View as shown highlighted in the image below.

You can then open the Overlay/Varnish tab and use cardPresso's design tools to design your own

Owerlay.
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* Fle Edit View Tool Database Wndow Help

=

i

[AII classes |»

E2

EEseomi

Background

Clipart

EREEBEE

]

o

62 Backgrounds found, 0 folders remaining

Design | Overiay/Vamish [l [N

-
s

After you finish designing your Owerlay in the Overlay/Varnish tab, you can use the Overlay File
button in the Print Options shown abowe to save your design to a .bmp file.

Once the file is saved, you can use the Owerlay settings on your Printer Driver settings to open the

Appendix B.1.3 - Printer Default Overlay

6 By default the printers which support Overlay have their own Overlay design. The third (and
default) Overlay Mode option is Disabled. When this option is selected cardPresso lets the printer
use it's default Overlay design.

This option is found trough the cardPresso menu File>Print Settings, Print Options>Overlay/
Varnish>Mode>Disabled.

When this option is selected, no more options are available and cardPresso will not send any
overlay designs to the printer.

When printing, the printer will either not print overlay if the option is disabled on the printer settings,
or it will print overlay using it's default design enabled on the printer settings.

Appendix B.1.4 - IDP SMART 50 Overlay Settings

6 The way the IDP Smart 50 printer works with Owverlay requires the following configuration:
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Print Options

- Rotate 120 -
- Flip Horizontal
- Flip Vertical
-Use Colored Card
- Print Jobs
4 Overlay/Varnish
4 Mode

External file
- File
- Side
4 Format

24-Bits per pixel

The RGB value of objects in a “user defined mask” is the factor that SMART uses to distinguish
which panel is used.

R value is for the Overlay (O) panel

G value is for the printing (YMCK) panel

B value is for Fluorescent (F) panel.

Value “0” means ‘activated’ and value “255” means 'deactivated'.

! ] Examples:

- Blue = RGB(0, 0, 255) : printing and Overlay

- Pink = RGB (255, 0, 255) : printing only

- Black = RGB(0, 0, 0) : printing, Overlay and UV printing
- Red = RGB (255, 0, 0) : printing and UV printing

Appendix B.2 - Web Print Server

© The Web Print Server alllows you to remotely print cards from a computer that doesn't have
cardPresso installed.

To use the WebPrint Server you are required to:

1 - Have a computer with cardPresso XXL Edition connected to a working local area network (LAN
or Internet) to act as the Web Print Server.

2 - Have another computer (Client Computer) connected and to the same local area network (LAN or
Internet).

3 - Use an external application on the Client Computer to send the Print Job trough IP to the server.
The Print Job format must comply to the standard we provide in our website, available for download
here. .

OTo use this service, the Web Print Server computer with the cardPresso XXL Edition USB dongle
must be accessible to the Client Computer via IP connection either trough a LAN or an Internet
connection.
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Appendix B.2.1 - Configuring a Web Print Server

O The first setp to use the Web Print Server senice is configuring the computer that will be
running cardPresso and receiving the print jobs.

To configure the Web Print Server you must:

1 - Sawe the card file you wish to print remotely on the My Cards folder:

File name; %
Save as type: [DOCUMENTS (*.card) 'r]
= Browse Folders Save | ‘ Cancel |

1 - Create a copy or use an existing cardPresso windows shortcut, right click it and select

Properties.
Create shortcut
Delete
Rename
Properties
[Pl

2 - Add the /PRINTSERVER switch to the shortcut Target after the quotation mark and click OK:
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Security | Details I Previous Versions
General | Shortcut | Compatibilty

bt

Target type: Application

Target location: cardPresso

Target: v« /PRINTSERVEH

Start in:

Shortcut key:  Mone

Run: [ Momal window = ]
Commert:
Open File Location ] [ Change lcon... ] [ Advanced... ]
oK || Cancel Aoply

3 - Open cardPresso as a Web Print Server with the new shortcut.

4 - On the Web Print Server window you must configure:

The IP Address of the computer acting as the Web Print Server.

The Port cardPresso should use to receive print jobs.

The User Groups (see more on Chapter 8.3) that can access the Web Print Server.

When all the settings are configured, press the Save button to save the changes and press the
green Start Service button, on the bottom right to start the Web Print Server.

If correctly configured, the button will turn red and the Status box will display a listen OK message
as shown below:
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Listen: Allowed user groups
Address: |¥| Administrators
< 127.0.0.172 [¥/] Editors
PO ] Print Only
532 72 [] view Only

Save

Status:
listen OK {127.0.0.172:632)

@)

Close

Your Web Print Server is now running and has a .card file ready to be printed.

0When working within a LAN (Local Area Network) the WebPrint Server computer must be connected
to the same network as the Client computer that will send the remote print jobs.

0When working trough an internet connection, both the WebPrint Server computer and the Client
computer must be accessible to eachother trough a TCP/IP connection.

Appendix B.2.2 - Sending a Web Print Job to the Web Print Server

@ With the Web Print Server configured and ready to recieve print jobs the last step to print using
this senvice is sendind a Print Job to the server.

cardPresso has a preset format for the Print Job that should be sent to the server. You can find a
sample executable file on our website available for download here.

This sample file exemplifies how to remotely send the Print Job data to the Web Print Server and
cardPresso reads the Print Job data.

The ltem IDs sent from the Web Print Job must match the IDs of the items on the card that is to be
printed.

In the sample file the NAME item is declared as follows:

<item>

<ID>NAME</ID>

<VALUE>RUI FARIA</VALUE>
</item>
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Where NAME is the ID of the item to receive the value and RUI FARIA is the data to be written and
printed.

When sending Images to the Web Print Server they should follow the Base64 encode scheme
(read more here).

Appendix B.2.3 - Web Print Job Sample

O Hereis a sample of a completely formatted Web Print Job data to be sent to the Web Print
Server:

<cardPresso>
<login>
<name>ADMIN</name>
<password>admin</password>
</login>
<cardDocument>
<filename>example.card</flename>
<data>
<item>
<ID>NAME</ID>
<VALUE>RUI FARIA</VALUE>
</item>
<item>
<|D>ADDRESS</ID>
<VALUE>FUNCHAL</VALUE>
</item>
<item>
<ID>PHOTO</ID>
<IMAGE>/9j/4AAQSkZJRgABAQEAYABgAAD/2wBDAAIBAQIBAQICAgICAgICAWUDAWMDA
wYEBAMFBwYHBwcGBwclCQsJCAgKCAcHCgOKCgsMDAwWMBwWKODwOMDgsMDAz/2wBDAQICA
gMDAwYDAwY MCAcIDAWMDAwMDAwMDAwWMDAwWMDAwWMDAwWMDAwWMDAwWMDAWMDAWMDAw
MDAwMDAwWMDAWMDAwWMDAZz/
WAARCAEAATQDASIAAhEBAXEB/8QAHWAAAQUBAQEBAQEAAAAAAAAAAAECAWQFBgCICQo
L/8QAtRAAAgGEDAWIEAWUFBAQAAAFIAQIDAAQRBRINMUEGE 1FhByJxFDKBkaE IlOKxwRV SOfAk
M2JyggkKFhcY GRolJicoKSoONTY 30Dk6QORFRkdISUpTVFVWYV 1hZWmNkZW ZnaGlgc3R1dnd4eX
gDhIWGh4iJipKTIJWWI5iZmgKjpKWmp6ipgrkztLW 2t 7i5us LDXMXGx8jJytL TINXW 19jZ2uHi4
+T15ufo6erx8vP09H3
+Pn6/8QAHWEAAWEBAQEBAQEBAQAAAAAAAAECAWQFBgcICQoL/8QAtREAAgGECBAQDBACF
BAQAAQJ3AAECAXEEBSExBhJBUQdhcRMiMoEIFEKRobHBCSMzUVAVYnLRChYKNOEIS8RcYGR
omJygpKjU2Nzg50kNERUZHSEIKU1RVVIAY WV pjZGVmZ2hpanN0dXZ3eHI6goOEhY aHiimKkpOUIZ
aXmJmaoqOkpaangKmgsrOOtba3uLm6wsPExcbHyMnKOtPU1dbX2Nnad4uPk5ebn60nq8vP09fb3
+Pn6/90ADAMBAAIRAXEAPwWDICJVAdIF/y6y/9+6j/wCEVnh/1kEv/fuvoPNf10+2SVr+8Nfanh/9gXH/
ADwk/wC/dR/20f7kv/fuvePO838KDCk38EfAH70/wC4Ye1PB/7N/wCelH9j9kr3j7Fa/wDPvHUCc2j2M3
+stbaX/ALZ0fOww9qeF/wBj0f2P XuA8HBVN1sY 6jPgP Q5v+ XGP/AL+UjX2h4n/Y 9HIMe9e2/wDCttH/
AOfeovBAhW OjzfwSmgPaHi/9j0f2P Xt E/wAK9K8r/IrHUf8Awp+ym+5PL/37p/uzT2p43/Y9OH9j17D/
wpm1m+5f5/wC2dRTBP8AuXcdHtaYe1Pl/wCx6P7Hr1j/AlUnP/BPbf8AkSo/+FJ33/PS2lo/
dknlf9j0f2PXqH/CmtS/uRVXm+D+qw/8uvmOfuzoPM/7Co/sd/WVvRJwjqUXW xqv/
WAIFfQj95Y3NWY +10H/ALJ/2KP7C/2K7SbwfPD/AMs Zf+/dRjw3JB/B0/6Z1Hsqge 10P/
seo/7THrtP7Bkh/g6VHNO9Hsghr7U4/+x6P7J/2K6z+yf8AY qT+yf8AY09mM4/+x39Y6P7J/
wBiuwg0eSX+Cj+wWikBxfOj\61J/Z3+x XY f2F/sVH/AGT/ALFZgcf/AGb51HINSV2H9hf7FR/2F/sUAcn/
AGZ71H/ZnfwZrrP7C/2Kj/sKgDk/wCzWipP 7M966j+wqk/
sKgDk/7M96PscnrXW2FUc2g96A0X+x/5zRXSP2PRW Xt TnPVKPPo8
+iVROMkoqOpKACrEHeq9Sf8ta6ALHN1J59V6krnAsed+60qODVUIJAEISVXgSgOLHN1JDeV XopezAue
fUkHeqcHepPNf1pezpgXPPoqvB3qSs/Z0wLEM1S/bH/V1ShmqgSj6vTHTLn2w/wDTOj/rokfH/

© 2014 cardPresso, Lda



Appendix B - Advanced Print Operations m

TOQ9FZfVqYiSbTbGb/WQW 3/AH70/s Gxm/5dbaipPPrX6vTH7Ur/AP ClaNN/rLGOo/8AhXuhyj5LHy/
+2lann0VI9WD2pj/8Kx0qY fcljgOb4S6VnPmS 10FHN0/ZVBHN/wDCmdOm4+1yx/8AbOo5vgnaSEw/
I[ddZUIL2VT/AJ+G3tDh5vgan8F9HLj/AJ6R1Xm+Cc/8EIt/38r0Dz6k8+n7KoZe1PM5fgnfiweXz/00pn/
Ck9R/54x/9/K9P8+jzv3tZfvA9qeTzB/VY OfsvBASEqQWNBK9S/54S17R59HNSf36P 3hr7 Q8P/wCFe30P/
LrL/wB+6rzeCZ4eZE5/6517553/AE008+j95/27D2h8+f8ACHyf3DRXv+U/uR/9+6Ky/ef8
+w90eNwzUV812f7eEnlfMNA/79yVo2f7eFj/ AMVGh3UZ/wCulen9Wxn/AD70OX2p9D0V 8/
WAP7eGif8tNKuY/+2IXLTOuTwxN/rIL60j6tjP+fYe1PdPPqS GavF 4f22PB0/8ArJ7mP/tnWhz/
tgeB5sf8TWX/AL91I7PEU/8AI2B6559WK8rtP2rvA8vADGY 4/8 ArpHW pZ/tFeDn7niOy/7
+UfWP+fYe1p0z0Tz6PPrj9N+MHhy8+5rlIL/ANtK11fiIFpV 59z UrK X/tpR7U00g8+iseDx VY zfcu7L/
v5VyHWIP+e9t/38rL61TH7MOIO9SVnw6knXzl/wDV5ViG8T30+tUxFipPPgn9s9/0qTz61
+s0wLkHeplO9U/PqSG809pTAUVJIVPzU9asQzVr7UCSpK|8+jz6Y Fijz6j8+igCxDNUIV6Ek8
+gCSplO9V/PqSGaucCxRUM1J59BmSVJVepKr2oEIFR+fUnn1JoHNn1J59V6koMy Tz6k8
+q8HeigCx59FROUAfmMp4J/Z1u/Elr5n262jk8vzPLgv8QvgDgvgO 1+ 1yeXc2f/PSOT/
VV7H8GdN9IxyfOM6ByP2rvG1r4V+F955nMI1+7jriwWJIxFSp7O0OmbVTomvJwK/
Gagn2yP3rmofEnnf8APPzKsQ3klelVq1IVDY 3ftj/36SHU+9Y/9p+1Sfa0/

wCelH1qoBuf2mnW SpPtnvBApXPw3nnVYhwK1+s 1P +fgGzFgXk/6uQx/9c6nh16f/nve/wDfysP7Z7/pR/
aftWn9pYgr2Z0kPiS7z/x93P8A38qWHxhqUP8AyY/XP/gRJIXNLPf8ASiIbU/JI6P7SxBn7Omdhz/
E7Xfuarff+BElaln8cvE +myxyQa5fRyf8AXSVM7zxUmmxCSf8Adxxf8tK4fxv+2B4L8By+XfazbeZ/0zk82i
nmVSw7p0/aB70mfUmm/tOeNY w+Y5L/wB+62LP9qlLx5D/zGZZf+ukdfnwH/BVzwVoN15cFrfXx/6Z/
Uug2NN/4LY +B9Htf3ngS +vpP+wj2WYfOAN/AKbNPZn6AQ/tdeOIf9ZfW O0VAG7 1ch/bZ8XQ/wCsSyl/7Z1
+efiT/gsl4E 1i6jk07wrfW 0/ ACOj8zzar/8AD2LwPL5M2t9bR/8tP8ApPIR7LEBVMGH1emfpBZ/t7
+lleJNKspf+2lakP8AwUIu4f8AWaBH/wBs5K+G/
hX+2B40+LV1cW+larH90i/5Zyf8ta9lhmk W OdPNKk;jl/1ckdc1XE4OnU9nUw4ezPqyD/gocn/LTw5L/
wCBFaFn/wAFAtK80eZod9GT/WBNK+S/JBAuSIUcOMmPuc1r7TL/8An2Z2VcN/08Psiz/
b98MTfEyxvo/8AtpHW 72Z/tyeC5v9ZP cx/9s 6+ GVv39HNP8A9NaP Z5fUCNTqH3pZ/tpe ASv+Y rLH/
wBdLeStCHOrnwJN/wWAzBH/37r8//no81/Wj6tg/+lQKtOofohZ/tOeC7z7niOxrQs/jx4Vm+5rll/38r84/
tnv+1SQB6IPDwZJaPg2D/wCflQz9IUP0ss/ipod5nZrNI/38rQh8Y adNnZfWUVBA28R1+ZcPiSfPySS/9/
K1NN1ieb/Ilve/9/KPqWH/6CDX2Z+IEOWV v/ P3bfd/Ksf2zH/z0j/7+V+d9neal/wA/d9H/
ANtJKuf2xrkMXy X19/4E SUf2b/1EGX7w/QiHUk6+2ZH/38qT7Z7/pX54Q/
FrxHpuRBrN9H/20geH9pDxrpudmuXP/AH8rL6l/z7xAeyqHEEfbPBASpPPr8

+4f2uvHFn9zXJeP +elWIf22PHNn/zE 05+ 2dH9m4j/AJ+UxH3559S QzV 8H2f7eHjiH/W T20n/bOtSz/
wCChHieH/'WW1ttLR/ZuM/wCnZn/3DPuDz6K+NI/+Ci2rKuG02Nm9ftFFP6ImH/

PsD5m+BVv7Y 2pTeCNQwpLVIbKOw/wBXBP8A9M4/Mrz\vOpb9tGD4zafpc CW sfixf8fFeV6PDJZ/
Cq8k/1fm3HI/+Q64vyf8Anok WLBU8BPD94elVp/\DrLP4tWMP/Lpc5rUs/jZpOP8Az1j/AO2debz W fH3Jf+/
IEMP+xRU+rHrEPxm0ocSSXPH/TWyL4taHN1vo68f+x/9dajmhrP2dMv2Z7Z/wALOOP/AJ/o/
wDtnViH4haVP9zUrb/tpd5VeF/Y/wDYjqSKz T/

pnWns6Zn7M98h8VWM33NSts/9dKsf8JGkOwy Tx/8AfywnsWik/wDPM1h+PPG1r4J0a4nub/8Aln+7jjk/
ey 1nVOn/AABdQO9IMfTmpeMLTQbW Se+ud7Zlo/

M8y SSvmw48f8FLNO80eZpvhm111K8/57/8ALKwPXte8Y/HjWY47VLE6PR/M/

dx+Z+6rqP Cv7HN3PaxyTp/108z91XTU+p4D95iP3IQ0p5SbUmcH48/aW +Ifx UluJLWbm2t 7r/
IhB+6iirh/7Au9Y uo/tc/m/wDXSSwgDTf2P +wyR/8AfytzT2RE03+CP8A7+VzVeJPafw/3Z008uPk/
wD4QOSGtS08ByfZY/8AV8VIOW X7IsnPmeX/ AN+6p3n7Md9ps 3y J5sf/ADO8uUVN/tL2n/Lw1
+pTPBION8HpS5XI714/
wDtnVi88Bfupl9nm/8ATS OVZJIvhjd6P 5tk S+2/171Xm8LXc38B509riP8AIZUNfZV DwiWPBU+gxfa4J7q
OSL/nnJ5VegBP9t74h/A3y7STUrm50uL955cOxJXW TDGfUV3aQeb/2zrl/Ffwfkhl/49c+b/
rP3nleVXTSzep/DxviwVXBe0Psj4D/t+eGfiZayR/2ILpOoReX5kE95/ra9wh8S XX/P3L/38r8g/
Enwru9Huo/sKeXj95/rK98/Zj/bq1XdexR+H/ESEupW8UnIxz101cNh6IP2mCOKrhglM/Qj/hdb7/
n7lom8SX2P9ZH/AN+68T039qjTtSijnSywpY 5g0P8AhpGx/wCgdfVITp1P+fZw1PaHrH/CSXcP/
POpIfGEmceRbV5PB+0TpU3+ssb60rkPx400Y /vPt0f/ AFO0t6fs6n/Psz9meqQ+MOP8Aj1j/AQ/
IR/8ACY QQ/wCstf8AV3JXc3xy0fol3/5DgnN8YLGb719Hz/0zo9ma+1PULz4qWNIHJJOI/7+V o/
CvakQeKVvEfl+RLHHF JH+7krwrUvHIjqUX7y+6/8APSus/Z78VadpvxBt/Mu48yxyV206eHI9mc1U/
Sz4S6Pa3ml/MLaWP/mXm/7YFnY +CYrOTTol7KSX/WJH/qq3Pgn8fDMGgxxz6rHHJ/q5P3del/
ALaXxUtfFXjyzgtbuOWO1j8z/nIXzW G/3wVM4u817zqpzan3rn4deT/npH/38qgx/
a8EO0XySRy/8AbSvSg1aZZoTan3qvaP+3VP+0/
aq814mfIZHTIgBsf2n7VIDefBATSsP7253NR/2IJDWWAOg+2/7dFY SawxX5pOaKPaGZ5BrFn/
AGb8NLO02Rxx3Unmf+1K5P8As 1P71dx48hkh0vR4JPN/dWcdcn5HVXR/
y7Ay5tN6eZHUR2PpsNakONH2P/
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0a5TQy4bPzgP7NT+5W p5PIfiRP2rb2pXt TL+xf7F SfY/8AOaufL W X4w8VWwvgnwbcalffSBAHVEW X/
Tuma+10f8Aid8QtO+GOjfa9Sk8r/WeXxhfw9+G+u/tUeLRrOpJLY6PFJ/rJJP9bH/0zo0HQAS/
ao+KFxdzz30ejxXH+rkk/wDRdfV nhvTbXwrpdvY 2KRx29rRjsd9Up/VsP/EPawW C/wCXQPB/
WANI9K8E6XHaadax21vFHXQQ7lap/wBp+1R/bPfOK8Cngv8An4evINSHI170TSpMPrwW9sk5/
eRx1H9s8n/Ip5uaPaxpSgmxDKkI+laFnsm/grl4by TzPkkirY 03z/8AnpGc 15uJP Sp0/
aGpNpsEO0X+rjrDvP CsEOVokfl/9M4621Zp/wDlolWPPrNfgODHO3wTa2cvmbP +/IXJvAelal/
rLG2Ig5B3qgxD5nFY 1P3h0+ypnH6l+zroGpSmT7DHXB+Nv2DIK8bSybP 3f7ySSPy469802aetyz27/
wCWdZ0sdjMJU9pTqGV XBU6Gh8d+FB+s/BnWY/DGuWW/wWDPW8A8spY67T7F/
sV9AePPAdj480H7Jd/8sV3Ivd/zykry O88Nz6DdSQTp+8ir7HLc3+t0/af8vD47NsFUoVDn/
sckpFH20P 1NdB9i/2KJrNM/cjr0/aHknP+Sn8EdHIPWpP Z/wByo/
sf+c0e0MV3ZnzQ1JZ2zSWd15iSSx1b/ALOkpY dM7ZrT2vszKrV/dngmg/
GDWdN+CNxaJPKY4riSPzPMryfXtSu9Y voLueeWW SX/ AJ6SV3Ggw+d8L7iPzI8xXkkn7z/
mXF3ImMNrpp4mpTpnNhv+nhT86TjY 8 AH8qP7ZP/wA/EVBA38gxNZ0VzfXahO/uyv8A2ncf8/dz/wB/
Kkh8VarZ/wCr1K5jqOaGTrVeazk837nNafW qgfuzUh+JGuQf8xW5NST8Lg8R+V8mpS/9tiow/
Keo50ZPN+tZ+1/6dIGs 3xj8Tqcf2lj28uis SWHD80UvaU/

+fZznrvxOvJL3VLOCTI35Vv8A8865eft XQfEiIbPi28EnMkX7us Ou2qc5HUK/INKkorEftSOjyPeiiucsjm2
WceXmSeXH/ANdK+R/2ivi3P8WViICPD9jP/AMS O1kjjk8v/AJayf8tK9w/aj+ JEHgT4aXEfmeXeap/
01vXzH8ONN/s26+1vZZP9Z+8rrp1PYU/rB1Y L+le+BmGDwfoMcEfm/

uq9MOHXvtk UkleJ+ GOReGLzP 3v7 3/AFkdemeA5p5v9Z/ q/wDnpXzfs/

afKh9TTq+004s7zzqs TTVI2frokeauTXkFnF5k8ItbR/35JPKrT20e 1LEMMK 1 XItH/
wCWklcXgXxy8M6DL5cmagx5/62xy S1zesftaaHZ/u0+0y/8AbvJROWXF T/

12ZfXqcD2SzhsY edkctbFneWMMv7zy46+W7z9szTW8uO1uf8AtpHJUmm/tjaPNL5¢c8n2b/
VOFWdXLalQ7sNm9M+sIv/ggSbyJg8X+Hwx4g8S QxyWsOwWLH/
z0jkrOCDxJ+6jkMn7uWvig4KpTPfp4mnUOo+x/
uhsohhk/6a1TOHxJBNjzDVjxV4kTQo05JJPLt5ZPL8yuap TNTQhmk6VqWZnEX+rjNefzfGzQ9H/1922Z
P+mddh4a+KmneV5fmf62uLE0zT2pqQ61+98uRKx/HmgprFh56J/pFrH/AN/
a6SHWLHXwZ8yo5Y{7I1ZY LE+zqHFmW Gp4vD+zPG/

PqOftW p4k0efTdUUISE8uPzP 3dZ9fomHqg+0pn5wW/d/uyvRj/

AGKkqOun2ZAUUY/2Kk+WikY 1TpPCv774fahB/wBNJJP/ACHXLzQ11ngnzJvDmoQeZ/z0/d/9s64
+aYy1pVpnNTI5+1V50U/56VY m8zmqc01Z+zNyOo5+1SefVeaapJ9oR1HP2omvKjmm/
wCutBIxpuaKgSXeHIOeKKCvanr3jyyk+1fbp/8AWXUn7yufroM+OX7N8kPhe4n0eTzZLX955EkdfN/
nfva7/Z+0p+0pnL7UKKj8+jz6z/hmhJP2q0jz6x/GViRPB/g3VNSk/WCXW 3kkrL+JUMz5H/
ab8dyfEL4tXEEF1Hc6fpXmR2//AEygxoMP7q3k2eX5\yVwej3n9p39xfSJ/x9SeZXonhWzzYeX/
yzirMqv7z2Z7eGpnY eHIZJpfk TzZJf3ccdeuaCYNBObz7uS O2jij8y T/pIXD/AAXOFLPy 7uf/
ALZ1x/7UXx4g0HWVIktcyxyyeXJ5F/LX/IrmXiU/3+1p06Z69Wr7CmeoeA/iR/
WALU16PTbXzbKz+zyXtx P5f+tj/ANX5f/ TOtDx5/Y HW30b7dPa21zcS/u4/tH72v)/2LfGsHIT7RqU/m/
utHkjk/d+VF5nmf6qOuT+PHxIu/GHiO4g8z/R4v3fl/wDP Kvbq06ftPZ0/4dM82rV OX+IXxm1Wa/
kjgnjso4pP+WEfV5nr3xa1tma6+TuUtS/7ZyVgaxCkOskcn/LKub1KGT1ThMmfLjk/wCelF St/
wA+6ZzVazn3njXxBP8AcwS/wC/kIbHg/
x5rm2n95qVz+6/56VnzalBeRfuX82iz1LyZcSJXm1cTU/59nThqdM94

+GOsQaxHbyX0FtHJ5n7y SOPyVBAIpXtHg/x Tqum2v8AXLtSub6zij/1E8nm183/AAr17ysSbP8AIn/
z0r2Dwr48g8N382/5aSyR+XHXN7X2IQ9v+ GeueFf2tPAMmxW 8F 94jsrK4/wB XJHJ5kssUIZ/xg/
aK0DxtFHaaPrltgXm/vP3cn+qrH+A+mwak8O0fbpINNjtxcSRx/6PHJ5V7yuw8bfBO18eaD/
wAeNIcyRfBATVEX ouvigfV6el9n70o0e/70pUw/7s8H17UtZ1iXz7FL6WP/AJ7/APLKUT1/
x54jh1XzJPE+m2UkUn/QQ8qu8/s2DTfgZbRpJLF9g1S4triOkk/49Zl//tdeLePNHg1KXy/
tf2bzf3nl16W GxP7w8CpTxB7D8K/2kPE/hu//AHNjXRL793/y 3VPN82vgj4b/ ALXUGvaXx519B5UR/
wCstJPN82vzn8K/DF Jr+PZff+Q67zQfDc/gm/s50k/eRf6VO5RVY7B4s6¢NicRT/iH3p42
+KnhzXtL8INS8u8i/1iTxyRfuby42vOijk/1scvBAzz/e10BL4nJ42+Bmn2N9Y 6brkcUfI3KE/72uk8E/
DHwWPr2gXEFrPfeG5JZPM8vzPNi/6afubK6ctInTp+zPm82/ie00PqPz67j4wfBPUwg/
a293Pd22paxdfeu7S T/v35kf/LOuD8+vS/dnjkIHn1X+2f8ALO0/O6bKozOz+Hs6fZdU/
wCufl1yE376LPNdh8GfOMuryP8Ae+XLH5cf7ruux8YaPd+G7
+SCdPL/55/8ATWOpq1f3hmzZ3nSf36qTTUTTV X+2e/
WCIUdATTVXmvIP+mdRz TV X+2e/6UGZY 87zpf3IRz9qj+1/7FFnN9slgf+vhnVglyOtHmhDHqgaKtLDxRV
GZ+0oWpaCkO0X3P3Zr4r/AGovhingPxlJd2sEcen38n/LP/VRSV98Xmm/uq8P/a0
+G/8AwIXw+WiebcWv+kxyVvgvegezMva8lQ+15

+1H7z3IzRP2qPz6MT+79ezOn2pJXk/7Y HiT+wfgtqEaT+XJf8A+jV6xXzn+35q/k+HNDtP+Wkt5J/
yOrPDO/3gf8VDxfwTZWQW skezzf3kdeweGIOBTW JY 9nixx 14/4Vs5PtMn/
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AC18qPzK9Q8K+Kk02W SRP9X5f+rryMb/ABD6TDNnY fEjx3B8PBsIvBPHbSRRyf8AbKvm/wCDPg+7
+LWqf2IrL3P9h6X/ AMtJP+WsIbnjbxhB8SPFEIjPP5en2tx5IxJJ/wAtf+mddJN4gkmOGPTdOtY 7bT4o/
LjeCj2vsKfs6Z6VPDVP41Q6jwf8QrWwWz8USaakHIxy2fixxxx/8ALSW/HN27Tb/AFDzE8u4
+0Sf6yOStyHTbuG/ju4J5Y 7yLI5HJ/y 1rtfjZ4gmtY 7TUpNN1K3i/5+9Pjllop4n2f7unTM6uG/59nz/
0+g32vapHB5cscesnl+ZJWx4w+Fc+j2EkemIR3MY/d+2ZHJ/7Ur610f4nJeReXP4c8L/
APgwyS81j7ZnyPD+gS4/56R13fXf+nZw4nBVKh8I+FBP9sXVnadayxx+ZJ9onkjgPxJoKaPrMlon720K
T/IWV90axpgTHI54c8Nx/wDbOuT1iax0395J4V8N3Mnl+Z/x7yVITxNOpU/hmviLEUzy/
WCHsN3pssnmJ+7P116540+D19r11/

aX9pXMcl1HJHHBJ5k XV +Ht39sh8xNAOTTY 5f+edvXrvgP Tplf9Ok8vzPL/d/ubz+s+z/
AlZ24bBe0givDoPhvdbTSNBt9Ng/497 COOKVRNBO390Y +9cnpE 32y Xy OrpLPUoNH/d+ZKc 15GJ/
eH2WHOT+P370vCVDnxRd6PJc/bJY4737JHH5s XmR/6z/pp/q6/

PWVNBnNs7C4u9ksuV+tHhXUk 101jk2ebXyf8AH79k Xw5Z+Lbyx0rxHZab9q/eyW GpSeV/
rP8ANNJRIUZUBRIMPiDxMywXs/4Z8j/D281K81ST7Layy+VH+8/
d16hZ+Np4ZbePUk8w W8y OOP97Xonw3/AGG9Zs9Ziu0u/

t2lyyfMINVI5MNj/6Z10fHj9mnVY'Y tPWHODUrKO1j8u48z975tdNXE4epU/
d1DLBU6Ns/3h6J+yw6QX8lja/6 THL5f8Ag4/NIr1jxJpv20/kjk8uW SL/AJ5181/si69d+D/iro9xPPLGbW 4t/
MroKP8AgoF8N9G/4Zuk+12jppscmgxxy SeR/wAtY 5P +en/bStfrP1TEU8P/AM/DxMy p+0xHs6h8f/
Ej9pBP+FX6h4Ru01KWOW 3kvwbO788AdS+X/WA85P8AIp5dY fwo8VQeKvB GI3cE/wBpjlj/
ANZXgem3mqg+PPFGsXcl9cnR9Ls7i03jkk82KLzP+ef8Ayzr2D4Y +G7X4b+CNP0a1T93a/wCs8z/
npXt4n2fs/ZngYnDez/d0ztPPqT9/efu4EMsg/
wCedZcOp+dXin7NPw3TUr+PVb6P935n7uQin+7p+00UBj9nX9nXxHDY R3ckNtH5v+r8y StD9pz4D6zZ
+Df7S+y+bJafozy/+edfTHWI8NpZ2s UH/

PKu8m8Nwalpclve 5t +7kj8uvMgdmp TxHtKhmfkfgPmQmT955dZc03/TSwpTotn9IGT4Y 6z JrOIJH/ Zd/
J5n+s8ryq+2Z5v.z89e3+7nT+sU/4ZpTOmMRzTVHNNUCc37r3qP/

W1xVQDzpP8AVpWxo9nSEX7y TO7Wfptn/

sR1sQfuYs5jrT2viszLyzcUVGsiMM50qgP 13m/1Ncd48s01HRrCRPNPIlyV5wP/
b88Ja9mPUkWNk/56SR/uq7yHx5pXjzRpJOK 1Ky 1K3/AOekEIY+1qU6n7ymc1XD1Kf8Q/P/
AOIXhv8A4RvxbgFj/wA8pKw/1969Q+P2j+T8S9Qk S Qnzf3kicH/Y elifZmtMx50f3VMf7e0JWNe8NweZ/
z0k/7aVIUTWcn9yvmfovCz+x6z4buSE/56f8AfyjDUzow/
WDEPK9Hh+xwyf8ATW uf+JPjABPY SWkEkW2i6/55/wDLKOtibUrXTdBuLu7njj8r/WVX/
Zv+Fd38ePG9xr35sen2skckfmRx+Vdf9Me8Sn/AM/KhOLhgf7wk+D/
AMDdS8beXd33m21nLH5kf7uvoNN+GP8AY 8R2Qeb/ANNKO9Is/B8Gj2scCQW 3IXFBATOtCzOhP 7kfl 1w/
VKh7 X/ Xw8v4Q0e8+TZH/AN+6jh+FdxDL/wWAuU3/fuvZItNS GL5EjgvNCkP8FHs/
Zjp0625nZ+Cfsf+sk/8h1JeQwaba+Yida7DX/Lh/dolc3NpE959/y/Lrmq+0/5eHb9W p/8uzg/
EmpT3115aJL/ANM/L/1tSaD8N59Y 8u7nTy4/+ecn+trODTdBgh/ebl/MNXP J8r8a6af/AE7M/
Z1P+Xhz80gmz8v5K6jR7NLOxjku5/s 1Y d5q6abL5n+t8qvi-/wBo/wDaun8CWixYad5f2y X AFez/
IIR70OpOp70mdtX2dCn7SofRE3xIsdBi/wBFfzZP+ek8f7qjTPjBBrEokn/4
+P8ANnnHJ5VMQPjB4z8bazJswbW SX/ InHXs/wAM/EmuQ+HbOPUZJftEX/PStc ThvZ0/3hlluOp1z78
+GPxCsfN/1nixy/8ALOtz4zfCux+JFhb6IBze2Ef+s8V AFsdfB/iL9qG+

+DemWQhhNzf3fmSIXkzF XuH7Gn7Yt98U9QubfWIY rfEf7wx 18tjgelp/
wCOUzB6WITp1P4dQ7zQfCtrZ+ W+ WkX7vO3W pdk 1)XNHOsHTr6+j/

ef6zzK3NS0e1WJJErPmmSGW O3kkP8A20ryfrPP+8qGfs625/8A8LC8R6bf+59IfSez/
y92cctdJ4g+P3/AANngOTSVE Gj219by/VbiCS4kitZZl/9XVzUvhKmpeZPa/6yW TzPLryfoqLThwdV/
Cqg41J0It5Iv+ef7uvby 3E+0xFONTPNn8yy6meb6D8SIPid48/sPQIKOnNRPDel/6 TeRwSfaftUkcn/
LSvXIdS87/IpzXh/wCyvpWoj+DbzUpJ52f72ZvPM/wBZ/wAs69Uh1JK+1p/

xD4DG1aftD0j4b6P J4q8R2cH7 3y 5f9ZJX2r8HVCqW cUdoicxR18xfsi6D51r/

AGjslllluP8AVIHX2J8K7MxSy Sf89a6s T/E/dnkVap654Jh/dH5P 3legaP Z+dF XD+Dvuu40ib/V5rmqU/
aGZzfixm+Fdj8TvAW 0aNfQRyx3Uf7vzP+W Ulfkv8Y P hjd/Dfx5qGjXcEtvAgk8uv2gm/fRZ5r4 XIiwCCmfwZ/
wCJzp/iO1tfNklj8udoynE+zqVMNUND4XMhMP7v1qPynrqJvB8418y SCs+8037H/
rdDmtKpr7Ur6b5kMVaF Z/8 Aqq4vakfHhPBM2GCCXUtUIj/ANR/
yytf+ulZ+1/59mX8Q9GW6RhnMdFfP8v7UupqwBOuB TECTiitP9oD2R9t TeG57OtDw3eX3hu/
jntZ5baSvZIvh7Y zf6zzasab8PdHs+fsvmyH/npXV9ZM6eJgHNGWV d94wm+1zpLLJ/z08usabwfP/
cl/7919AQ7If41/+/dE2yb/AFiR/wDfuswNT/n2ZU6p83zeD5If4P/ACHS5 VLT
BSbwrdpujeF77ZHHH9skjrOGPGGvaV4VsPtepSWVIb/APPSeOvPOt7WPDP7Tnwl/
sDSn8WIrjizLef7P8A6GqBY mn9Y/efwzpw2GxHtPaezPzX8eXcmpXVnodr+9
+1Sf8ALOVgz9mnwgnw88E W 9p5SHI3E Uf7yuf8B/su2w3uvt93PHqVSNHSfy f8ALL/rmXY abgfokXUmz/
V/8868jHVadSp70OmfbYan7M7z+0v8AY gP+3vix5nflAKZ1hwax537xJM1oWc3/
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AEO0p06Z01KZOEN550Ucn/LOX95Uc14kPVM1nzXn7r/WVIBIrE/P+tNdABZY 10bzwrPgPzviN/Ck8n/
rrXOejTgkv/LP95WNBJNLIP/AEZWh9j/AHVR/ULOL95JXN7UKIU87
+KI5P0oPljzP3d1Xz38VPCEPja6Ek8n2byf7le+fEjxgn7yBEtrm/In5kn/LKVN4fCs15dS Tyfvf+mdelhqgf/
Lw8jHZI7Sn7M5/4f/DhP CFjGht THcf8tLj/AJ61654b0eDUtLt5JEZzJ/WwA86r+F M 1K Xy D+7kij/
wCWkdR+Kbz/AInPIwJ+7i/dyf8ALLIO5XNifZz/iGeGxNSmV/ip4Ptfib4Ts4L421t9l/wCPeSP/
AJZV0OH7Lvg018B6pJHazyyyS/wDPSq+seG/7S8B+ZBJ5WoGPzl4/+micn4J8belP Cs UkdjP/
AK395JJ5deBicNUNTONnTPsspzLDOP4h9p2ep T3k Uf+tq7/ZgXn+s8uWvmwi8VPFVnL5I3d/9s/
LrulfiZfab5fmJHLJLJ5ccnmeVXz9TBYinU9mel9ew9Q948N+F XhI8x JJf+/
n7gmxg+Etj82vg3rnhy+SPzL+3/0eTy/+WIcX8MfiAmpfu7j931JP +WIlemax4807R7D7XPdx20f/ADzk/
wCW1tc3talPEU6hzZIT9pT/dnw3Z60nhCwj0pP3cel/6NHViIG8r0zWPgmnjzxbqF 3Yzx2VndXH+j/
uB5fx58FNc+HstvwPJB9us5ZP9fB/wC1K/TctzLD1Kn8Q/JcdgsRT/iH1h+zfo6aR4N0+D93/q/
M+SvoTw3420fwrF/xMtSsraP/AKaSV4v4V8B+d4S0+eCTzbe6t45I515P 3VR3wv3k/uR1r7WnU/5eHm/
VqZ9MaP8AtUeANHHIyeJ4/wB1/wA8466DR/20vhI5scf/ AAK/I/8AXS 3krdzvP CskP+sMVZ82g96091h/
+1Q0+rUz9F P Cv7RXgvxhLHBp3ifSbmSX+ DzPKrj/wBq7R4P GHwl1jy 515Kt/ Mjkj/
e18Lw6P5MprsPDfxO1Lwro0limqyy28scnmRzyfuq5s TgvZ1PaYeoZVadM8nviUhil8uuP8V{8fukZ/1ddR
qU3neZsrk/EkKH72SSSTI5XTVp+0/eHP TOX1Kb7HF JJJ5f1+ X8MMISdS Ty Z8y X/
WSV6p4q8yawulP3fmS 15voy Qy 3En+r8qOs ToPLfiNpUV p4olUdCinOKK6HUTB//
CVXTXzw4eb7w96KcaeiGzokY 2v3VW IZqgp2farldNI4iSj/IrUdRz TeVFIKO/

wCnY ofxD89/25P 2xp7P4I6hptjB9u+wSeXb/vP3X7uvO/h78VPE95f2d3qVrHLp91/
rPL/5ZVx/7TSGmyf8AC39YjnTpcSeXIwB/K948HeG7XTth9pcey2lk/
wCWdPNgdOFSnh6Z+rYn2dOnTOnTK+vax9s/5af6qvO7zW JIbgSRP+eleieNtBTw34cku/tFW./yzj/
eV5X5P72vIPExNU6GjQdek+1Rx+Z/ra6j TdRSaX/'WeX/ 10krzvTJVO/wCmdbGmalP9qkjz/
qq1p0zP2h3E2pIP3fMtRww+d/rErDs9eSGWPz/Lj/2/
Mrch1JJowkqgzop1Qh0zyfeqepXnk1J53P3/3Ic34w17+x4pJPOb/ANtK56ntDp+s+zJNY 8ayabY SeX
rkK4fWNek 1668+ST95/WA9IKX/EniSTWL+SSSSX7PL/

AMs6Bw708k82TYkv72tadP2Z5NXE 1Khs TQp5uJD9p/
wC2dWIdHSylku7uTy7Py/8AV/8APKqc3igx8EB6X9uu5PNk/52x+ZXmfiX4wT69dS SP/AKV/
AJZxxyVIV9p/y 7P SwWW/8wKh7hpvx UODRS5flkgll/d/6+Py/3tWP7S8M6xE JOvpf+udfNfBAws KP/np T/
wDhYUkKkMXy T3MVBA1zrzauCqf8uz62nTwf8Ay8pn0zB8TtAhHkeRLKalfEng6aX9/J9m/wCuf/
LKvmOHWNV 1KX9xa30vbOSg+v6IrOmxb54Lny/+mlcVXLan/Pw0qVcH/z7PqzWNNsZrXxzNOu45bT/
npXB6x8VIPDf2iP7dnyvaXHXz/D8Ttc02KTZBLHH/ANdKr+DptV+J3jKOx/1ccsnm Sf8ATKunBZdU/
wCXQ+bxO0p06n7s+yP2VIH1n4wSXGufad 7L T4pP9Zcfe2X/
tnXuk+g+dL+8n+3Sf8APSSsf4G2cHg/4X6fY 2uY 7fy/
+eddZZzJN+82R11Vp+0ge0D+0qITO2WNBOeTTZY 5EkrsLOyg1GwWEF2kcscv+sjrn7PzJvetzTobuGWP/
AFctcVWnUpnV+7qUzP 1L/hO/g+ft3gDWY 77TxceZceHtW/exf9s65eb/AIKrT+Cbr7D41
+GO0ttefouT7JeSRebJ/20r1izh+2Rf885K5v4 1/AHSjz4NOm6kkf2yL97b3cn/
ACykrpw2d4f2ns8xp/8AcQ+ax2U/8+zi/wDh7R80buLEngvxJH/1zuLeW gf/AA8a8M+JVBAQFCW peX/
AM9J7iOvh/4y/BnxB8B/GVxpWs2sv2fzP9Du4/8AVXUdbnwOISGW 37p5dfw/
UsWn7SnT/8AKh83Vp06Z29gaD+0tP481mO0sdKsrLzf+WnmebXSTalPefoy SWWvVA/
gzeed4ns9h/5aV7xDnyvOZWns6dP+Gc1Up3neuX8Sfera5XW Xneub179zF JJ/37rOqZ0zg/
EmyGw8ySSvG/FU13NLJaWsksv2+4k/7ZfvK9g8bf8gG4k T/WV 5npsN3pus3Hnyfu/tHMR1IS/
wCXhpTOpTwzZaZaW8EnmuY4gA2123D1zRXDeP8A4gRaLraQF 5d3kg5+pJP9aK5Y4bRG31Q/
WyzwWiceZH/38qx9r/wBivy 7s/iR4js\VORrmr23/X04kq50P7QnjW G6ul/wDhKtb8uKT93/pFen/Z21/5
+HB7Kn/z8P0887/YkgwNeV+dcP7VHjyH/mZ9SIx/z0/e1qW{7Y 3xDh/5mCW X/tnWvI1LEUzWnT/59nH/
tdeCZNH/aWuLTZJHHLef6z/nr51d5488Y f81f4Dyn7248vy/L/wCmdY fiTxJFE7WdP 1nVZ/tOofaP9lkrl/
iDZ32sazp9jamX/ SpP+mnIRVImVX2+190fqNL/d6ZJ/ws JPEng2SDyP 3k X+sk/wCev72sPyfO/g/8iVOn/
CsU8H+Fpl5Lu2uf+mkdcvZzJ9qkj2f6qSVNINT/AOXZ8/if4hY 87y Y gks 7y Sb61H53m/hRpv/
H1J8nmx1pT9oc1UuTTedF5fmVoaP4kkspf3kksuf8AnpWMNsm+51q0O87xyV1VapnTgnWQ699si8y N/
idef2ldeWn+s/5aV1kM32018uT/

AJZVxfiCLztZkk/561zUvdh04n2hz2rzQQW Fv+88u4l/1n7us TXHIroNrJPP528qtjWWNOS8EeysPR/2dZ/
G1/8Aa9Sub5Y45f+WccdHsqdT/AJeHThqdM831LxXgXxO1S3ggSWX
AKZ/63yv+mldhoP7PaXkUcmpSX0snl/6uP8AdV7R4P8Ag/o/gO1/0W1jj8393/z1qvdk8S Jo/wC7gg8uP/
pnWVTE/WDPs9unVp0/4h5WN8MdK8Nx+ZJpOc X AEOk/e1Th1LR7OXy4Ps3/
XSOO0gfxI8SXesSyRweb5fmfvK4uz+11zVcNUgWKIQ6f7bwIP8Ad+zPYNN15LyLyOk83NU9eOe1lijkn8
uX/rpXD6PeTw5/1tak2s TzQ+XIJmwWNg4apTD+1/aGH8SPI+y+WiR/
upP+WddB+zT4V8nRrzUuftF 1/6Lrz/ AOIW pf6 Tbx pJL+9k/wBXXgngPxVB4b0G3tMx/uo/
+WIlevhv3eHPn8TT9pU90ofXHwx 1hD410+NPNI/d12nhgbzv4D+9krx/8AZv17/hJfCVVAM8/M8VAL917JD/
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AKH/AKuszX2dM6iGb7H/AAVoW esJDzmulLmvdB5knmS8U/SJp/
MH7yWuWrhvaBTgnqgOm6x533M810umzJNF+8SOvPvDd59jh/

efvZK6zRISkvivM8zyB68DE4Y 6frJT+LPwx0P4neHP7N1zTo7m3/5Z/8ALLyq+N/2IV2Xf+FD6p/
bOgJLc+G7/wDdx/vP3trJ/wA86+7P OS 7tRH5k Zrg/id4DsfiF4AXVNDw3dvdR/
wCjyf8APKSssDmMVTCVP4n7syq4LD1Kf7w+P/g/
qWPGVnGn+r8yvoyH97Xy/4V8K33gP4tf2VfebHJa3HIyVIOURIs/LrOI9pTPgMT+7gF Ob/U1zfiQST20n/
WADrrLyH919yuf8SQ+TY SSc1rVImZ0zz/xJD5thcR7PNxHXj15eT/b/ADNn+tr23UofPP8ArOle T/
EL4e6lpt/Jd6dJ5tnN/WAS/L82WKuH2f7z222

+19mePeNTJ4k1171Y duV Cked4zRXSTaNqgFvecSI9tcghjgeX2or044 XRHF 7U7n7HS53F Z+g/

vopJD9yW SSuo/s2SHI5W X4b0fydMj2JLXbVpnDSI4Y U61J/y 1rQ+xf7TFH2P/
ADmMj2ZrSNzwref6LXaeGIOSkmiul5/Lj/
ANXHHJ/0zrzeGGSH7nm1T1jx5rnhuWP7LBHcx/8ATOw8bgqgn/Ls+/y3HUG
+HINUPUPEInaw2Fx5nm/vY 5K8Xhm8mXH+trU8SfGDUptLkgntZZfiN/wCedcvZ6xJeeZ+4/
eeXblc3sbns/wB4Z1Tc/tdIvdKsaPedpsUnmdew4dS/56JVwXnnRUUzIgmpeakhI8xP/IIY 95rEKNhS/
wD6Mgneax5MVZd5q8k0Xly T/u/+eckleoZm5Z66byL/

AFIVIS 1JJpPLkr7zZWEhHIolRw+JJJpfuf8AkSuGqdB 3Hg/R7XWB5iSebH/

z0ruLOzTTYV8AW ebXnfhDxJ/Zs Ukf7397XQf8Jh53/POvPqndTgmxqW pfz/nnXH6xZ/
bJZJP9VWxDefbP+edF5DBDF J5n/POtqdU19geZe JNB8+KTIx5vm/9INK5D+zfJI8vZ+8/6516hqUOEP/
LeOL/
pnXPaxed5vXzaOgnAc5Zwyf3PLgxeQpZ2vmSeVRqV55MXPI+ZXF+MPFTw+ZB5n7zy64apt9Z9mcfdq1
L/Alg2zj3/ALs SRyf+RK90s/CsHiTwvomzy5JY /wB3JH/
z0r5j8SXnn6p5nmebX0B8IPFVxgXgm3jtlL82GP8A56V6RzU6WMKh7B+xzrE/huHWNNnNn/
wBVJHJbyf8AXT/WV9IMabqUk0X7zza+B9IN8Va58N/G/26RLb7PL+7k8z/nnX1x8MfFU+vaDHOkkfly/
vi5PL/

wCWdcWOp1KdT2h690n7Q9Qhm TpWhzZ/6HXP6DZ+TL5kkkfmVsefW ftfaGW JpmxZ6153NbFnrEkMX
+8/7Z+Z2XH2d4kMuDJWh/bF ¢ 1XDHN7 UGBy Hxh5P Xy 6 JVFUF5KPMkIrk 5t T71Tm 1L97/
rk82pgj0qeJLHxO+EunePNUs9ZtfLj1S1/5aSSf62rn207h/wBZBUdn4jkhigSbxJJNF/
rK6aeb4ihT9mebiclw+Lge0l50ZPKPyVh69F/
oskkhlrYh8VecPLk/5a1T16FLyKTZJ1rtp8QU6IT94ebjuHMRQp+0pnn95Cnm5NZ81mk33K1LyzPm1H
DDX1INKpTgHz9UxpvCOM8haT7xoroY4YyoyaK10OM4PUrPydLuH/AOeUdU/Dej+TpdnH/
wWAtDHXSeMNNMPhe8d/9X5dWNNOdPsscezy/3f8Aq69+rTp/8vDIp1THhOc/VPkj/wC/IH9me9dB/
ZP+xR/Y/wC+/wBXWXs6Y U6py81mn9yq80MmPuc11E2m/
wCxVb+yJP8AMdZ+zNKdU5T+x5JpPIXHXF692yWegXEfP+sr1j+zf3w/
wBc68z+Kmjyab+88zy44v8AIpXkY6mfSZSc3NgX+ISRyfBALKq82pdNhrm9S17yZfkn83/
rmWN4wk/1ea8T2R6VWqdBNrE95dY 8yjUrzyoo/3n7z/IpWfpuvQeV+8/1tXJpkvivuV3e1D/
AJdMXDN500NS G88mKqU2peT5kf8AqzWZNqUnm/VJPNrngmXt TrNB 151Y pl/
+mlaE2vZi+SSuDh1PyfU1JFr39xKkzg4moeoWfilCDRzHHIkssnl/8s5Kr698SEm/dp1rzubXs/
wCsT95/0zou/wB1YR/

VPLkrb2Y e 1NzUVGCTXX+MI/7Z1j6Iry Xnyfuc/8AXS ufGpSedJ+8qvDrH+Id6x+A09gampalBDD5f+rk/
wCulcP4r1KS8uvMkT/VBtK2NYm8663+2ZXF69gXn TSVKzgmft Tm9XJuj7V6D8BPiCnhqg88iT/
AJbfu683uj5ty T61p+HLS SaUbKAwW38Q+sNS+y+MNKjn8zzfNjr1j9nvx UkPhKOxkkMclh+7/AHIfH/
0/4gX3g+LyLhPMt5ZP+/Ve4fBndqWusarJBB+7+3x+25dGOp/
uz6TDVaZ9Qab4xSzik2Vn+JPHiXnIxwSS/wDTSWP5te/0X/

pnLXJzeJJldZk8y S Xy68mkFWrTqHOB4b8S SebHHJJnza7Czm/dfvO9eR/D3Uw+EkiikM/m/wDPT93/
AKqwW7P/AFRrgPKgizan5PW0a8kqgxeQyQ/Wsu8715tUumP+2P8A3DS/8JJJD+7rPI1JP3IV/
wDIrXBiXTqHdTgnQQ6950tWIdY S8781zcvimTzEkqOHUpIR8leTUp+z/hnt4arz/
WAQOPEkXky+ZJ5v7 3/

vIWfDDVie8k 1K1kjkeWW qej3iQyyRyfuSM8AnpX2W QY 7np+zgHWnEGW +zxHtKZoRQkJ30gq0nSivrP
anzBzPjDUtO1LRVTUbLzJZI/M82z91+7rcs4Y JwTxy/wDbSvM4dnXy481Idn/LT/y HXwv+velP6Px P Ofqf/
MNiD1T+xvO4zmo5tM7ZrzeHWLUEfJdy 1ch8Y azZ/u01W52f885K7cNx/T/5eHzeJ8AsOp/
w6h3H9MpDFVObTO2a5v8A4TzW SMyXfm/9s6P+E81Lzf3n2aW P/ppHXpU+NsPUPIXPgpxHT/hmp/
ZidJK83+J2jyfarj5P+ekldp/wnk/SS1tpf/IV c/4qvP 7e8yfZHH5VI uS OP 97 WVO4fF/
wzyavB2aZNT/22mfLibRSNBupNn+rrm/7YzL+8r3TxV8PY Nfikj T/W Sx/wDP SvK/GHw9/
sGWORPNIjIpfGeR7Ux7PxInm9a6Cz1jzowkrj5tBkirQ0fzIf3fP11 FWnUOmMIVNiaWeaX95JWfqU3kxSVY
mvKy7zzJvel/180apVMe88S SebUkHiuSH1qP UtHT+5LxXN6I5kNdNOmc/
tToP+Ekk83zKJWFUnI58yuPm1GSH1qwea9JN+FP2gzsP+Ek86KQJ/

rkz5te/56SVy80pSdZMOTX cpobk3iSSbrPLxWHqV4k/W56jn7UAQSsRiu0+E+kPqcOmK4d8IvpXp/
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wCzfMZtZulP+Whj/d1r7TqTgv3mI5Dc174e/wCi/
IN7ysP4V6xrmkeMrOx06T955n+rk/1Veqaxshl8uSs/4M+FY Jvi/
bzokfmGOSSOj937M+gxOGqUD2AaxPZ2HkX0n+kRf8tPLrCs7xLzVPL/
AOQetb\j2z8618/8A5aRf6y OOP/W 1x+g3kcOWV/mSfIM682nTOIMc Xt TOjw T4Ik8N6zHInl/6z/
IpX0B4b1hNYtY50kjl/6aV8z+ckvPWVRPgb4w8mKSO0nk/1Unl1pV/h+0pmn8Q9sm2Q/
vHzzWPgX+mf8tP/ACHUmMmMTJefPM/d1JgWyal14mK9oaljn7yH/AKaVHIs SGX/
WdKsXkL+b8nJrPmh8mXzJK4vancF5gXnY2SdapzaxJDEP9XzRNefu/
L2Vn3kOHmM81zVTopmhZ+I5PN8yT/wAh1cmh/tiXzESXzKx7LZ+NalnqUIn5X/
POinVqUKntKZrVp08RTINUHf22dP ZoprWW4Minkng3vRVwIL3EkQY cOV7f+srPm5cNK7P/2Q==</
IMAGE>
</item>
</data>
</cardDocument>
</cardPresso>

Appendix B.3 - AutoPrint

ne of the advanced print features you can use with cardPresso is the ability to automate prin
0o f the ad d print feat ith cardP is the ability t t te print
jobs and use external applications to run custom print jobs. This feature is called AutoPrint.

For these purposes cardPresso allows you to use the Windows Command Prompt to run print jobs
you hawve previously prepared.

The possibility to use the Command Prompt to run customizable print jobs allows you to create .bat
files with your custom settings and run those .bat files whenever you need.

You can also use external programs to run custom print jobs, either by running the cardPresso
AutoPrint commands, or by running a previously saved .bat file.

To work with AutoPrint, the card you are going to use must be previously saved with your printer
settings configured.

Appendix B.3.1 - AutoPrint Commands

© Below are the commands used to interact with cardPresso through the command prompt:
/(P)RINT - Print

IFILTER:"data" - Conditional Print Filter

/CONTINUOUS:seconds - continuous printing with seconds delay

ISHOWPRINTDIALOG - Always show Print Dialog Box

IDBFILTER:"Filter" - where "Filter" is the equivalent to a SQL WHERE clause
ISAVE:"optionalFileName" - Sawes the document opened in the command line applying all
changes made by Print or DBFilter

If optionalFileName is specified, then the card document will be saved with the new name.

For example:

/SAVE - saves the document with the current file name

/SAVE:"D:/Tickets/newCard.card" - saves the document with the new file name
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Using the Save command with a filter allows you to preview the card fields filled with data that meets
the determined conditions before printing.

/EXIT - Forces cardPresso to Close & Exit after printing

The syntax for the /P print command to be used from Run or Command Prompt is:
"c:\Program Files\cardPresso\cardPresso.exe" "c:\cP Test.card” /P

where:

"c:\Program Files\cardPresso\cardPresso.exe" - cardPresso's executable file location
"c:\cP Test.card" - card file location

[P - print command

0 note: cardPresso's exectuable file location may vary depending on your operating system and the
location you selected when installing cardPresso.
The card file location is where you saved your cardPresso .CARD document.

Appendix B.3.2 - AutoPrint with Command Prompt and Windows
Run

© AutoPrint commands can be run directly either from the Windows Run dialog box, or from the
Windows Command Prompt.

To run an AutoPrint command from the Windows Run dialog box, open the dialog box trough the
Windows Menu Start>Run type the AutoPrint command in the dialog box and click the OK button:

=== Typethe name of a program, folder, document, or Internet
resource, and Windows will open it for you.

"oh\cP Test.card" /PR

Dpen:

QK | l Cancel ] | Browse...

To run an AutoPrint command from the Windows Command Prompt, open the command prompt
trough the Windows menu Start>Accessories>Command Prompt. And type the AutoPrint
command in the Command Prompt window:

© 2014 cardPresso, Lda



m cardPresso Manual

Microsoft Windows

sUszerscPPedroSzousaX'civProgram Files' ..o

ard' <P

[Version 6.1.76011
Copyright <c> 2889 Microsoft Corporation.

All rights resevrved.

Appendix B.3.1 - AutoPrint Batch File

. -exe" "cincP Test.

© AutoPrint commands can be stored in a batch file (-bat) for later use. This way, you can create
as many batch files as you like, each with it's custom settings, and run your desired file with the

desired settings whenewer it's needed.

You can create a batch file in any regular text editor like Notepad.
Simply create a new text document. Type the AutoPrint commands you want to run and save the

file with the .bat extension.

Mame

[E] cPbatchfile

Date modified Type

B T e Ty 2 e - Mindows Bateh Eile
30-12-201315:51 Windows Batch File

“| cPbatchfile - Notepad

= | B 2R

File Edit Format View H

exe" " N Test.card™ /P -

"c:\Program Filesh ...

| Save As e ]
o husd) | « Local Disk (C:) » cpbatch - |"'f| | Search cpbatch B
File name: A
e Save as type: |Tex1: Documents (*.td) v|
» Browse Folders Encoding: | ANSI v| | Save | ‘ Cancel |

You can then run the .bat file directly, or trough an external program such as the Windows Task

Scheduler.
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Appendix C - Encoding

O The multiple types of encoding available in cardPresso provides the best flexibility when working
with multiple card types.

To ensure a good knowledge base, in this chapter we will further develop the topic of encoding,
addressing each type of encoding and how to perform it within cardPresso.

0 For testing purposes, we recommend disabling Front and Back printing on the print window (menu
File>Print) before printing.

Print Operations

Print Front
Print Back
¥| Magnetic Encoding

Appendix C.1 - Magnetic Stripe

i Magnetic encoding is a contactless type of encoding performed on the magnetic stripe
(Magstripe) of a magnetic card. cardPresso supports both High Coercivity (HiCo) and Low Coercivity
(LoCo) magnetic cards.

There are up to 3 tracks on magnetic cards: Track 1, Track 2 and Track 3

Each Track supports a specific data type and size.

Track 1 - 80 Alphanumeric Characters
Track 2 - 40 Numeric Characters
Track 3 - 110 Numeric Characters

When a magnetic card type is created, cardPresso displays a visual representation of the Magstripe
on the Card Back view. This allows you to individually select each Track and edit the data to be
encoded directly trough the card design view.

You can access it by clicking the View Card Back button, or trough the menu View > Card Back.
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Appendix C.1.1 - Macros / Sentinels

O When encoding data into a Track the data must follow a specific set of formatting rules. These
are what determine which Track is being written and what data is to be written.

To do this, encoders use a set of characters named Sentinels which determine where the data to be
encoded starts, where it's separated and where it ends.

Start Sentinel (generally '%') marks where the data to be encoded is going to begin.
End Sentinel (generally '?') marks where the data to be encoded ends.

Field Separator (generally V) separates different fields within a track.

ex: %Example/Text?

Where:

'% is the Start Sentinel.

'Example’ is the first field of data to be encoded on the current track.

'"A'is the Field Separator.

'Text' is the second field of data to be encoded on the current track.

'?"is the End Sentinel.

cardPresso simplifies the process by using Macros: an array of Sentinel presets for several

manufacturers, making changing Sentinels as simple and easy as a click (see more on Appendix
C.1.5).

Appendix C.1.2 - Adding Data to a Track

O Tracks in magnetic cards can work as easily as any other item in cardPresso when it comes to
adding data. Simply double click the data you wish to add data to encode, input the data to be

© 2014 cardPresso, Lda



m cardPresso Manual

encoded on the input textbox and click the Close button. The change will be immediate:

Trackl:

Example

This allows you to quickly add information into a magnetic card without any previous knowledge on
magnetic encoding.

Appendix C.1.3 - Adding a Database Source to a Track

© when working with databases, having the versatility to add a database item to a Track is
fundamental.

As with any item in cardPresso, each Track contains it's own set of properties which can be used
for advanced encoding operations.

To add a database source to a Track:

1 - Select the Track in the Card Back view.

2 - On the Source tab, to the right, change the Source type to Database
3 - Select the Table where the database data is stored.

4 - Select the Column which contains the data to be encoded.
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Database

Table

Employee
Column

First Mame
Font auto adjust

Mewver

Concatenation

All changes are immediately visible in the Design View:

Appendix C.1.4 - Concatenation With Databases

© concatenation allows you to stack up to three database fields within the same Track. This is
allows for a much more dynamic and space efficient data generation when working with magnetic
tracks.

To use Concatenation on a Track select the Track, on the Track Properties select the Source
tab and click the Concatenation button.

The Concatenation pop-up provides the following options:

Data Prefix allows you to customize the text prefix that appears on the currently selected track.
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Ignore on print disables or enables encoding the Data Prefix.

Data Suffix allows you to customize a text suffix that appears on the currently selected track.

Ignore on print disables or enables encoding the Data Suffix.

Concatenate database columns enables or disables Concatenation

Column Prefix adds a text prefix to the data obtained from the selected data column.

0 Usually used for the Field Separator Sentinel

Column selects the database column from which to obtain the data.
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| Database v |
Teble
| Employee v |
w  Column
2 :
=
2 | Employee Id v |
Font auto adjust
| MNewver v |
Data Prefix
' TRACK1: | Ignore on print
Data Suffix

| | [ Ignore on print

Concatenate database columns

Column Prefix

| - |

Column

[ First Name v |

Column Prefix

| Eat

Column

[ Last Mame "J

Column Prefix

| Fa

Column

[ Extension v |

[ oK [ Cancel

Appendix C.1.5 - Editing Magnetic Macros / Sentinels

6 Different encoder manufacturers use different Sentinels. To simplify managing sentinels
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cardPresso provides several Macros with preset Sentinels from several manufacturers.

You can change Macros trough the cardPresso menu File > Print Settings > Print Options >

Magnetic Encode > Macros and select your encoder/printer manufacturer.

Print Options

- Antialiasing -
» Composite black replacement

4 Magnetic Encode
4 Macros

Ewvolis

CIAAT -
.1Datacard
sEvolis
IFargo
GLADIO

Ch i
aAdv) g A Smart

* R Javelin

- Fli Magicard

=L Misca b

To manually configure Macros open the cardPresso menu File > Print Settings > Print Options >

Magnetic Encode > Macros and select User Defined.

This will allow you to manually type the Start Sentinel and End Sentinel as shown bellow. All 3

Tracks must be manually set.

Print Options

4 Magnetic Encode
4 Macros

User Defined

» Font
4 Track 1
4 Begin
%
4 End
7

* TalK £
» Track 3

- Composite black replacement -

: Character encoding -

Appendix C.1.6 - Script Encoding

© cardPresso also allows you to manipulate Track data trough Scripts. This powerful feature
allows for even more advanced operations to customize your encoded data to it's full potential.
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In cardPresso each Tracks has a unique ID. Namely ISOTRACK1, ISOTRACK2, and ISOTRACK3
for Track 1, Track 2, and Track 3 respectively.
The data on this item can be manipulated trough scripting as with any other item.

0 The encoded data must still follow each Track's data type (see more on Appendix C.1 - Magnetic
Stripe).

To create a Script click an empty area of the card design and select the Script tab in the
Properties Dock..

0 Scripts can also be added to an item by selecting it and clicking the Script tab in the properties Dock.

On the Script tab you can select when the script should executed and on the text box, write the
script.

Ex: item.ISOTRACK1="Example Text"

| Before Printing

item.ISOTRACKL="Example Text"

Background

Databaseg

Database Filter

Database Find

4..
o

=
L=

)]

Script | Output @

Example Text
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Appendix C.2 - Contact Encoding

i ] Contact encoding in cardPresso is done in the Encode Operations window in the Encode
View. Here you can dewelop your customized encoding operations for all the supported contact Card
Types.

This allows you to manipulate the data stored in your Card, the data in the Card Design ltems and
the data stored in your database, if connected to one.

The code varies with each Card Type. cardPresso comes with sample code for the supported Card
Types designed to get you familiar with the basic operations of each Card Type.

Below is the sample code of an 12C script.

Contact encoders | OMMIKEY CardMan 5x21 0 v |

card.hasNulluiDs=true;
card.waitForPresent("#12C");

12C.write(0 ™ He
12C.write(10,"6D6F7 2652074686 16E20616E2061706CE96361 T4696F6E", "hex"):

log(i2C.read(0 ,10).toHex ()};
logll2C.read(10,23).toUtfa());

12C.read{10,23).toutfa();

Contact Output @
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Appendix C.3 - Contactless Encoding

(i ] Contactless encoding in cardPresso is done in the Encode Operations window in the Encode
View. Here you can dewelop your customized encoding operations for all the supported contact
Contactless Types.

This allows you to manipulate the data stored in your Card, the data in the Card Design ltems and
the data stored in your database, if connected to one.

The code varies with each Card Type. cardPresso comes with sample code for the supported Card
Types designed to get you familiar with the basic operations of each Card Type.

Below is the sample code of a Mifare script.

Contactless encoders | OMMIKEY CardMan 5x21-CL 0 A
/I Read and Wite to a Block of the card [a]

/f wirite to HEX in sector X block ¥
Jimifare.write(X,Y,"54657374207772697465000000000000", "HEX");

I from the connected Database
Jimifarewrte{X.Y,currentRecord["Hire Date"].toString());

/I Simple text write
fimifarewrite(X, Y, Test read");

I to write to the trailer use
Jimifare writeTrailler( X, "FFFFFFFFFFFFFFO72069FFFFFFFFFFFFY);

/{ to read a Block without converting it
/imifare.read(x,Y):

I Read with conversions
fimifare.read(X.¥).toHex();
fimifare.read(X,Y).tostring();
fimifare.read(X.y).touTFa();

I To save the read data to a field in 2 Database use:
JfcurrentRecord. COLUMMNMAME=mifare.read{X,Y);currentRecerd.save();

. - T . i
Contactless | Output @
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Appendix D - Barcodes

o Barcodes are a staple of today's industry and cardPresso follows trough in this feature as well.

Supporting 1D and 2D barcodes libraries with various customizations allows for a wide application
area.

To create a barcode simply click on the New Barcode or New 2D Barcode button on the Design
Toolbar and then click-drag the new barcode to the size you want.

| &3

Appendix D.1 - 1D Barcode

L1 VN Barcode is the most common barcode type also known as a Linear Barcode.

0 To create a 1D Barcode click the New Barcode button in the Design Toolbar or trough the
cardPresso menu Tool>Barcode.

You can then click-drag to place the new barcode with the desired size.

To customize the barcode, select it and click the Barcode separator in the Properties Dock.
The following options are availlable:

Symbology lets you select the symbology the barcode should use.

Barcode color lets you change the color of the barcode.

Module width lets you customize the width of the module.

Bearer bar customizes the positioning and shape of the barcode bearer bar.

Bearer width customizes the width of the Bearer Bar.

Quiet zone customizes the size of the quiet zone.

Human readable customizes or disables the barcode caption text.

Font customizes the size of the caption text.

CheckDigit enables or disables the Check Digit.
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-
=
@
E
c

o

=L

Outline

[ Barcode

Li INPs) Barcode also know as a matrix code, is an advanced barcode type which can hold more

|. Code 2 of 5

Barcode color

| lRGE(0,0.0)

Module width

| Auto

Bearer bar

| Mo bearer bar

EBearer width
0.75 mm

Quiet Zone

|Elmm

Human readable

| Eelow

Font

| Normal

CheckDigit

|Nune

Appendix D.2 - 2D Barcode

data per area.

Appendix D - Barcodes

233

0 To create a 2D Barcode click the New 2D Barcode button in the Design Toolbar or trough

the cardPresso menu Tool>2D Barcode.

You can then click-drag to place the new barcode with the desired size.

To customize the barcode, select it and click the Barcode separator in the Properties Dock.

The following options are availlable:

Symbol format changes the symbol format of the barcode.
Barcode color changes the color of the barcode.
QRCode Format changes the barcode encode system.

Module Width changes the width of the barcode.
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Mask changes the barcode mask.
EC Level changes the error correction level.

Size/Version changes the barcode size/version.

| QR-Code

Barcode color

[lRGE(0,0,0) -

Position

Code Page

| Default

QRCode Format

| Standard

Module width

| Auto

-
=
U
£
c

=

=L

Mask

| Standard

Raotation

EC Level

| Medium

Outline

SizefVersion

| 21x 21/(vs 1)

" Barcode

Appendix D.3 - Database Generated Barcodes

0 cardPresso's barcodes also supports having database items as the data source. This means
cardPresso can dynamically generate barcodes using the data from an existing database.

As with any item in cardPresso, each Barcode contains it's own set of properties which can be
used for advanced barcode generation.

To add a database source to a Barcode:
1 - Select the Barcode in the Card Design view.
2 - On the Source tab, to the right, change the Source type to Database

3 - Select the Table where the database data is stored.
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4 - Select the Column which contains the data to be written on the Barcode.

| Database

Table

|. Employee

Column

| First Name

Data Prefix
L%_ I
U | | [ Ignore on print

Data Suffix

o
(o
]
E
|

Az

=L

[] ignore on print
[¥] Concatenate database columns

Column Prefix

Outline

Column

| Last Name v |

Column Prefix
| Extension:
Column

BEarcode

| Extension v |

Column Prefix

‘ Source

Column

| (Mot Used) v

oK || Cancel

Concatenation allows you to stack up to three database fields within the same Barcode. This is
allows for a much more dynamic and space efficient data generation when working with barcodes.

To use Concatenation on a Barcode click the Concatenation button on the Source tab.

The Concatenation pop-up provides the following options:

Data Prefix allows you to customize the text prefix that appears on the currently selected track.
Ignore on print disables or enables encoding the Data Prefix.

Data Suffix allows you to customize a text suffix that appears on the currently selected track.
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Ignore on print disables or enables encoding the Data Suffix.
Concatenate database columns enables or disables Concatenation
Column Prefix adds a text prefix to the data obtained from the selected data column.

Column selects the database column from which to obtain the data.

Appendix D.4 - Script Generated Barcodes

© cardPresso also allows you to manipulate Barcode data trough Scripts. This powerful feature
allows for even more advanced operations to use your barcodes to their full potential.

In cardPresso the data on this item can be manipulated trough scripting as with any other item.

0 The encoded data must still follow each Barcode's format rules.

To create a Script click an empty area of the card design and select the Script tab in the
Properties Dock..

0 Scripts can also be added to an item by selecting it and clicking the Script tab in the properties Dock.

On the Script tab you can select when the script should executed and on the text box, write the
script.

O Eexin the example below the QR code being used was given the ID QR.

When ltem Double-Clicked

item.QR.data="TEXT "

Script | Output Y

Result:
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Please enter barcode data

TEXT

Close
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Appendix E - Link Image to DB Field

O Pictures and images are a recurring element of ID cards. When connected to a database
cardPresso allows you to quickly set up a database field as a source for images on your computer.

To set a database field as a link to an image file follow these steps:

1 - Locate the database field that contains the name of the picture files. In the example image below,
the field name is Image File Path:

2 - Right click the database field to open it's Properties menu and change change the Data Type
to Indexed Image.

Image File Path Properties
Data Type

Text Line v E]

E( Text Line

Text Box

Value

Database Counter S
Integer Value | Cancel
Date

= Time

Date and Time

List

3 - Before closing the Properties menu, click the "..." button to the right of the Data Type drop
down list.

4 - On the Indexed Image Properties menu in the Images Folder type the path to the folder
which contains your images.

Alternatively, click the "..." button to the right of the Images Folder path and browse to your images
folder.

Indexed Image

Valid extensions

\ipg.png.bmp. tif.gif |

Image Format | Image Free format

Default Data | Universally Unique Identifier

Source Feld [ Show

| Cancel
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When you're done. Click the OK button on the Indexed Image menu. Then click the OK button on
the Properties menu and finally click the Database refresh button as prompted.

When refreshed, if correctly configured and the database field contains valid image paths, the
database field will now show the images from the folder.
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